Copyright
© Spectrum Software. 1982-2001. This manual and the software described in it are copyrighted, with all rights reserved. No part of this publication, or the software, may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language in any form without the written permission of Spectrum Software.

Software license notice
Your license agreement with Spectrum Software, which is included with the product, describes the uses of the software which are permitted and the uses which are prohibited. Any unauthorized duplication of Micro-Cap 7, in whole or in part, in print, or in any other retrieval or storage system is expressly forbidden.
# Table of Contents

- Spectrum Software and Micro-Cap ........................................ v
- What’s New in Micro-Cap 7 ................................................ ix
- About the User’s Guide ....................................................... xiii
- Typographic conventions ..................................................... xiv

## Chapter 1 - Before You Begin

- Check your package .......................................................... 2
- Check your equipment ....................................................... 3
- Register your product ....................................................... 3
- Let us know .......................................................................... 3
- Install the program ............................................................ 4

## Chapter 2 - Exploring the Basics

- What’s in this chapter ....................................................... 5
- Program structure ............................................................ 5
- How to start MC7 ............................................................. 5
- A quick tour .......................................................................... 6
- Command lines and batch files ............................................ 17
- Terms and concepts ......................................................... 19
- The Schematic editor ......................................................... 22
- Menus ................................................................................ 24
- Dialog boxes ................................................................. 25
- The File menu ................................................................. 26
- The Edit menu ................................................................. 28
- The Component menu ..................................................... 32
- The Windows menu ......................................................... 34
- The Options menu ......................................................... 36
- The Analysis menu ......................................................... 46
- The Design menu ............................................................ 48
- The Help system .............................................................. 49
- The Component editor .................................................... 51
- The Shape editor ........................................................... 55
- The Model editor ............................................................ 56
- Function keys ................................................................. 58
- The Undo and Redo functions ........................................... 59

## Chapter 3 - Creating and Editing Simple Circuits

- What’s in this chapter ....................................................... 61
- Creating a simple circuit .................................................. 62
Chapter 4 - Transient Analysis

- What's in this chapter .................................................. 83
- The Transient Analysis Limits dialog box ...................... 84
- Selecting curves to plot or print .................................. 89
- Plot Properties dialog box ........................................... 93
- State variables and initialization .................................. 101
- The State Variables editor ......................................... 102

Chapter 5 - AC Analysis

- What’s in this chapter .................................................. 105
- AC analysis .............................................................. 106
- The AC Analysis Limits dialog box .............................. 108
- Experimenting with options and limits ......................... 113
- Numeric output ....................................................... 115
- Noise plots ............................................................. 116
- Nyquist plots .......................................................... 118
- Smith charts ........................................................... 119
- Polar plots ............................................................. 120

Chapter 6 - DC Analysis

- What’s in this chapter .................................................. 121
- DC analysis ............................................................ 122
- The DC Analysis Limits dialog box .............................. 124

Chapter 7 - Using the Scope

- What’s in this chapter .................................................. 129
- Experimenting with Scope .......................................... 130
- Magnifying ............................................................. 135
- Panning ................................................................. 136
- Cursor mode .......................................................... 137
- Cursor mode panning and scaling ............................... 138
- Cursor mode positioning ........................................... 139
• Adding text to plots ............................................................... 144
• Adding tags to plots ............................................................... 145
• Performance functions .......................................................... 147
• Animating an analysis .......................................................... 156

Chapter 8 - Using Probe
• What’s in this chapter .......................................................... 157
• How Probe works ............................................................... 158
• Transient analysis variables .................................................. 160
• Probing node voltages ........................................................ 162
• Probing lead-to-lead voltages .............................................. 163
• Navigating the schematic .................................................... 164
• An AC example ............................................................... 165
• A DC example ............................................................... 167
• Probing a SPICE file ........................................................ 169

Chapter 9 - Stepping Component Parameters
• What’s in this chapter ........................................................... 171
• How parameter stepping works ............................................. 172
• Stepping in transient analysis ................................................ 174
• AC and DC examples .......................................................... 176
• Text stepping ............................................................... 178
• Stepping summary ............................................................. 180

Chapter 10 - Using Monte Carlo
• What’s in this chapter .......................................................... 183
• How Monte Carlo works ...................................................... 184
• Distributions ................................................................. 186
• Performance functions .......................................................... 187
• Options ................................................................. 188
• An example ............................................................... 189
• Statistical summary ............................................................. 196

Chapter 11 - Working with Macros
• What’s in this chapter .......................................................... 197
• What is a macro? ............................................................... 197
• Creating the macro circuit file .............................................. 198
• Selecting a suitable shape for the macro .............................. 199
• Entering the macro into the Component library .................... 200
• Using the macro in a circuit .................................................. 202
• An easy way to create macros .............................................. 204
Chapter 12 - Working with Subcircuits
• What’s in this chapter ........................................................... 207
• What is a subcircuit? ............................................................ 207
• Creating the subcircuit text file ........................................... 208
• Selecting a suitable shape for the subcircuit ....................... 209
• Putting subcircuits into the Component library .................. 210
• Using the subcircuit as a component .................................. 212
• Using the Add Part wizard to add subckt parts ..................... 213

Chapter 13 - Printing
• What’s in this chapter ........................................................... 215
• Printing schematics ............................................................ 216
• An example of schematic printing ....................................... 218
• Printing an analysis plot .................................................... 220

Chapter 14 - Animation
• What’s in this chapter ........................................................... 225
• How Animation mode works ............................................. 224
• Animation components ..................................................... 227
• Animate Options dialog box ............................................. 228
• A transient analysis example ............................................ 229

Index ..................................................................................... 231
Spectrum Software and Micro-Cap

Spectrum Software was founded in February of 1980 by Andy Thompson to provide software for personal computers. Initially, the company concentrated on providing software for Apple II systems.

One of the earliest products was Logic Designer and Simulator. Released in June 1980, this product was the first integrated circuit editor and logic simulation system available for personal computers. In many ways it was the forerunner of the Micro-Cap products. Its primary goal was to provide a “circuit creation and simulation” environment for digital simulation.

In August of 1981, the analog equivalent of the first program, Circuit Designer and Simulator, was released. Its integrated text editor created circuit descriptions for a simple, linear, analog simulator.

September of 1982 saw the release of the first Micro-Cap package. The first program to offer a “sketch and simulate” motif, it provided a schematic editor which created netlists for the companion simulator to analyze. It also included an improved nonlinear simulator, based upon the modified nodal circuit formulation and backward Euler integration techniques. One of its key features was the ability to plot the results dynamically during the run. Because you could see what was happening, you could often terminate the run long before it was finished, saving valuable time. Both Apple II and IBM versions of the product were released.

In November of 1984, Spectrum released the Micro-Cap II package. It greatly improved upon the earlier schematic editor and included enhanced models. Versions 2.0, 3.0, and 4.0 were introduced in 1985, 1986, and 1987 respectively, and included support for higher resolution displays, coprocessors, and plotters. Both Macintosh and IBM versions of the product were released.

Micro-Cap III was released in December of 1988. Built around the use of the mouse and windows, it provided a very easy-to-learn environment. Its simulator, while not 100% Spice compatible, was based very closely on the UC Berkeley SPICE 2G model. Standard device models included the Gummel-Poon bipolar transistor model, JFET model, and the Level 1 and Level 3 MOSFET models. Subsequent revisions, have converted it to the C language and added numerous improvements on and extensions to the Spice 2G models. These include models for analog behavioral sources (Laplace and nonlinear function), nonlinear magnetic cores, GaAsFETS, and OPAMPs. It included many other advanced features such as Monte Carlo analysis and parameter stepping.
In February of 1992, Spectrum introduced Micro-Cap IV. In addition to a much improved schematic editor, Micro-Cap IV included a simulator that could read and analyze SPICE 2G text files directly. The schematic editor sported many new refinements, including a clipboard. The DOS version of the simulator was faster than any DOS-based simulator and the extended DOS version was even faster. The latter used up to 16 Megabytes of extended RAM and handled circuits as large as ten thousand transistors. The core simulator was identical to SPICE 2G, with enhancements that derived from Spice 3 and Spectrum’s own developments. For those who required device models not in the large part library, an optimizing model generator was included that made model creation from data sheets easy and accurate. Standard device models included all SPICE 2G models, analog behavioral sources (Laplace and nonlinear function), nonlinear magnetic cores, GaAsFETs and OPAMPs. The Probe feature let users probe the schematic with the mouse to display waveforms in a ‘scope’. The use of mathematical expressions provided great flexibility in plotting and defining component models. Expressions included all of the usual arithmetic, transcendental, hyperbolic, Boolean, and relational operators as well as some special ones like forward and inverse Fourier transform, correlation, auto-correlation, coherence, numerical integration and differentiation.

In August of 1995, Spectrum introduced the first Windows version, Micro-Cap V. Micro-Cap V included all of the features of Micro-Cap IV and added an integrated PSpice® compatible 5-state event-driven digital logic simulator, time synchronized with the internal analog simulation engine. The user interface was similar to that of Micro-Cap IV, but updated to conform to the Windows interface standard. Additional component models were added, including lossy transmission lines, and voltage and current-controlled switches. Schematic structure was enhanced with the addition of a separate text area to hold the text needed in a simulation file. Schematics were generalized to multi-page documents using inter-page ties for connection. New editing commands included region mirroring, rotating, and flipping about the X and Y axes. Components acquired additional attributes, each with independently movable text. Lines became wires with the new property of connecting only at their endpoints, an essential feature for the dense interconnect of logic schematics. Analysis plots acquired graphical objects, text, and tags for labelling individual data points and differences between data points.

In June of 1997 Micro-Cap V 2.0 was released. It included full MOSFET BSIM models, 3D plotting, performance function plotting, multidimensional parameter stepping, symbolic stepping, and animated displays. Animated displays included blinking seven-segment displays, LEDs, node states, and switches.
In July of 1999 Micro-Cap 6 was released. Its major features were:

**Active and passive filter designer**
An active and passive filter circuit design function was added that allowed rapid creation of Butterworth, Chebyshev, elliptic, Bessel, or inverse-Chebyshev filters, using a variety of circuit implementations ranging from Sallen-Key to Tow-Thom. Filters could be created in circuit or macro form, and represented by either circuitry or Laplace transfer functions.

**PCB netlist interface**
A netlist interface to popular PCB tools was introduced for rapid translation of circuit schematics or SPICE netlists to particular PCB packages.

**New BSIM3 3.2 MOSFET model**
The latest version of Berkeley's BSIM3 model was introduced.

**Dynamic DC operating point analysis mode**
The on-schematic display of DC operating point voltages and digital states was expanded to include dynamic DC response to any circuit edits. The new version supported animated battery voltage controls, on screen device currents, node voltages, device stored, generated, and dissipated power terms, and condition displays (Sat, On, Off).

**Sensitivity analysis**
This new analysis mode calculated the DC small-signal sensitivity of multiple user-specified outputs to multiple input variables. Input variables included model parameters, component parameters, and symbolic parameters.

**Transfer function analysis**
This new analysis mode provided a DC transfer function, an input resistance, and an output resistance.

**Temperature list for all analyses**
Temperature stepping from a list was added to AC, DC, and transient analyses.

**List, log, and linear sweep options for DC analysis**
The original DC sweep options were expanded to include a log sweep, a linear sweep, a list sweep, and the original automatic mode.

**Extended DC analysis**
DC analysis was expanded to include temperature, model parameter, and symbolic parameter sweep options.
Automatic macros
A capability to automatically create macros from existing circuits by dragging a defining box region was added.

Network version
A Network version was formally introduced.

Enhanced user waveforms
User waveforms were expanded to include the ability to be saved after the run, to be selected for plotting during a run without requiring a User source in the circuit, and were made available for transient, AC, and DC.

Gmin stepping
Improved DC convergence was achieved with Gmin stepping.

Slope, X_Low, X_High, Y_Low, and Y_High performance functions
New performance functions that return the slope at a specified X value, and the X and Y values at maximum and minimum were added.

Macro pin selector
A macro / subcircuit waveform selector list was added in Probe.

New power variables
New power variables for plotting generated, stored, and dissipated power in each device and for the total circuit were added.

DSP math functions
The ability to use math functions on DSP functions was added.

New math functions
Complex Bessel functions, complex series, and factorials were added to support advanced mathematical modeling.

Symbolic parameter tolerances
Monte Carlo tolerances were added to symbolic variables.

A polygon plot
A polygon object was added to show design specifications in analysis plots.
What's New in Micro-Cap 7

In September of 2001, Micro-Cap 7 was released. Its major features were:

**Optimizer**
An optimizer was added for use in transient, AC, and DC analysis. It provided the capability of minimizing, maximizing, or matching numeric values for any set of performance function expressions subject to specifiable constraints.

**RF models and Smith charts**
An S-Parameter two-port analog primitive was added to facilitate the modeling of RF devices. A Smith chart plot style was added to plot S-Parameter data.

**Portable schematic files**
Formerly, to send a schematic to a colleague, it was sometimes necessary to transfer not only the schematic file, but the component library file, the shape library file, and any model library files used. In Micro-Cap 7, the schematic file format was expanded to include all information necessary to draw and analyze the circuit. The necessary component, shape, and model library information is stored in the schematic file, so sending a circuit to another user requires only circuit files be sent.

**User-specified paths (folders) for all major file groups**
User-specified paths (folders) for circuits and libraries were added to allow easy separation of file types. Circuits can be stored in one folder and model libraries in another. Formerly, circuit files and libraries had to be in the current (last opened) folder or in the folder set by the MC6DATA environmental variable.

**Characteristic curves**
Many users have asked for a stimulus editor that would interactively show the waveform plot as edits are made. We liked the idea so much we added plots for most devices and incorporated it into the Attribute dialog box. Not just waveform sources, but active devices, diodes, Laplace sources, and digital stimulus sources all have characteristic curves or waveforms that can be plotted as you make edits. In the case of analog and digital waveform sources, the characteristic curve is the waveform itself. In the case of BJTs, one or more curves are selectable including DC current gain, saturation voltage, IV characteristics, and beta vs. frequency. Diodes and FETS have IV characteristics plots. OPAMPs have Bode plots.

**Component editor improvements**
The Component editor was significantly enhanced with an Import wizard that scans a model library file for subckts and adds them to the library when it finds existing
parts with similar pin names. This provides near-automatic addition of vendor libraries and makes their frequent updates easier to integrate into the libraries. Other improvements include an Add Part wizard, part templates for rapid manual entry of similar new parts, parts count by group, part name alphabetizer, and a part name list generator.

**Attribute dialog box editor**
The Attribute dialog box (that comes up when you double-click on a part) was changed to allow editing of model parameters, subckts, digital stimulus patterns, and analog waveforms from within the dialog box. This makes the ADB the place for all-in-one viewing, editing, and visualizing model-related data for components.

**Multi-stage undo and redo**
A multi-stage undo and redo was added to let you go back and forth one or more schematic steps.

**Improved component find command**
The component find command was expanded to search on the Name, Shape, Definition, and Memo fields. A Beginning of Line option was added to simplify Memo field searches. A text output of the search results was provided to create custom lists of the library sections.

**Text stepping**
Stepping through a list of text labels was added to facilitate automated analysis of multiple pattern names, subckt files, model statements, and other text based material. For example, if XYZ is the model name for a BJT, then stepping XYZ through the list \{2N2222A, 2N3906, 2N4114\} produces three runs each using a unique set of model parameters for the transistor.

**Symbolic derivative finder**
MC7 introduced the symbolic derivative finder. It solves for and prints symbolic derivative formulas. For example, it will find the derivative of \( x^x \) (x raised to the power of x), with respect to x, as \( x^x*(x-1) + x^x*\ln(x) \).

**Status bar monitor**
The status bar was expanded to show electrical information such as part name, type, current, and power as the mouse passes over the schematic parts. It also shows the step values for waveform branches in the analysis plot.

**Waveform and data point labeling**
Optional, automatic labeling of stepped waveform branches was added. Labeling of data points from a user-specified list was also added.
**Multiple file opener**
A capability to open more than one file at a time was added. MC7 now opens one or more files selected from the File dialog box.

**Smooth schematic panning**
Smooth 1 pixel panning was added. Earlier versions panned 8 pixels to accommodate earlier, slower machines.

**Bill of materials**
A bill of materials was added to the program. It lists the number, value, power, cost, and instances, for each electrical part type in the circuit.

**Sanity checker**
A model parameter range checker was added to warn when model parameters exceed user-specified "reasonable" limits.

**SPICE file probing**
Probing, the ability to click on an object and see its curve or waveform, was added to SPICE text files. This was actually added after the original MC6 release and was never in the MC6 manuals.

**Analysis plot improvements**
Several improvements were made to analysis plots, including the ability to switch between log and linear scales, to select the grid interval and the grid pattern, width, and thickness.

**Shape editor improvements**
Several improvements were added to the analysis plots, including the shape origin symbols, font size memory, and a drag copy command.

**Live formulas**
Live on-schematic text formulas were added that automatically update when any edits are made allowing live design formulas.

**New X and Y Scale format**
A new scale format, High, [Low], [Step], allows users to specify arbitrary grid intervals (scale divisions).

**Even decimal values cursor positioning**
A new cursor positioning mode was added for placing the cursor on even decimal values of the horizontal axis variable.
**New thumbnail plot**
A thumbnail plot was added to provide a global view of enlarged analysis plots, showing the location of the expanded region box superimposed on the whole plot.

**Incremental auto-ranging**
Y dimension auto-ranging was modified to apply only to the specified X range, not the whole simulation range.

**Simultaneous multi-row analysis limits edits**
Rapid analysis limits editing was facilitated by allowing users to change all of the rows in a waveform column simultaneously by clicking on the column header.

**Run-invariant expressions in model parameters**
Run-invariant expressions (those that don't change during a run) were added to model parameters. For example, a MOSFET VTO could be expressed as 2.0 + TEMP/100 to allow for threshold shift with temperature.

**Complex trigonometric functions**
All trigonometric and hyperbolic expressions were modified to accept and return complex arguments. New trigonometric functions included cot, sec, csc, acot, asec, and acsc. New hyperbolic functions included coth, sech, csch, acoth, asech, and acsch.

**Complex conditional functions**
The MIN, MAX, and LIMIT functions acquired complex arguments.

**Expressions for histograms and performance plots**
In earlier versions of Micro-Cap, only individual performance functions were allowed. MC7 added individual performance function expressions as well. For example, expressions like Rise_Time(...) + Fall_Time(...) were allowed.

**Attribute search and replace**
A search and replace command was added to allow easy mass editing of model attributes.

**PADS PCB output**
The ability to write netlist files for interfacing to the PADS PCB program was added.
About the User's Guide

This guide helps you get started. It shows you how to install the product and describes the main features of the program. Tutorials are used throughout, first to teach basic concepts and later, to develop skill in using the features of the program. The chapters cover these topics:

- Chapter 1, "Before You Begin", shows you how to check your equipment, make backup copies of the disks, and install the product.

- Chapter 2, "Exploring the Basics", provides a quick tour of the product, followed by an introduction to the basic Micro-Cap user interface.

- Chapter 3, "Creating and Editing Simple Circuits", illustrates techniques for circuit creation and editing.

- Chapter 4, "Transient Analysis", describes the time domain simulator.

- Chapter 5, "AC Analysis", describes AC analysis.

- Chapter 6, "DC Analysis", describes the nonlinear DC simulator.

- Chapter 7, "Using the Scope", shows how to use Scope to analyze plots.

- Chapter 8, "Using Probe", illustrates Probe's 'point and shoot' tools for interactive display of simulation results.

- Chapter 9, "Stepping Component Parameters", shows how to use parameter stepping to see the effect of changing the numeric model parameters.

- Chapter 10, "Using Monte Carlo", describes how to use the Monte Carlo function to analyze the statistical performance of a circuit.

- Chapter 11, "Working with Macros", describes the use of macros.

- Chapter 12, "Working with Subcircuits", describes the use of subcircuits.

- Chapter 13, "Printing and Plotting", describes the options for printing and plotting the various text and graphic displays produced by Micro-Cap.

- Chapter 14, "Using Animation Mode", describes the animation methods.
Typographic conventions

Certain typographic conventions are employed to simplify reading and using the manuals. Here are the guidelines:

1. Named keys are denoted by the key name alone. For example:

   Press HOME, then press ENTER.

2. Text that is to be typed by the user is denoted by the text enclosed in double quotes. For example:

   Type in the name "TTLINV".

3. Combinations of two keys are shown with the key symbols separated by a plus sign. For example:

   ALT + R

4. Option selection is shown hierarchically. For example this phrase:

   **Options / Preferences / Common / File Warning**

   means the File Warning item from the Common section of the Preferences dialog box, which is chosen from the Options menu.

5. User entries are shown in italics. For example:

   *emitter_lead*

6. The [ and ] characters bracket optional user entries. For example:

   *[low]*

7. The < and > characters bracket required user entries. For example:

   *<emitter_lead>*

8. The OR symbol ( | ) designates mutually exclusive alternatives. For example, PUL | EXP | SIN means PUL or EXP or SIN.
Welcome to Micro-Cap 7, a mixed analog-digital circuit analysis program for personal computers. Micro-Cap 7 is the seventh generation of a program that began in 1982 with the release of Micro-Cap. Since then it has acquired many refinements, always adhering to its primary goal of providing an easy to use, sketch and simulate environment. Micro-Cap 7 continues that tradition by providing:

- A modern, Windows-based, easy to learn user interface
- A powerful schematic editor
- A fast PSpice™ compatible analog-digital simulator
- An optimizer for fine-tuning circuit values
- Schematic waveform probing
- Fast, accurate device model creation from data sheets
- A large device library with more than 15,000 analog and digital parts
- Powerful analog and digital behavioral modeling features
- Advanced BSIM MOSFET models
- Powerful performance measurement and plotting functions
- A netlist interface to popular PCB packages
- Integrated filter design functions
- Animated analysis displays

Micro-Cap 7 lets you describe your circuits in the way most natural for you. You can sketch a schematic or type in a SPICE text description. Either way, Micro-Cap 7 quickly analyzes the circuit and plots the results dynamically during the run. This chapter tells you what you need to do before running the program.
Check your package

Your Micro-Cap 7 package includes the following items:

• A single CD ROM

• A security key (if not upgrading from an earlier version)

• A password sheet (if upgrading from an earlier version)

• Two instruction manuals

• A registration card


• The User's Guide is designed to get you started quickly. It shows you how to install the program and how to begin using it. The manual provides a brief introduction to most of the product's features and a series of graduated tutorials that introduce you to the main features and teach you how to use them.

• The Reference Manual provides a detailed description of the capabilities of every feature of Micro-Cap 7. It describes and illustrates some of the more advanced uses of those features.

The security device plugs into any of the parallel printer ports on your computer. The program will check all parallel printer ports for the existence of the device. The device need not be present to install the program, but it must be present whenever any of the Micro-Cap 7 programs are running. The device does not interfere with other printers or devices that may be attached to the port.

If you are upgrading from an earlier version of Micro-Cap, your package includes a sheet with a password generated from your Key ID. When you run Micro-Cap 7 for the first time, it will ask you for the password. Type it in and the program will permanently upgrade your key so that it can run Micro-Cap 5, 6 or 7.
Check your equipment

You can use Micro-Cap 7 on most PC systems. The minimum hardware requirements are as follows:

- A Pentium II or later computer
- Any Windows operating system later than 3.1. This includes NT 4.0 / 2000 and Windows 95 / 98 / ME.
- System memory of 64 MB
- An SVGA or better display adapter and monitor

Register your product

Be sure to fill out and return the enclosed registration materials. You may also register online at our web site:

www.spectrum-soft.com

Registration is important to you for two reasons.

First, it provides access to technical support for the product. Spectrum provides technical support only to registered users. Second, it helps us keep you informed about upgrades and new versions of the product.

Let us know

Let us know what you liked and what you didn't. We want to know your opinions, suggestions, and comments about how to improve the product. So call us, write, or email us. Either way, please tell us what you think about this product and what you'd like to see in future versions.
Install the program

The installation of Micro-Cap 7 is done with the SETUP program. Here are the specific steps:

- Insert the CD in the drive.
- Select the Run item from the Start menu.
- Browse to the CD ROM drive and run the SETUP program.
- Follow the instructions provided by the SETUP program.

SETUP creates a main Micro-Cap 7 directory called MC7, a data subdirectory called DATA, and a library subdirectory called LIBRARY. It then copies the programs into the MC7 folder, the model libraries into the LIBRARY folder, and the sample circuit files into the DATA folder.
Chapter 2  Exploring the Basics

What's in this chapter

This chapter covers the basics of operating the program. It presumes that you are familiar with the Windows user interface and shows you how Micro-Cap employs that interface to create and analyze electronic circuits. The chapter also reviews the key terms and concepts central to the operation of the program.

Program structure

Micro-Cap 7 includes two executable programs:

- MC7   This is the main program.
- MODEL  This is the modeling program.

MC7, the main program, provides the seamless integration of creation, analysis, and display tools for which the Micro-Cap family is famous.

MODEL is an auxiliary program designed to make the creation of device models from data sheet parameters fast, easy, and accurate. It includes an interactive, optimizing curve fitter that takes data points from graphs or tables and produces an optimized set of model parameters. MODEL can be run from the Program Manager and from within MC7.

How to start MC7

Micro-Cap 7 is activated in the usual way if Windows is already active, by double-clicking on its icon.

Before you run Micro-Cap 7, insert the security key into one of the parallel ports. The key must be connected to a parallel port to start MC7 and must remain there while running the program. If you are using the LAN version, the red LAN key should be in the server parallel port.
A quick tour

As a quick introduction to MC7, we’ll take a brief tour of the program. Begin with a double click on the MC7 icon.

To begin the tour, we’ll load one of the sample circuit files supplied with MC7. Choose **Open** from the **File** menu. When the file prompt comes up, type in the file name "MIXED4". Click Open. The program loads the circuit and displays it.

![Figure 2-1 The MIXED4 sample circuit](image)

The circuit uses an analog TTL inverter to drive a digital three-stage synchronous divide-by-five counter. The digital clock input to the first JK flip-flop is driven by the analog TTL output, while the CLR initializing pulse for the flip-flops comes from a digital source, U2. The CLK inputs are connected together with a .TIE command. The flip-flop preset nodes are connected together by a wire and the node is labeled PREB with grid text. This node is initialized to a '1' state with an .IC command. The digital source states are specified in a .DEFINE command statement located in the schematic text area. The text area is a private cache in each schematic for storing text. You can toggle the display between the drawing and text areas by pressing CTRL + G or by clicking on the Text tab in the lower page scroll bar. This combination of analog and digital circuitry is easily handled by the program, since it contains a native, event-driven digital simulation engine, internally synchronized with its SPICE-based analog simulation engine. Micro-Cap 7 is a true mixed-signal simulator.
Select **Transient** from the **Analysis** menu. MC7 presents the Analysis Limits dialog box where you specify the simulation time range, choose plot and simulation options, and select waveforms to be plotted during the run.

![Transient Analysis Limits](image)

**Figure 2-2 The Analysis Limits dialog box**

Here we have chosen to plot the analog voltage waveforms at the input pulse source, the output of the analog section, and several of the digital waveforms. In general, MC7 can plot any expression using as variables any node voltage or state or any device terminal voltage or current. Here are a few other expressions that could have been plotted in this circuit.

- `d(CLR)` Digital state waveform on node CLR.
- `hex(CLR,PB,1,2)` Hex waveform at nodes CLR,PB,1,2.
- `vbe(q3)` Base-emitter voltage of transistor q3.
- `I(VCC)` Current through the VCC source.
- `PG(VCC)` Power generated by the VCC source.
- `qbe(q1)` Charge stored in the base-emitter cap of q1.
- `cbc(q4)` Base-collector capacitance of q4.

There are a great many other variables available for plotting. Click the right mouse button in the **Y Expression** field to see a list of variables available for plotting or printing. Click outside of the menu to remove it.
Now let’s run the actual simulation. Click on the Run button or press F2 to start the simulation. MC7 plots the results during the run. The run can be stopped at any time by clicking the Stop button, or by pressing ESC.

The final waveform plots look like Figure 2-3. Each waveform can have a unique token, width, pattern, and color. These options are set from **Options / Default Properties for New Circuits** for new circuits and can be changed for the current circuit from the Properties (F10) dialog box. Waveforms can be grouped into one or more plots. Grouping is controlled by the plot number assigned to each waveform. The plot number is the number in the P column of the Analysis Limits dialog box. You can assign all the waveforms to a single plot, or group them into as many plots as will fit on the screen. To assign several waveforms to the same plot, give them all the same plot number. To create several plots, use different plot numbers. To disable plotting a waveform, enter a blank for the plot number.

In this example, all waveforms in the plot group share a common vertical scale. You can use different scales by disabling the **Scope / Same Y Scales** option and specifying the scales you want in the Y Range field. All waveforms in a plot group always share the same horizontal or X scale.

Digital and analog waveforms may be mixed or separated. Separated digital waveforms show the expression on the left, adjacent to the plot. Mixed digital waveforms display the expression at the bottom of the plot along with the analog expressions in the order of their occurrence in the Analysis Limits dialog box.
Zooming in on a waveform

Place the mouse near the top middle of the waveform plot group. Press the left mouse button and while holding it down, slide the mouse down and to the right to create an outline box as shown in the figure below. Release the mouse button and MC7 magnifies and redraws the box region.

If you make a mistake, press CTRL + HOME and try again.

You must be in Scale mode to zoom in with the mouse.

Figure 2-4 Using the mouse to magnify a waveform

Figure 2-5 The magnified region
Press F3 to quit the analysis. Select **Dynamic DC** from the **Analysis** menu. This runs a DC operating point and displays the node voltages and digital states like this:

![Operating point node voltages and states](image)

**Figure 2-6 Operating point node voltages and states**

Click ![voltage](image) to turn off voltages and click ![current](image) to display currents like this:

![Operating point DC currents](image)

**Figure 2-7 Operating point DC currents**
Click [ ] to turn off currents and click [ ] to display power terms like this:

Figure 2-8 Operating point DC power terms

Click [ ] to turn off power and click [ ] to display conditions like this:

Figure 2-9 Operating point DC conditions

The voltage, current, power, and condition are the current time-domain values, which in this case is the result of a DC operating point calculation.
Turn off the **Dynamic DC** analysis mode from the **Analysis** menu. Remove the MIXED4 circuit by choosing **Close** from the **File** menu. Load a new file by choosing **Open** from the **File** menu. Type RCA3040 for the name. Click Open.

Select **AC** from the **Analysis** menu. As before, an analysis limits dialog box appears. We have chosen to plot the voltage of the two nodes, Out1 and Out2, in dB. Click on the Run button, and the analysis plot looks like this:

**Figure 2-10 The RCA3040 circuit**

**Figure 2-11 AC analysis plot**
The same rich set of expressions available in transient analysis is also available in AC analysis. In addition, these operators are very useful:

- db(c) Finds the decibel value of the complex expression c.
- re(c) Finds the real value of the complex expression c.
- im(c) Finds the imaginary value of the complex expression c.
- ph(c) Finds the phase in degrees of the complex expression c.
- gd(c) Finds the group delay of the complex expression c.
- inoise Finds the input noise reflected to the input node.
- onoise Finds the output noise at the output node.

Click on the Cursor mode button in the Tool bar or press F8. In this mode, two cursors are placed on the graph and may be moved about. The table below the plots show the waveform values at each of the two cursors, the difference between them, and the slope. The display should look like this:

![Scope in Cursor mode](image)

Figure 2-12 Cursor mode

The left mouse button controls the left cursor and the right button controls the right cursor. The cursor keys LEFT ARROW and RIGHT ARROW also control the cursors. As the cursors move around, the numeric display continuously updates to show the value of the waveforms, the change in waveforms between the two cursors, and the waveform slope between the two cursors. The optional cursor trackers also track the X and Y values as the cursors are moved.
Note from Fig 2-10 that the load resistors R1 and R3 are set to RL, a symbolic variable defined as 1.32K. We'll optimize the value of RL to maximize the gain at 1MHz. Press CTRL + F11 to bring up the Optimizer. It looks like this:

![Figure 2-13 The Optimizer dialog box](image1.png)

These settings seek the value of RL that maximizes the performance function Y_Level(DB(V(OUT1)),1,1,1E6). From Fig 2-12 the value of DB(V(OUT1)) at 1.0Mhz before optimization is 40.9dB. Click on the Optimize button. The optimizer whirs and chugs and eventually spits out an optimal value of 2.3K. Click on the Apply and Close buttons. Press F2 to rerun the analysis, then F8 and you'll see that with RL=2.3K, DB(V(OUT1)) at 1Mhz is now 45.4dB, a net gain of 4.5dB. Press F3 to exit the AC analysis routine. Choose Close from the File menu to unload the circuit.

![Figure 2-14 The optimized gain curve](image2.png)
Choose **Open** from the **File** menu to load a new circuit, then type "IVBJT" and click the Open button.

![Figure 2-15 The IVBJT circuit](image1)

This creates a set of bipolar transistor IV curves. Choose **DC** from the **Analysis** menu. Click on the Run button. The plots look like this:

![Figure 2-16 The IV curves of a bipolar transistor](image2)

Press F3 to exit the DC analysis, then unload the circuit with CTRL + F4.
Probe is the final topic on our quick tour of MC7. Press CTRL + O, then type "MIXED4". Click Open. Choose **Probe Transient** from the **Analysis** menu. MC7 runs the analysis, saves it to disk, and presents the Probe display. You scroll the schematic or pan it with a click and drag of the **right** mouse button and probe any node or component with a click of the **left** mouse button. Move the mouse to the pulse source and click the **left** button on the dot near the IN node, and its voltage waveform is fetched from disk and plotted. Click the mouse on the OUT node, CLKB pin, J or K pin, and on the CLR node. This plots the analog input and output, and the clock, JK, and CLR digital waveforms. Analog and digital waveforms are placed in the same plot when the **Separate Analog and Digital** option on the **Probe** menu is not checked.

![Figure 2-17 The Probe display](image)

Probing on a node produces either analog node voltage waveforms or digital node state waveforms. Probing between the leads of an analog device produces pin to pin terminal voltage waveforms such as VBE(Q4). Probing on a digital device produces a list of the pin names. Selecting a pin name from this list plots the digital waveform on that pin. Current waveforms are also available, as are charge, capacitance, inductance, flux, and all the usual variables. In addition, you can enter expressions involving circuit variables.

Press F3 to exit the Probe routines and return to the Schematic editor. Remove the circuit with CTRL + F4. This completes the quick tour. For more extensive tours of MC7, see the **Demo** options in the **Help** menu.
Command lines and batch files

Although Micro-Cap 7 is designed to run primarily in an interactive mode, it can also be run as a batch process from the Program Manager command line. Either of two formats may be used.

MC7 [F1[.EXT]]...[FN[.EXT]]

MC7 [ [/S | /R] | [/P] | [/PC | /PA ]] [@BATCH.BAT]

In the first format, F1, ...FN are the names of one or more circuit files to be loaded. The program loads the circuit files and awaits further commands.

In the second format, circuits can be simulated in batch mode by including the circuit name and the analysis type, /T(transient), /A(AC), or /D(DC) on a line in a text file. The syntax of the circuit line inside the batch file is:


The definition of each command is as follows:

/T Run transient analysis on the circuit.
/A Run AC analysis on the circuit.
/D Run DC analysis on the circuit.
/S Save the analysis run to disk for later recall.
/R Retrieve the analysis run from disk and plot the waveforms specified in the Analysis Limits dialog box.
/PC Print the circuit diagram.
/PA Print the circuit analysis plot.
/P Print the circuit diagram and analysis plot.

The /T, /A, and /D commands are for the batch file lines only. The other commands may be applied globally for all circuits in the batch file by placing them on the Program Manager command line, or locally to a particular circuit file by placing them on a circuit line within the batch file.

In the second format, MC7 must be invoked with the name of the batch file preceded by the character ‘@’. For example, consider a text file called TEST.BAT containing these three lines:
PRLC /A /T
SENSOR.CKT /A
LOGIC /T

If MC7 is invoked with the command line, MC7 @TEST.BAT, it will:

1. Load the PRLC.CIR circuit and run an AC and transient analysis.
2. Load the SENSOR.CKT circuit and run an AC analysis.
3. Load the LOGIC.CIR circuit and run a transient analysis.

During these analyses, the expressions specified in the circuit file would be plotted during the run and be visible on the screen, but the results would not be saved to disk.

Note that the default circuit file name extension is .CIR.

By appending an '/S' to the command line, all of the analyses specified in the batch file will be run and the results saved to disk for later recall. By appending an '/R' to the command line the analyses are bypassed and the results merely recalled and plotted.

By appending a '/P' to the command line, all of the analyses specified in the batch file will be run and the circuit and analysis plot printed.
Terms and concepts

Here are some of the important terms and concepts used in the program.

Attribute. Components use attributes to identify part names, model names, and other defining characteristics. Attributes are created and edited in the Attribute dialog box which is accessed by double-clicking on the component.

Box. The box is a rectangular region of a circuit or an analysis plot. Created by a drag operation, it defines plot regions to be magnified or circuit regions to be stepped, deleted, rotated, moved, turned into a macro, or copied to the clipboard.

Click the mouse. Most mice have two or more buttons. 'Click the mouse' means to press and release either the left or right button. The middle button is not used.

Clipboard. This is a temporary storage area for whole or partial circuits from a schematic, or text from any text entry field. Items are copied to the clipboard with the Copy command (CTRL + C) and pasted (CTRL + V) from the clipboard into the current schematic or data field with the Paste command. Anything that is cut is also copied to the clipboard. Anything that is cleared or deleted is not copied to the clipboard.

Component. A component is any electrical circuit object. This includes connectors, macros, and all electrical devices. This excludes grid text, wires, pictures, and graphical objects.

Copy. This command (CTRL + C) copies text from a text field or circuit objects from a schematic to the clipboard for use with the Paste command (CTRL + V).

Cursor. The cursor marks the insertion point. When an object is inserted into a circuit or text inserted into a text entry field, it is placed at the cursor site. The schematic cursor is a mouse arrow or the actual component shape, depending upon a user-selected option. The text cursor is a flashing vertical bar.

Disabled. This means temporarily unavailable. See Enabled.

Drag. A drag operation involves pressing the mouse button, and while holding it down, dragging the mouse to a new location. Dragging with the right button is used for panning shape displays, circuit schematics and analysis plots. Dragging with the left button is used for box region selection, drag copying, moving circuit objects, and magnifying an analysis plot region.
Enabled. A check box button feature is enabled by clicking it with the mouse. It shows an X when enabled. A menu item feature is enabled by clicking it to show a check mark. A button feature is enabled by clicking it to depress the button. Button features are disabled by clicking them to release the button. Other features are disabled when they show neither an X nor a check mark.

ESC. The ESC key is used as a single key alternative to closing the Shape editor, Component editor, Stepping, Monte Carlo, and State Variables dialog boxes and to stop a simulation. It is equivalent to Cancel in a dialog box.

Grid. The grid is a rectangular array of equally spaced locations in the circuit that defines all possible locations for the origin of circuit objects. The grid can be seen by clicking on the Grid icon.

Grid text. This refers to any text placed in a schematic. It is called grid text to distinguish it from component attribute text. Grid text may be placed anywhere. Attribute text is always adjacent to and moves with the component. When grid text is placed on a node it gives the node a name which can be used in expressions. Grid text may be moved back and forth between a schematic page and the schematic text area by selecting the text and pressing CTRL + B.

Wire. Wires connect one or more nodes together. Crossing wires do not connect. Wires that terminate on other wires are connected together. A dot signifying a connection is placed where a wire connects to another wire or to a component pin. Two wires placed end-to-end are fused into a single wire.

Macro. A macro is a schematic, created and saved on disk to be used as a component in other schematics. It uses pin names to specify its connections to the calling circuit.

Node. A node is a set of points connected to one or more component pins. All points on a node have the same voltage or digital state. When analog and digital nodes are joined, an interface circuit is inserted and an additional node created. The process is described in detail in the Reference Manual.

Node name. A node name may be either a node number assigned by MC7 or a piece of grid text placed somewhere on the node. Grid text is on a node if its pin connection dot is on the node. The dot is in the lower left corner of the box that outlines the text when it is selected. To display pin connections, select the Pin Connections option from the View item on the main Options menu. Nodes that have the same text are connected together.
**Node number.** A node number is an ID number assigned by the system. You may refer to nodes either by number or name. Names are better, however, since node numbers can change when you change the schematic.

**Object.** An object is a general term for anything placed in a schematic. This includes components, wires, grid text, flags, picture files, and graphical objects.

**Pan.** Panning is the process of moving the view of a shape, schematic, or an analysis plot. It is like scrolling, except that it is omnidirectional. Panning is done with a drag operation using the right mouse button.

**Paste.** The Paste command (CTRL + V) copies the contents of the clipboard to the current cursor location. Pasting is available for schematics and text fields. To control the location of a paste operation, first click in the schematic or text field where you want the upper-left corner of the paste region to be, then paste.

**Pin.** A pin is a point on a component shape where electrical connections to other components are made. Pins are created and edited using the Component editor.

**Select.** An item is selected so that it may be edited, moved, rotated, deleted or otherwise changed. The general procedure is:

1) If the item is anything but text in a text field, enable the Select mode by clicking on the Select mode button.
2) Select the item.
3) Change it.

Item means any dialog box feature, text fragment in a text field, or any object in the Shape editor, schematic window, or analysis plot. Items are selected with the mouse by moving the mouse arrow to the item and clicking the left button. Items are selected with the keyboard by pressing the TAB key until the desired item is selected. Keyboard selection is available only for text objects and dialog box features. Shading, outlining, or highlighting is used to designate selected items.

**Shape.** All components are represented by shapes. These are created, modified, and maintained by the Shape editor.

**Short.** A short is a Micro-Cap 4 schematic object which connects two or more nodes together to form a single, common node. It is not used in MC7 but is present in the Component library to facilitate automatic conversion of Micro-Cap 4 schematics to MC7 format. For connections, use wires instead of shorts.
The Schematic editor

The Schematic editor is the home base for the system and is the first display you see when you run MC7. It is used to create and edit schematics, to access the various editors, and to initiate analyses. Its display looks like this:

**Menus:** Menus, located at the top of the display, select major functions. Circuit windows are used to create or edit circuit schematics or SPICE text files. The Tool bar is used to select modes, tools and other options.

**Title bar:** The title bar at the top center of the window shows the window name. Using the mouse, you drag the title bar to move the window. The window may also be moved with the keyboard using the move option from the Control menu. Cursor keys move a window outline and the ENTER key terminates the move.

**Main tool bar:** The Main tool bar, positioned below the title bar, contains buttons that represent frequently used menu options for all windows, providing a quick way to access these options. Clicking on a button will activate the option. The tool bar groups buttons into logical sets which can be placed at any of the four sides or can float above the schematic. To move a set, disable the **Lock Tool Bar** option in the **Common Options** section of the **Preferences** dialog box and drag the...
gray border around the tool set to the new location. Buttons for all major actions options are available. Buttons can be added or deleted from the **Main Tool Bar** section of the **Preferences** dialog box.

**Local tool bar**: The local tool bar, usually positioned below the main tool bar, contains buttons that represent frequently used menu options that are available in the local window. Like the main tool bar, tool sets can be moved to preferred locations. Docking of the entire local tool bar can be toggled between the left and the top simply double-clicking in the open area of the tool bar.

**Maximize/minimize buttons**: These buttons are in the upper right portion of the window. Clicking them maximizes, minimizes, or restores the window. The upper set of buttons control the MC7 window and the lower set controls the active circuit window.

**Horizontal and vertical scroll bars**: The scroll bars to the right and lower right of the window let you pan the screen horizontally or vertically. Clicking on the scroll arrows pans the display smoothly, at a rate of roughly 10% of the window width per click.

**Horizontal and vertical splitters**: These black bars can be dragged to split the display either vertically or horizontally. Split display sections have individual scroll control, letting you select widely separated areas for simultaneous viewing.

**Page scroll bar controls**: These controls include left and right page scroll buttons and first page and last page buttons. Clicking on one of the buttons scrolls the view of the page tabs in the direction of the button arrow.

**Page selector tabs**: These tabs let you select a page for display by clicking on its tab with the left mouse button. A right mouse button click on a tab invokes a menu that lets you add a page, delete the tab page, or rename it. Clicking in the region between tabs invokes a button that lets you add pages. Pages can also be added or deleted from the Edit menu.

**Page tab display width control**: The width of the page tab display is controlled by dragging the Page tab width control left or right. This changes the proportion of the scroll bar allocated to the Page scroll bar versus the Horizontal scroll bar.

**Status bar**: This optional bar provides summary descriptions of the menu item or object currently under the mouse cursor, as well as other explanatory messages. Its display can be toggled on or off from the **Options** menu.
Menus

The menus used by MC7 are selected in two ways:

**Mouse menu selection:** To select a menu item with the mouse, move the mouse to the menu and click somewhere on the menu name. The menu pops down, revealing a list of commands or options. Sometimes a submenu appears to the right disclosing further choices. Move the mouse to the desired option and click again.

**Keyboard menu selection:** To select a menu item with the keyboard, simultaneously press the ALT key and either the first letter of the menu name or the underscored letter if one is present. Then select the desired option from the menu by either pressing the first letter (or the underscored letter if one is present) of the option name, or use the UP ARROW or DOWN ARROW cursor keys until the desired option is selected and then press the ENTER key. Submenus are denoted by an arrow pointing to the right. To invoke a submenu, use either the RIGHT ARROW or ENTER key. To collapse a submenu, use the LEFT ARROW cursor key. The cursor keys may also be used to navigate through the activated menu and submenus.
Dialog boxes

When you select options or enter data it is frequently done through a dialog box. Here, for example, is the **Open** dialog box for files:

![Figure 2-19 The Open dialog box](image)

Both the mouse and keyboard may be used for selection or data entry. The selected field will be highlighted or framed.

**Using the keyboard:** The TAB key is used to move among the fields. For text entry fields such as a file name, the data is simply typed in. The SPACEBAR is used to select the Open, Cancel, and Help options. For drop-down boxes or lists, the cursor keys may be used to scroll among the options. Type the first letter of the desired item to rapidly locate the group of items that begin with the letter. In the directories list, the ENTER key and cursor keys are used to change to a new directory. The TAB key moves through the fields in one direction and SHIFT + TAB moves in the opposite direction.

**Using the mouse:** Move the mouse to the desired field and click. For text entry fields such as a file name, the data is simply typed in. For the Open, Cancel, and Help items, click the buttons to select the option. For drop-down boxes, click on the drop-down arrow, and then click on the desired selection. In the directories menu, double click on the directory icon to change to that directory.
The File menu

The File menu provides commands for the management of schematic circuit files, SPICE circuit files, document text circuit files, and model library files.

- **New**: (CTRL + N) This command invokes the New dialog box to create a new file.

- **Open**: (CTRL + O) This command invokes the Open dialog box to load an existing file from the disk.

- **Save**: (CTRL + S) This command saves the active window file to disk using the name and path shown in the title bar.

- **Save As**: This command saves the active window file to disk after prompting the user for a new file name and (optionally) a new path.

- **Paths**: This lets you specify one or more default paths for DATA (circuits), LIBRARY (model libraries), and PICTURE (wmf and bmp picture files). If more than one path is specified, they must be separated by a semicolon (;). MC7 first looks locally in the circuit for model data. It looks in the LIBRARY paths next, searching multiple paths in left to right order.

- **Translate**:
  - **Binary Library to SPICE Text File**: This command translates a binary MC7 library parameter file, FILE.LBR, into a text file, FILE.LIB, containing model statements.
  - **SPICE Text File to Binary Library**: This command translates a SPICE text file, FILE.LIB, containing model statements, into a binary MC7 library parameter file, FILE.LBR.
  - **Schematic to SPICE Text File**: This command creates a SPICE netlist from the active schematic. Any or all analyses may be specified and several types of SPICE formats may be specified.
  - **Schematic to Printed Circuit Board**: These commands create netlist files to be used as input to the Protel, Accel, OrCad, or PADS.
  - **MC7 Schematic to MC5 Version 1 Schematic File**: This command saves the circuit file to disk under the older MC5 Version 1.0 format
• **MC7 Schematic to MC5 Version 2 Schematic File**: This command saves the circuit file to disk under the older MC5 Version 2.0 format.

• **MC7 Schematic to MC6 Schematic File**: This command saves the circuit file to disk in the MC6 format, creating a file that MC6 can read.

• **Bill of Materials**: This command creates a bill of materials for the schematic listing part name, type, value, quantity, cost, and power budget.

• **Load MC File**: This command loads a circuit numeric output file and scans it for references to Monte Carlo performance function error reports. It then creates the circuits which caused errors during the Monte Carlo run, showing each circuit with parameter values which caused failure. Failure means not meeting a performance function limit (like rise time or delay) specified in the original Monte Carlo run.

• **Revert**: This command restores the file in the active window to the one currently on disk.

• **Close**: (CTRL+F4) This command closes the active file. This means it removes it from the MC7 memory but not from the disk. It will optionally ask if you want to save any changes on disk.

• **Print Preview**: This option previews what the printed schematic, analysis plot, 3D plot, performance plot, or Monte Carlo plot will look like with current print options. It also lets you select, move, and re-size the schematic and plot.

• **Print**: (CTRL+P) This command prints a copy of the document shown in Print Preview in accordance with the instructions in Print Setup.

• **Print Setup**: This option changes the printer settings and paper choices. Its format will vary with different printers, but usually it lets you specify a particular printer to use and the paper size, source, and orientation.

• **Recent Files**: This is a list of the most recently used files. You can reload or display any one of them by clicking on its file name. The number of files displayed is set by the **File List** value in the **Common Options** section of the **Preferences** dialog box.

• **Exit**: (ALT+F4) This exits Micro-Cap 7.
The Edit menu

This menu provides the following options. Equivalent tool bar buttons appear next to the commands below.

• **Undo**: (CTRL + Z) MC7 has a multistage undo. It can undo the last N operations that change a circuit file. N is limited only by RAM memory and is usually greater than 20. Undo can also restore the last state of a text field, if the text cursor is still in the field.

• **Redo**: (CTRL + Y) Redo operates in the opposite direction of Undo. It restores the prior circuit state. Like Undo, it can redo the last N operations that change a circuit file.

• **Cut**: (CTRL + X) This command deletes the selected objects and copies them to the clipboard. Objects include text field text and schematic objects.

• **Copy**: (CTRL + C) This command copies selected objects to the clipboard. Objects include text from text fields and schematic objects.

• **Paste**: (CTRL + V) This command copies the contents of the clipboard to the current cursor position. If a group of characters in a text field is currently selected at the time of the Paste operation, they are replaced with the text in the clipboard. If the front window is a schematic, the paste is done from the last point in the schematic where the mouse was clicked.

• **Clear**: (DELETE) This command deletes the selected items without copying them to the clipboard. This command deletes selected wires from their end points.

• **Clear Cut Wire**: (CTRL + DELETE) This command deletes selected wires by cutting them exactly at the sides of the select box.

• **Select All**: (CTRL + A) This command selects all objects in the current window or all text in the current text field or document.

• **Copy to Clipboard**: This command copies all or part of the visible portion of the front window in graphics format to the clipboard. It copies all or a part of the window contents in BMP, WMF, or EMF format to the clipboard. The picture in the clipboard may then be imported via pasting to other programs, such as Word, Excel, or MC7.
You can't paste a *clipboard picture* to MC7, though you can import a picture *file* to MC7 using the **Picture** item from the **Mode** part of the **Options** menu. After selecting the Picture mode, drag or click in the schematic and MC7 prompts for the picture file name.

- **Copy the Entire Window to a Picture File:** This command creates a picture file in BMP, WMF, or EMF format from the front window. The file can then be imported into MC7 or other Windows applications.

- **Add Page:** This command adds a new page to the schematic.

- **Delete Page:** This command deletes one or more schematic pages.

- **Refresh Models:** This command localizes circuit model information by copying subckts and model statements from the libraries to the circuit. It is a handy way to embed model information in the file prior to sending a copy of the circuit to a colleague who may not have your models. It can also serve as a refresh step, restoring model information from the master libraries in case you have edited the models and want to restore them.

- **Box:** These commands affect objects enclosed in the selected region.

  - **Step Box:** This command steps all objects within the selected region vertically, horizontally (or both) a specified number of times.

  - **Mirror Box:** This command creates a horizontal or vertical mirror image of the objects enclosed in a selected region.

  - **Rotate: (CTRL + R)** This command performs a counterclockwise rotation of the objects in a selected region.

  - **Flip X:** This command flips the objects in a selected region about the X-axis. The X-axis is defined as the horizontal line that bisects the selected region.

  - **Flip Y:** This command flips the objects in a selected region about a Y-axis. The Y-axis is the vertical line that bisects the selected region.

  - **Make Macro: (CTRL + M)** This command makes a macro circuit from the circuitry inside of the current box region. It gathers the circuitry into a new circuit, labels the pin names, saves the circuit to disk under a name you choose, records an entry in the Macro section of the
Component library, and replaces the circuitry within the box region with an adjustable macro symbol representing the circuitry. After the macro command, the circuit will simulate just as before, but the schematic will have less clutter.

• **Change:** This option lets you change several attribute features:
  
  • **Properties:** (F10) This accesses the Characteristics dialog box for the circuit window. From here you can change the color of circuit features such as wire or component color. Changes affect all objects rather than just selected objects.
  
  Attributes: This lets you change the display status of the five main attributes of all components in the circuit, *en masse*.
  
  **Color:** This lets you change the attribute color of selected components.
  
  **Font:** This lets you change the attribute font of selected components.
  
  **Rename Components:** This command renames all components using standard naming conventions. It also reorders the components to make the node numbers flow from left to right and top to bottom. It updates the component names in analysis plot expressions, so that R(RRX) changes to R(R5) if the part name is changed from RRX to R5. It does not update node numbers in analysis plot expressions, however, so expressions like V(10) will not be changed to V(2) if node 10 gets changed to node 2.
  
  **Rename Defines:** This command renames all .defined symbolic names where conflicts exist between the symbol name and predefined names.
  
  **Reset Node Positions:** The relative printing position of the node number, node voltage, current, power, and condition can be changed by dragging its text. This command provides a way to restore their original default positions.
  
  • **Bring to Front:** A mouse click on a stack of overlapping objects selects the front object in the stack. If the front object isn't the one you want, a way is needed to select other objects from the stack. This command makes the selected object the front object.
  
  • **Send to Back:** This command makes the selected object the back object.
• **Go To Flag**: This command invokes the Go To Flag dialog box. It lets you reposition the display on a flag. Select a flag and click on the OK button and the program redraws the schematic, with the selected flag at the center of the display. This item is enabled only when there are flags in the schematic.

• **Find**: (CTRL + F) This command invokes the Find dialog box, which is used to search the circuit window for a variety of objects, including part names, node names, attributes text, component type, and grid text.

• **Repeat Last Find**: (F3) This command repeats the search and finds the next object in the circuit that matches the search criteria.

• **Replace**: This option replaces text in a text document or in the text area of a schematic. The replace function for schematic attributes is done from the Attribute dialog box using the Change button.
The Component menu

This hierarchical menu shows the contents of the Component library. The library was created and can be edited by the Component editor, although most users will not need to do much editing. One part of the menu looks like this:

Analog Primitives: The Analog Primitives section contains generic analog components for which the user supplies the values or model statements that define their electrical behavior.

Analog Library: The Analog Library section contains models for commercially available analog components. The values or model statements that define their electrical behavior are provided in the Model library.

Digital Primitives: The Digital Primitives section contains generic digital components for which the user supplies the values or model statements that define their electrical behavior.

Digital Library: The Digital Library section contains models for commercially available digital components. The values or model statements that define their electrical behavior are provided in the Model library.
Animation: This section contains objects which change their display or respond to user clicks during a simulation. The objects include a seven-segment display, an LED, and a switch which toggles its state between 1 and 0 when you click on it. These objects are designed to operate in transient or DC analysis in conjunction with the Animate mode. In this mode, a single analysis step (time or DC voltage or DC current) is taken and the states and animate devices are updated on the schematic. MC7 then waits for either a key press or a specified time delay before taking the next time step. The purpose is to slow the simulation down to show individual node voltage or state changes.

Filters: This section holds filter macros created by the filter design function (accessed from the Design menu). It is absent until one or more filter macros are created.

Find Component: (CTRL + SHIFT + F) This command lets you search the Component library for a part. Because there are thousands of parts in the library, you may need to search for a part without knowing its full name. This command lets you specify a name or a part of the name. It then displays a list of the parts whose names or, other fields, match the characters you have typed in. You then click on the name of the part you want and the OK button and MC7 sets the default part to the one you selected, a click away from adding it to the schematic.

You can search the Name, Shape, Definition, Memo, or All fields and you can specify whether the text must match at the beginning of the field or not.

For example, to search for any parts that use the word filter in their Memo field, select the Memo option and disable the Beginning of Line option. The search shows several switched-capacitor and several linear filters.

To select a component for placement click the mouse on one of the menu items and click on the OK button. When you select a component, MC7 automatically changes the tool mode to Component.

To actually place the component, click the left mouse button in the schematic, or click and drag the component to where you want it to be placed. To rotate the component, click the right button before the left button is released.
Chapter 2: Exploring The Basics

The Windows menu

- **Cascade: (SHIFT + F5)** This command cascades the open circuit windows in an overlapping manner.

- **Tile Vertical: (SHIFT + F4)** This command vertically tiles the open circuit windows in a non-overlapping manner.

- **Tile Horizontal:** This command horizontally tiles the open circuit windows in a non-overlapping manner.

- **Overlap:** This command overlaps the circuit window and the analysis plot window. If the Plot on Top option is enabled, the circuit is maximized and a 1/4 size analysis plot is placed on top, otherwise the plot is maximized and a 1/4 size circuit is placed on top. This option is available only when a normal or Probe-mode transient, AC, or DC analysis is active.

- **Maximize:** This command maximizes a selected circuit window or circuit window icon.

- **Arrange Icons:** This command neatly arranges any minimized circuit window icons.

- **Zoom-In: (CTRL + numeric keypad +)** If the active circuit window is a schematic, this command magnifies the schematic. This command affects only the display, not the printed size. If the active circuit window is a text window, this command draws the window using the next largest font size.

- **Zoom-Out: (CTRL + numeric keypad -)** If the active circuit window is a schematic, this command shrinks it. The command affects only the display, not the printed size. If the active circuit window is a text window, this command redraws the window using the next smallest font size.

- **Toggle Drawing/Text: (CTRL + G)** Every schematic has a drawing area and a text area. The drawing area contains the schematic. The text area stores modeling information, such as model statements, digital stimulus command statements, and source table statements. This command toggles the window display between the drawing and text areas.

- **Split Horizontal:** This command horizontally splits the front schematic window into its drawing and text areas for simultaneous viewing.
• **Split Vertical:** This command vertically splits the front schematic window into its drawing and text areas for simultaneous viewing.

• **Remove Splits:** This command removes any split panes in the window.

• **Component Editor:**
This command accesses the Component editor. This editor is used to manage the Component library. Unless you are adding a new part to the library, or editing an existing one, you will not need to use this editor.

• **Shape Editor:**
This accesses the Shape editor. Each component in the Component library uses a graphical shape, which comes from the Shape library. This editor manages that library. Unless you are adding a new shape to the library, or editing an existing one, you will not need to use this editor.

• **Package Editor:**
This accesses the Package editor, which manages the information needed to generate netlists to drive popular PCB programs.

• **Model Program:**
This accesses the MODEL program, a stand-alone Windows program that models commercial parts by optimizing model parameters to fit data sheet specifications. It was used to model most of the discrete parts in the library.

• **Calculator:**
This command accesses an expression-type calculator that can compute the numerical result of any MC7 expression. For example, while in transient analysis, you can type V(A) - V(B) to see the current differential voltage between nodes A and B, or PD(R1) to see the power currently being dissipated in resistor R1. Variables are current values. If the analysis run is complete, these will be the ending values. If the run is currently paused, these are the values at the point of the pause. The calculator can also do symbolic derivatives. For example, type in 12*SIN(2/A), click on Differentiate and it returns 12*(COS((2/A))*-(2/A^2)).

• **Check Model Library Parameters:** This checks Model library parameters against the limits set in the Model Parameter Limits Editor.

• **Files in Memory:**
This group lists the open files in memory. If multiple circuits have been loaded, you can select any one of them for display from this list.
The Options menu

• **Main Tool Bar:** (CTRL + 0) This toggles the main tool bar on and off.

• **Default Main Tool Bar:** This option restores the default main tool bar.

• **Status Bar:** This option toggles the Status bar on and off.

• **Mode:** This option accesses the Mode submenu. It contains these items:
  
  • **Select:** (CTRL + E) This mode selects objects for editing. To change attribute values like part name or model name, to edit a fragment of grid text, or to select a schematic region for moving or deleting you must be in the Select mode. Normally, you invoke this mode by clicking on the Select button, pressing the SPACEBAR, or by typing CTRL + E, but you may also invoke it by selecting this menu item.

  • **Component:** (CTRL + D) This mode lets you add a component to the schematic. Invoke this mode by clicking on the Component button, typing CTRL + D, or selecting this menu item.

  • **Text:** (CTRL + T) This mode lets you add grid text to the schematic. Grid text can be used for node names and model statements (which can also be placed in the text area). Normally, you invoke this mode by clicking on the Text button, or by typing CTRL + T, but you may also invoke it by selecting this menu item.

  • **Wire:** (CTRL + W) This mode adds orthogonal wires to the schematic. Wires are used to connect components together. Normally, you invoke this mode by clicking on the Wire button, or by typing CTRL + W, but you may also invoke it by selecting this menu item.

  • **WireD:** This mode is used to draw diagonal wires in the schematic.

  • **Line, Rectangle, Diamond, Ellipse, Arc, Pie:** These modes let you draw graphic objects on the schematic or plot. You can select a mode from here, or click on the Graphics button in the Tool bar, then select the desired object from the menu that pops up.

  • **Polygon:** This command lets you place a polygon in an analysis plot. The polygon is intended for use in defining valid specification ranges.
After rough drawing a polygon object, double-clicking on it lets you type in more exact values. The key words MIN and MAX place a polygon vertex coordinate flush with the plot sides.

- **Flag**: This mode is used to place flags on the schematic. Flags are used to mark locations for quick navigation. Normally, you invoke this mode by clicking on the Flag button, but you may also use this menu item.

- **Picture**: This mode lets you place picture files in the schematic.

- **Scale**: (F7) This command puts the analysis plot in Scale mode.

- **Cursor**: (F8) This command puts the analysis plot in Cursor mode.

- **Point Tag**: This mode lets you place a point tag on a plot. A point tag labels the X and Y values of a single data point on a waveform.

- **Horizontal Tag**: This mode lets you place a horizontal tag between two data points. This tag measures and labels the horizontal difference between two data points on one or two waveforms, yielding pulse width or time delay if the X expression is Time.

- **Vertical Tag**: This mode lets you place a vertical tag between two data points. This tag measures and labels the vertical difference between two data points on one or two waveforms.

- **Help**: (CTRL + H) This command invokes the component help mode. This mode lets you click the mouse on a schematic component to see its parameter and model syntax.

- **Info**: (CTRL + I) This invokes the Info mode. In this mode, clicking on a component displays its model parameters, model statement, subcircuit description, or command statement.

- **Point to End Paths**: This command invokes the Point to End Paths mode. In this mode, clicking on a digital component displays all paths from the component clicked to all possible end points. End points include flip-flops and gates which drive no other gates.

- **Point to Point Paths**: This command invokes the Point to Point Paths mode. In this mode, clicking on a digital component displays all paths from the first component clicked to the second component clicked.
• **View**: These options determine what will be drawn on the schematic.

  • **Attribute Text**: If checked, this shows component attribute text.

  • **Grid Text**: This option shows grid text. Grid text is any text created with the Text tool.

  • **Node Numbers**: This option shows the node numbers assigned by the program to each node. Analog nodes have rounded rectangles and digital nodes have normal angular rectangles. Grid text placed on a node may serve as an alias for the node number.

  • **Node Voltages / States**: This option displays the last AC, DC, or transient analysis time-domain node voltages and digital states. If these are the result of an operating point only run, the display shows the DC operating point values.

  • **Current**: This option displays the last AC, DC, or transient analysis time-domain currents.

  • **Power**: This option displays the last AC, DC, or transient analysis time-domain power.

  • **Condition**: This option displays the last AC, DC, or transient analysis time-domain conditions. Conditions define the operating state for devices such as ON, OFF, LIN, SAT, and HOT for BJTs.

  • **Pin Connections**: This option displays a dot at the location of each pin. This helps you see and check the connection points between parts.

  • **Grid**: This option displays the schematic grid.

  • **Cross-hair Cursor**: This option adds a cross-hair cursor.

  • **Border**: This option adds a border to the schematic.

  • **Title**: This option adds a title block to the schematic.

  • **Show All Paths**: This command shows all digital paths and their delays. Selected paths are highlighted on the schematic. It is an immediate command as opposed to the Point to End Paths and Point to Point Paths modes, which require mouse clicks to specify path endpoints before a path list appears.
• Preferences: (CTRL + SHIFT +P) This accesses the Preferences dialog box, where many user preferences are selected. These include:

• **Common Options:** This accesses a list of operational choices:

  • **Select Mode:** This option causes the schematic mode to revert to Select mode after any other mode is completed. For example, to place a component you must be in the Component mode. After placing the component, the mode normally stays in Component mode. If this option is selected, the schematic mode reverts to Select immediately after a component is placed. The same thing would happen when drawing wires, placing text, querying a component, or any other mode-based action.

  • **Sound:** This controls the use of sound for warnings and to indicate the end of a simulation run.

  • **Lock Tool Bar:** This option disables movement and locks the tool bar into its current position.

  • **Print Background:** If enabled, this option adds the user-selected background color to the printouts. It is usually disabled, since most background colors do not print well.

  • **Time Stamp:** This option adds a time stamp to all numeric output files and plots.

  • **Date Stamp:** This option adds a date stamp to all numeric output files and plots.

  • **File List Size:** This value sets the number of file names to include in the Recent Files section of the File menu.

  • **Warning Time:** This sets the duration of warning messages.

• **Analysis Options:** This accesses a list of options related to analysis:

  • **Floating Nodes Check:** This provides a warning for floating nodes (those for which only one component pin is attached).

  • **DC Path to Ground Check:** This checks for the presence of a DC path to ground. It should normally be on.
• **Convergence Assist**: This option enables the Convergence Assist routine which attempts to optimize selected Global Settings parameters to help a circuit converge. It may modify RELTOL, ABSTOL, VNTOL, ITL4, ITL2, METHOD, GMIN, and others to achieve convergence. If it succeeds, it adds a .OPTIONS statement to the circuit with the modified parameters, so that subsequent runs converge more readily.

• **Add DC Path to Ground**: This option automatically adds a 1/GMIN resistor to any path where there is no path to ground.

• **Plot on Top**: If enabled, this option places the analysis plot on top of the schematic if they are overlaid. If unchecked, the schematic floats above the plot.

• **Select Curve Color**: If enabled, this option colors the selected curve branch in the Select Color Primary. It is nearly always on, except when many hundreds of branches would slow down the redraw required by the select color.

• **Inertial Cancellation**: If enabled, this option causes the logic simulator to employ inertial cancellation, which cancels logic pulses whose durations are shorter than the device delay. If this option is disabled, the simulator does not cancel short pulses.

• **Analysis Progress Bar**: If enabled, this option displays a progress bar during a simulation run in the Status Bar area, if the Status Bar feature is enabled on the Options menu.

• **Gmin Stepping**: If enabled, this option tries Gmin stepping after both normal methods and source stepping have failed to achieve DC convergence.

• **Circuit Options**: This accesses a list of options related to circuits:

  • **Text Increment**: This controls whether non-command grid text is incremented during a paste, step, drag copy, or mirror operation. Incrementing means that the ending numerals in the text are increased by one. If no numerals are present, a '1' is added to the text.

  • **Node Snap**: This flag compels components, wires, and text to
originate on a node if a node's pin connection dot is within one grid of the object being placed or moved.

- **Auto Show Model:** This mode causes model statements added to the schematic text area to automatically split the circuit window and show the newly added model statement.

- **Component Cursor:** If enabled, this option replaces the mouse arrow with the shape of the currently selected component whenever Component mode is active. This has the advantage of showing the currently selected component and its size.

- **Rubberbanding:** If enabled, this option causes drag operations to extend the circuit wires to maintain node connections. When disabled, drag operations sever selected wires at their endpoints and drag them without changing their shape or length. SHIFT + CTRL + R toggles the feature on and off to allow the rapid mode switches, necessary when dressing up a schematic.

- **Show Slider:** If enabled, this option places a slider control on the schematic adjacent to batteries and resistors during Dynamic DC Analysis. This lets the user change the battery or resistor values by dragging the slider with the mouse. With or without the slider, the values can be changed by regular amounts with each press of an UP ARROW or DOWN ARROW cursor key.

- **Nodes Recalculation Threshold:** If the Show Nodes option is enabled, nodes are recalculated and displayed whenever any schematic editing is done. For large schematics this can become time consuming. This value sets an upper limit for node count beyond which automatic node recalculation will be ignored, even if the Show Nodes option is enabled.

- **Block Select Display Mode:** This option enables the block select mode, which shows the background of selected objects in the Block Select color. This makes the selected objects easier to spot, especially when there is only one object. If disabled, the selected object is drawn in the standard foreground Select color.

- **Automatically Add Opamp Power Supplies:** This option automatically adds and connects the VCC and VEE power supplies for level 3 opamp primitives. It places the batteries on a
schematic page called Power Supplies. Note that it will not work for vendor-generated opamp subckt models.

- **Color Palettes:** This option lets you define your own palettes. Click on any of the color squares to invoke a color editor that lets you customize the hue, saturation, and luminance of the selected palette color.

- **Format:** This option controls the numeric format to be used when displaying analysis plot tag values, schematic node voltages, currents, powers, DC operating point values in the numeric output text page, formula text, and schematic path delays.

- **Status Bar Text:** This lets you change the Status bar text attributes.

- **Main Tool Bar:** This panel lets you show or hide buttons and tool bars that normally reside in the main tool bar area.

- **Component Palettes:** This lets you name the nine component palettes and control their display in the Main tool bar. You can also toggle their display on and off during schematic use with CTRL + palette number.

- **Auto Save:** This accesses the Auto Save dialog box from which you can enable automatic saving of circuit files to disk every time you run an analysis or on a specific time schedule.

- **Warnings:** This accesses the Warnings dialog box from which you can enable specific warning messages including:
  
  - **File Warning:** This provides a warning when closing an edited file whose changes have not yet been saved.
  
  - **Quit Warning:** This asks if you really want to quit.
  
  - **Opamp Power Supplies:** This alerts the user when MC7 adds VCC and VEE power supplies.
  
  - **Add DC path to ground:** This warns when adding resistors to avoid a DC path to ground.

- **Default Properties For New Circuits:** This dialog box controls the properties of new circuits. It includes:
• **Schematics:** This controls three types of features for schematics:

  - **Color/Font:** This provides control of text font and color for various schematic features such as component color, attribute color and font, and background color.

  - **Title Block:** This panel lets you specify the existence and content of the title block.

  - **Tool Bar:** This panel lets you select the tool bars and buttons that will appear in the local tool bar area located just below the main tool bar.

• **SPICE Files:** This provides two types of features for SPICE text files.

  - **Color/Font:** This provides control of text font and color for SPICE text files.

  - **Tool Bar:** This panel lets you select the tool bars and buttons that will appear in the local tool bar area located just below the main tool bar.

• **Analysis Plots:** This provides control for several analysis plot features:

  - **Scales and Formats:** This panel lets you specify the numeric format for the Numeric Output, plot scales, Cursor mode tables, Optimizer values, and Watch values. It allows selection of Same Y Scales for separate plot groups and lets you select the method for measuring slope: normal, dB/octave, and dB/decade. The latter two are more appropriate to certain AC measurements.

  - **Colors, Fonts, and Lines:** This provides control of text font and color for various plot features such as general scale and title text, window and graph background colors, and individual curve color, thickness, and pattern.

  - **Tool Bar:** This panel lets you select the tool bars and buttons that will appear in the local tool bar area located just below the main tool bar.

• **3D Plots:** This provides control for several 3D plot features:
• **Color:** This provides color control of 3D plot features such as general scale and title text, window and graph background colors, axis colors, patch color, and surface line color.

• **Font:** This provides font control for all text in the 3D plot.

• **Scales and Formats:** This panel lets you select the numeric format for the X, Y, and Z axis scales and the numeric values in the cursor tables.

• **Tool Bar:** This panel lets you select the tool bars and buttons that will appear in the local tool bar area located just below the main tool bar.

• **Monte Carlo Histograms:** This provides control for Monte Carlo histogram plot features:

  • **Color:** This provides color control of histogram features such as general scale and title text, window and graph background colors, and bar colors.

  • **Font:** This provides font control for all text in the histogram.

  • **Tool Bar:** This panel lets you select the tool bars and buttons that will appear in the local tool bar area located just below the main tool bar.

• **Performance Plots:** This panel controls performance plot features:

  • **Scales and Formats:** This panel lets you select the numeric format for plot scales and values shown in the Cursor tables. It also allows selection of same Y scales for separate plot groups.

  • **Colors, Fonts, and Lines:** This provides control of text font and color for various plot features such as general scale and title text, window and graph background colors, and individual plot color, thickness, and pattern.

  • **Tool Bar:** This panel lets you select the tool bars and buttons that will appear in the local tool bar area located just below the main tool bar.
• **Global Settings**: (CTRL + SHIFT + G) This accesses the Global Settings dialog box where many simulation control choices are made. These settings are discussed in greater detail in the Global Settings section of the Circuit editor chapter of the Reference Manual.

• **User Definitions**: This option displays the file MCAP.INC. This file, located on the directory with MC7.EXE, stores global definitions for use in all circuits. The contents of the file are automatically included in all circuit files.

• **Model Parameter Default and Limits Editor**: This editor lets you set the upper and lower limits that the model parameters must have. A warning message is generated and placed in the numeric output file for parameters that do not fall within the Min and Max values.

• **Component Palettes**: This option accesses the Component Palettes. These provide a quick and convenient alternative to the Component menu when choosing components for placement in the schematic. Membership in a palette is specified from the Component editor. The original disks provide several sample palettes containing common analog and digital components. The palettes can be tailored to suit personal preferences. Palette display can be toggled on and off by pressing CTRL + palette number. For example, CTRL + 1 toggles the display of palette 1.
The Analysis menu

The Analysis menu is used to select the type of analysis to run on the circuit in the active window. It provides these options:

• **Transient: (ALT + 1)** This option selects transient analysis. This lets you plot time-domain waveforms similar to what you'd see on an oscilloscope.

• **AC: (ALT + 2)** This option selects AC analysis. This lets you plot frequency-domain curves similar to what you'd see on a spectrum analyzer.

• **DC: (ALT + 3)** This option selects DC sweep analysis. This lets you plot DC transfer curves similar to what you'd see on a curve tracer.

• **Dynamic DC: (ALT + 4)** This option selects an analysis mode in which the program automatically responds to user edits by finding and displaying the DC solution to the current schematic. You can change resistor values and battery voltages with slider controls or with the cursor keys. You can also make any edit such as adding or removing components, editing parameter values, etc. MC7 responds by calculating the DC solution and will display voltages and states if \[
\text{Volts on} \quad \text{is enabled,}
\]

• **Transfer Function: (ALT + 5)** This option selects an analysis mode in which the program calculates the small signal DC transfer function. This is a measure of the incremental change in a user-specified output expression, divided by a very small change in a user-specified input source value. The program also calculates the input and output DC resistances.

• **Sensitivity: (ALT + 6)** This option selects an analysis mode in which the program calculates the DC sensitivity of one or more output expressions to one or more input parameter values. The input parameters available for measurement include all parameters that are available for Stepping, which is practically all model parameters, all value parameters, and all symbolic parameters. Thus you can create a lot of data with this analysis. A suitably smaller set of parameters is specified in the default set, or you can select only one parameter at a time.
• **Probe Transient:** (CTRL + ALT + 1) This selects transient analysis Probe mode. In Probe mode the transient analysis is run and the results are stored on disk. When you probe or click part of the schematic, the waveform for the node you clicked on comes up. You can plot all of the variable types, from analog node voltages to digital states. You can even plot expressions involving circuit variables.

• **Probe AC:** (CTRL + ALT + 2) This option selects AC Probe mode.

• **Probe DC:** (CTRL + ALT + 3) This option selects DC Probe mode.
The Design menu

The Design menu accesses the filter design functions.

• **Active Filters:** This section accesses the Active Filter Designer. This part of the program designs an active filter from your filter. The filter type can be low pass, high pass, bandpass, notch, or delay. The filter response can be Butterworth, Chebyshev, Bessel, elliptic, or inverse-Chebyshev. The filter polynomials are calculated and implemented in one of several different circuit styles, ranging from classical Sallen-Key to Tow-Thomas. Optional plots of the idealized transfer function are available. Filters can be created as circuits or as macro components.

![Figure 2-21 The Active Filter Designer](image)

• **Passive Filters:** This section accesses the Passive Filter Designer. This part of the program designs a passive filter from capacitors and inductors from your filter specifications. The filter type can be low pass, high pass, bandpass, or notch. The filter response can be Butterworth or Chebyshev. The filter polynomials are calculated and implemented in either standard or dual circuit configuration. Optional plots of the idealized transfer function are available. Filters can be created as circuits or as macro components.
The Help system

The Help system provides information on the product in several ways:

• **Contents**: This section provides help organized by Menus and Topics.

• **Search for Help On**: The search feature lets you access information by selecting a topic from an alphabetized list.

• **Product Support**: This option provides technical support contact numbers.

• **Tip of the Day**: This option shows the tips dialog box, which provides short hints on various program features.

• **About Micro-Cap**: This option shows the software version number.

• **Statistics**: This displays a list of statistics showing the key ID, MC7 version number and executable date. In an analysis it also shows the setup and run time, the number of analog and digital nodes, the number of data points calculated during the run, a list of the actual parts in the circuit after macro and subcircuit expansion, and a list of the number of iterations and solutions for the run.

• **Key ID**: This displays the security key ID which you sometimes need when upgrading the program or accessing technical support.

• **Demos**: These live demos show the sequence of actions involved in performing some of the MC7 functions. The demos include:

  • **General Demo**: This provides a general overview of MC7. It includes each of the demos below and runs continuously until ESC is pressed.

  • **3D Plots Demo**: This illustrates the use of 3D plots, which let you show how circuit waveforms or performance functions vary with two different parameters.

  • **Analog and Digital Demo**: This shows how to mix analog and digital parts in a schematic and their analysis plots.

  • **Analysis Demo**: This shows how to start and control an analysis.
• **Animation Demo:** This illustrates the use of the animation feature, in which animated circuit parts like switches, LEDs and seven-segment displays respond to circuit states by turning on and off.

• **Dynamic DC Demo:** This demonstrates the Dynamic DC feature, which automatically calculates the DC operating point of the circuit as it is changed by the user.

• **Filter Demo:** This illustrates the use of the integrated active and passive filter design function.

• **Fourier Demo:** This illustrates the use of the DSP functions to do Fourier analysis on circuit waveforms.

• **Monte Carlo Analysis Demo:** This illustrates the use of Monte Carlo analysis, which analyzes circuit behavior statistically as circuit parameters are varied around specified distributions.

• **Optimizer Demo:** This illustrates the use of the optimizer function to optimize and fine-tune circuits.

• **Performance Plots Demo:** This illustrates the use of performance plots, which let you plot important circuit characteristics, like bandwidth or rise time, versus model and other parameters.

• **Probe Demo:** This illustrates the use of the Probe feature, which lets you plot waveforms by clicking on schematic nodes or components.

• **Schematic Demo:** This shows how to create a schematic.

• **Sensitivity Demo:** This illustrates the Sensitivity analysis mode, which calculates the DC sensitivity of the circuit to one or more parameters.

• **Stepping Demo:** This illustrates the Stepping feature, which lets you systematically step or change model and other parameters to see their effect on circuit behavior.

• **Subcircuits Demo:** This demo shows how to create and use new subcircuits, including how to add them to the Component library.

• **Transfer Function Demo:** This illustrates the Transfer Function analysis mode, which calculates the DC transfer function.
The Component editor

The list of components available for use in a schematic is called the Component library. It is managed by the Component editor which looks like this:

![Component editor diagram]

**Figure 2-22 The Component editor**

To create a component you specify the *Name, Shape, Definition, Initial Text Attribute Locations, and Pin Assignments*. Subcircuits, macros, logic expressions, pin delays, and constraints require named pins.

*Name* is the proper name of the component. It appears in the Component menu when you select a component to add to a circuit.

*Shape* is the name of the shape that is drawn when the part is placed in a circuit. This name is chosen from a list of named shapes created and maintained by the Shape editor. Clicking in the field displays the list.

*Definition* specifies the general mathematical model to be used. Numeric parameter values to be used in the model are specified in a model statement contained in or referenced by the circuit. Clicking in the field displays a list of definitions.

*Memo* is used for descriptive information about the part or its function. It has no effect on electrical behavior.

*Cost* and *Power* are optional and are used in the Bill of Materials report where they are listed individually and included in the circuit totals.
Initial Text Attribute Locations are specified by dragging a generic text block to the desired location relative to the shape for the two orientations. This specifies the initial text location, when the part is first placed in a schematic.

Pin assignments equate visible pin locations with the electrically defined pin names. When you add a part like an NPN transistor, pin names automatically appear and need only be dragged to their proper locations on the shape. Macros, subcircuits, logic expressions, pin delays, and constraints require the user to place a pin and name it. Placing is done by clicking in the Shape area, typing a pin name in the Pin dialog box, specifying whether it's an analog or digital pin, then dragging the pin to a suitable location on the shape.

Editing an existing pin name involves double-clicking on the pin dot or pin name to invoke the Pin Name dialog box. Pins and their names may be independently located on the shape by dragging the pin dot or the pin name. Some digital parts have a variable number of pins and require an additional Pin field to specify the number of input, output, and enable pins. For example, a nor gate may have an unlimited number of inputs. An Input field then specifies the number of inputs.

Assign Component Name to MODEL (or NAME) automatically assigns the component name to the MODEL (or NAME) attribute when the component is added to a schematic. This bypasses the Attribute dialog box, simplifying the process of adding components. This option is enabled on all Analog Library and Digital Library parts and is disabled on all Analog Primitive and Digital Primitive parts.

The Display PART Attribute, Display VALUE Attribute, and Display MODEL Attribute options set the display flag for these attributes. They control the initial display only, when the part is first placed. Afterwards, you can control attribute display by toggling the appropriate display flag in the Attribute dialog box.

The Display Pin Names and Display Pin Numbers options set the initial display flag for showing pin names and pin (package) numbers. These flags can be individually changed on the part when it is placed in a schematic. Pin names are normally shown for complex LSI parts, but not shown for simpler components, such as diodes and transistors, since their shapes adequately identify the pin names. It's easy to identify the base lead of an NPN, but not so easy to identify pin names on a complex linear part. Pin number display is mostly used to facilitate PCB work.

The Palette field lets you assign the displayed part to one of the nine custom user palettes. These pop-up palettes are designed to make component selection easier for frequently used parts. The palettes are invoked with CTRL + palette number.
New File creates a new component library file.

Open File opens an existing component library file.

Merge lets you merge an MC4, an MC5, an MC6, or an MC7 component library file with the current MC7 component library file.

Import Wizard imports subckt-based parts from a text file en masse. It copies the model file to the library folder, adds the file name to the master index file, nom.lib, and makes the required entries in the Component library. It finds all of the subckts in the file and enters each as a new part using the subckt name. Part names already in the library are ignored. New parts are added using as a guide a part selected by the user from a list of parts whose pin names match the new part. New parts whose pins do not match existing parts are added with generic shapes and their memo fields are annotated to indicate that additional work is needed to complete them. Usually this involves picking a suitable shape and placing the appropriate pins on the shape. The Import wizard is optimized for automating the mass import of manufacturer-modeled parts.

Export to MC6 saves the Component library file in MC6 format.

Parts List creates a text file containing the part names from the currently selected group or from the entire library.

Add Part Wizard integrates all of the actions necessary to add a single part to the MC7 libraries. Like the Import wizard, it copies the model file to the library folder, adds the file name to the master index file, nom.lib, and makes the required entries in the Component library. It differs from the Import wizard in that it handles a single part of any type, not just subckts.

Add Part adds a new part to the group selected in the list. To add a part, select a group or component from the list, click this button, then edit the name and other fields. This command doesn't copy model files to the library folder nor add the model file name to the nom.lib as the Add Part wizard does.

Add Group adds a new group at the end of the group currently selected in the hierarchical list. To add a group, select a group from the list, click this button, then edit the generic group name that appears.
Copy copies the current component description to the clipboard in preparation for a subsequent paste to the library.

Paste copies a component description from the clipboard to the library. Except for a generic name, the new component is a copy of the clipboard version.

Replace replaces the current component description with the one in the clipboard except for the part name which remains the same.

If a shape is selected Delete removes the shape. If a file is selected it closes the file, removing its parts from the library. It does not delete the file from disk.

Move accesses a dialog box which facilitates moving multiple parts from one part of the library to another.

Undo undoes prior edits. It is a multistage undo.

Redo restores prior edits. It is a multistage redo.

Find finds parts whose name, shape, definition, or memo fields match a specified text string.

Zoom-In draws the shape larger. Its actual (schematic) size is unchanged.

Zoom-Out draws the shape smaller. Its actual (schematic) size is unchanged.

Info loads and displays relevant model information for the part, usually a subckt listing or a model statement.

Sort lets you sort the parts and/or groups alphabetically.

Clear Palettes removes all component names from the user-defined component palettes.

Help provides information for the Component editor.
The Shape editor

The Shape editor is used to create and maintain the shapes, or graphical images used to represent the component in a schematic. It looks like this:

Shapes are created by selecting drawing tools from the Tool bar and clicking or dragging the mouse in the Drawing region to create a graphical object.

The Scale buttons in the Tool bar change the display size of the shape image shown in the Drawing region.

The Add button adds a new shape. The Delete button deletes the currently selected shape. The Object editor button invokes an editor that lets you edit the specific numerical values that determine a particular object's size or other features.

The Tool bar provides many specific tools and objects which are described in more detail in the Reference Manual.
The Model editor

Model libraries provided with MC7 come in two forms, text and binary.

In text form they are contained in files with the extension LIB, and encode device models as .MODEL, .MACRO, and .SUBCKT statements. Text files can be viewed and edited with any text editor, including the MC7 text editor.

In binary form, model libraries are contained in files with the extension LBR, and are implemented as a list of model parameters for the parts. These binary files can be viewed and edited only with the Model editor. The Model editor is invoked when the File menu is used to open or create a binary library file.

The Model editor should not be confused with the MODEL program, which is accessed from the Windows menu. MODEL is a separate Windows program which produces optimized analog model parameters from commercial data sheets. MODEL can create model libraries in either the text or binary form.

Once binary libraries are created, the Model editor can view and edit them. The Model editor display looks like this:

![The Model editor](image)

Figure 2-24 The Model editor
The various parts of the editor function as follows:

• **Name:** This field is where the part name is entered. If the part has been imported from the MODEL program, this field is a copy of the T1 text field.

• **Memo:** This is a simple text field that may be used for any descriptive purpose. If the part has been imported from the MODEL program, this field is a copy of the T3 text field.

• **Type selector:** This is used to select which device type to display. Each library may contain a mixture of different device types. Selecting NPN for example, displays all of the NPN bipolar transistors in the file.

• **Part selector:** This selects a part by name for display and possible editing. It provides a window to review the specific model values for the displayed part. As in other windows, the Maximize button may be used to enlarge the window to see more of the model values.

• **Add:** This adds a new part of the current device type to the current library.

• **Delete:** This deletes the displayed part.

• **Pack:** This removes all duplicated and untitled parts and reorders the parts alphanumerically.

• **Copy:** This command copies a part from the displayed library to a target library. If the target library already has a part with the same name, the name of the newly created copy is set to "name_copy". The target library may be the current library.

• **Merge:** This command merges a library from disk with the displayed library. The merged library is displayed but not saved to disk.

• **Go To:** This command lets you specify a parameter name, then scrolls the parameter list of the currently displayed part to show the parameter value.

Note that the Find function is available to locate parts by name in the current library file or in one of the library files on disk. Simply click on the Find button in the Tool bar.
Function keys

F1 is used to invoke the Help system. It accesses an information data base by contents and by alphabetical index.

F2 is used to start an analysis after selecting the type of analysis from the Analysis menu.

F3 quits the AC, DC, or transient analysis and returns to the Schematic editor. F3 also repeats the last search when in the Schematic editor.

F4 displays the analysis plot.

CTRL + F4 closes the active window.

F5 displays the Numeric Output window.

F6 scales and plots the selected analysis plot group.

CTRL + F6 cycles through the open windows.

F7 switches the analysis plot to Scale mode.

F8 switches the analysis plot to Cursor mode.

F9 displays the Analysis Limits dialog box for AC, DC, or transient analysis or their Probe equivalents.

CTRL + F9 clears the waveforms in Probe and invokes the Analysis Limits dialog box when in an analysis module.

F10 invokes a dialog box for the front window that lets you change the front window characteristics. The type of dialog box depends upon the type of front window.

F11 invokes the Parameter Stepping dialog box.

CTRL + F11 invokes the Optimizer dialog box.

F12 invokes the State Variables editor.
The Undo and Redo functions

Micro-Cap 7 has a multistep undo and redo capability. All schematic edits can be undone back to the point where the circuit was loaded. In general, text field undo is limited to the last state. The one exception to this is the Component editor, where text field edits are multistep.

Undo is accomplished by clicking on the Undo button \( \text{undo} \) or by pressing CTRL + Z. The Undo function is shown under the Edit menu.

Redo is accomplished by clicking on the Redo button \( \text{redo} \) or by pressing CTRL + Y. The Redo function is shown under the Edit menu.

For instance, suppose you load a circuit, and add a diode to it, then change a resistor value from 1K to 2K, then delete a capacitor. Pressing Undo once restores the capacitor. Pressing Undo again restores the resistor value to 1K. Pressing Undo again removes the diode, restoring the schematic to its initial state. Pressing Redo once restores the diode. Pressing it again restores the resistor to 2K, and a third press deletes the capacitor. Only RAM memory limits the depth of the undo/redo for schematics.

Schematic edits may be undone even after running an analysis. You can delete a region of circuitry from a circuit, run an analysis, then return to the Schematic editor and use the Undo function to restore the circuit to its former condition.

Note that the Revert command on the File menu also functions like a large-scale undo command. It loads the existing version of the front window file from disk, discarding any changes to the front window that occurred since it was loaded.
What's in this chapter

This chapter shows you how to create and edit simple circuits. The goal of this chapter is to introduce the basic techniques and to refine them into working skills by practicing on sample circuits. The particular subjects covered are:

• Schematic creation
  • Adding components
  • Entering component parameters
  • Connecting components with wires
  • Using define and model statements
  • Adding node names

• Schematic editing
  • Text editing modes
  • Editing component parameters and text
  • Deleting objects
  • The clipboard
  • Selection
  • Viewing large schematics
  • Creating and editing SPICE text files
Creating a simple circuit

Begin by double-clicking the mouse on the MC7 icon. The program automatically opens a circuit window and names it CIRCUIT1. Using the mouse, select the Component menu, then Analog Primitives, then Waveform Sources, and finally, select Pulse Source.

![Selecting a part from the Component menu](image)

The cursor changes to a pulse source shape. Click the left mouse button and hold it down. Press the right mouse button and the shape rotates. Eight clicks of the right mouse button produce the eight possible orientations. While still holding the mouse button down, slide the source to a position halfway down the circuit window and near the left window edge. Rotate it until the plus symbol is on top and the minus symbol is on the bottom. Release the mouse button. This activates the Attribute dialog box as shown in Figure 3-2.

For this type of source there are two important attributes, the part name and the model name. MC7 creates a suitable part name, in this case V1, which you can accept or edit. For some parts from the Analog Primitives section, we must also specify a model name. You can type in a new model name or select a model from the Model list box. Select the SAWTOOTH model from the list box.

If you enter a name that is not in the Model library, MC7 loads a set of default parameters. If you pick a part from the Model list, MC7 reads the model parameters from the library source file. Either way the parameters are displayed for
review and editing. The model parameters shown are global, as you can see by the line: Source: Global library located at E:\MC7\LIBRARY\UTILITY.LBR

Place the cursor in the VZERO field and change it from 0 to 1. Click in any other field and the model parameters become local to the circuit as you can see in the line: Source: Local text area of E:\MC7\DATA\CIRCUIT1.CIR

This illustrates a principal point of how MC7 stores and accesses model data such as subcircuit descriptions and model parameters:

*Model data is global until edited when it becomes local to the circuit.*

*Global* means the information is stored in the MC7 library folders. Each time you run an analysis, MC7 uses the global libraries to build the simulation data base.

*Local* means the information is stored within the circuit. Each time you run an analysis, MC7 uses the local in-circuit copy of the models to build the simulation data base.

To localize or simply refresh model information, use the Refresh command. This command can either copy model data into the local circuit or refresh model data already there depending upon the options chosen from its dialog box.
You can see the pulse source waveform by clicking on the Plot button. For this set of parameters the waveform looks like this:

![Pulse Source Waveform]

**Figure 3-3 Characteristic plot of the source**

The Plot button produces zero to three plots for each basic part type (primitive). The plots are created on the fly from mini-simulations of test circuits designed to produce the plot in question. Some parts, like the Pulse source, have a simple simulation and a single plot. Others, like the NPN, have several plots that can be chosen from the plot selector. Some parts, like macros and subckts, have no plot at all since it is impossible to know what would be a relevant plot for a general part like a subckt. Once the plot is up, it responds dynamically to parameter edits. To illustrate, change the value of P4 to 1U and the plot looks like this:

![Pulse Source Waveform with P4=1u]

**Figure 3-4 Characteristic plot of the source with P4=1u**

Click OK to place the edited SAWTOOTH pulse source.
While the Component menu hierarchical structure provides easy access to parts, it can take several steps to find the one you want. A fast way to select frequently used parts is the Component palette. These user-selected parts palettes can be toggled on and off with a single key. You click on the part you want, then leave the palette on the screen or make it disappear with the same key that invoked it. The palettes, numbered 1 to 9, are toggled on and off with CTRL + number. Membership in a palette is specified with the Component editor. For example, CTRL + 1 toggles palette 1 on and off.

We'll use a palette to add a resistor. Press CTRL + 1 to invoke palette 1. The screen should now something look like this:

![Figure 3-5 A user palette](image)

Click on the Resistor name in the palette. Press CTRL + 1 to remove the palette. Drag the resistor to the source and rotate it until it is horizontal. When one of the resistor leads is just touching the top of the source, release the mouse button. If the Node Snap option is on, the resistor lead only needs to be near the source. The resistor lead will snap to the nearest node. Release the mouse button, and the Attribute dialog box will appear. MC7 suggests the name R1 which we’ll accept. Type "1K" for the VALUE attribute, and press ENTER.

Let's move the resistor attribute text. To move anything we must be in Select mode. To activate Select mode, click on the Select mode button in the upper left portion of the Tool bar, or simply press SPACEBAR. Drag the resistor name, R1, and its value 1K, until they are centered, respectively, above and below the resistor body. Attribute text can be moved relative to the part by simply dragging it to the desired position. The initial position of attribute text relative to the shape is
determined in the Component library. After the part is placed, its text attributes (e.g. NAME and VALUE) can be moved as desired. Attribute visibility can also be toggled on and off from the Attribute dialog box.

Figure 3-6 The circuit after moving the value attribute

Select a new part from the Component menu or User palette only if the part is different from the last one chosen.

Select **Analog Library / BJT / 2N0000- / 2N3903- / 2N4013** from the Component menu. This selects the 2N4013, a pre-modeled bipolar NPN transistor. Drag the NPN so that its emitter points down and its base touches the right resistor lead. Click the mouse button. The Attribute dialog box does not appear since all of the parts in the Analog Library and Digital Library groups have their **Assign Component Name to MODEL** flag set. This sets the MODEL attribute to the component name. When you select the part name 2N4013, the model name is known to be the same, and its model parameters are readily available in the model libraries. Since the part name and model name are already known, the dialog box isn't needed and doesn't appear. It is easier to use a part from the Analog Library and Digital Library sections of the Component menu than from the Analog Primitives and Digital Primitives sections. You simply pick a part from the library and drop it into the schematic. No modeling decisions are required. Components chosen from the Analog Primitives and Digital Primitives portion of the library, like the Pulse Source, require a specific model name and parameter set, which may be selected from the libraries or entered by editing if desired.

Invoke palette 1 again with CTRL + 1. Select Resistor from the palette. Click in the schematic and add a 10K resistor. Point it up from the collector lead. Select Battery from the palette and place a battery vertically so that its positive lead touches the top resistor lead. Set its value to 10. From the palette, select Ground. Place a ground vertically with its lead touching the negative battery lead. Add
grounds to the emitter and to the pulse source minus lead. Toggle the palette off with CTRL +1. The circuit should now look like Figure 3-7.

Figure 3-7 The circuit after adding the bipolar stage

To illustrate a third way to select parts, select the Find Component command from the Component menu or press SHIFT + CTRL + F. Enter OP08_AD. Click on the Find and OK buttons. Place the opamp to the right of the NPN.

To illustrate a fourth method of part selection, click on the battery button in the middle of the top row of the Tool bar. Click in the schematic and place a 4.0 volt battery vertically so that its positive lead touches the '99' or 'VCC' lead of the OP08_AD. Click on the ground button in the Tool bar. Place a ground at the negative lead of this battery and at the '50' or 'VEE' lead of the OP08_AD.

For a wire to connect two leads together, the endpoints must terminate on a lead or a wire connected to a component lead. To see where the leads are, click on the Pin Connections button. This draws a small dot at each component lead. You can also display pin names and connections individually for each component by enabling the Display Pin Names option from the Attribute dialog box.

Click on the Wire mode button in the Tool bar or press CTRL + W. This changes the mode so that dragging the mouse draws a wire. Place the mouse at the '3' or 'plus input' lead. Click the mouse button, and while holding it down, drag the mouse horizontally to the left until the wire touches the junction between the collector lead and the resistor lead. Release the mouse button. This connects the two leads together.
Connect the '2' or 'minus input' lead to the '45' or 'output' lead by clicking near the output lead and dragging a wire straight down until it is below the opamp. While still holding the button down, drag the mouse to the left until it is just below the '2' lead. Release the mouse. This creates a right-angled wire extending from the output to an intermediate point below the input lead. Click again at this intermediate point to start a second wire. Drag it to the '2' lead, and release the mouse.

From the Component menu / Digital Library / 74xx00- / 04- / 7404, select the 7404 buffer. Place the buffer horizontally so that its input lead is to the right of the OP08. Draw a wire from the OP08 output lead to the 7404 input lead. Draw another wire from the 7404 output lead horizontally to the right. Finally, draw the final wire from the pulse source plus lead horizontally to the left.

Click on the Text mode button \( \text{T} \) or press CTRL + T to enter Text mode. This mode lets us add text to the schematic. Text placed directly on nodes gives the node a name which can be used to refer to it when plotting its node voltage or digital state.

Click on the horizontal wire just added to the pulse source. When the dialog box comes up, type "IN" and click on the OK button. The lower edge of the selection box outlining the text "IN" should just touch the wire. If it doesn't touch, enable the Select mode and drag the text until it does touch. Add the text "A" to the wire connecting the NPN collector to the OP08 plus input lead. Add the text "C" to the wire connected to the 7404 output.

Figure 3-8 The circuit after wiring the OP08
MC7 assigns node numbers to every analog and digital node to identify them. To see the node numbers, click on the Node Numbers button \( \text{Node Numbers} \) in the Tool bar. The circuit should look like this:

The program automatically assigns numbers to the circuit nodes when an analysis is requested or when the circuit is saved to disk. It displays them on the schematic only when the Node Numbers option is enabled. When you want to plot or print a node's voltage waveform you refer to the waveform as \( V(\text{node name}) \), where the
node name may be either the node number assigned by the program or a text name assigned by you.

For the program to know about node names, they must be placed directly on the node. The lower left corner of the text outline box must be placed directly on the node. Node Snap, if enabled, makes this easier by moving the text to the nearest node within one grid. The Node Snap option is selected from Options menu / Preferences / Common Options / Circuit.

The system assigns and displays node numbers according to the following rules:

1. Ground is node number 0, but its node number is never displayed.

2. The other nodes are numbered from 1 to the highest node number.

3. When an analog node and a digital node touch, or are connected by a wire, each node is assigned a unique number. MC7 automatically inserts an interface circuit between the two nodes. The interface circuit creates an interface node of the form <num>$ATOD or <num>$DTOA depending upon whether the digital node is an input or an output, respectively. If the interface node is accessible (can be referenced in a plot expression), it will be printed on the schematic. In general, interface nodes between analog parts and digital primitives are accessible unless they occur at a subcircuit interface. Since the interface node in this circuit occurs at a subcircuit interface it isn't accessible.

4. Analog node numbers are displayed in a box with rounded corners while digital node numbers are displayed in a box with square corners.

5. Nodes with the same text node name are connected together. This is done to provide a convenient way of connecting large numbers of common nodes.

Save this circuit using the Save As option from the File menu. Type "TUTOR" in the file name field. Remove the circuit by selecting Close from the File menu.
Editing component parameters and text

Schematics are composed of components, text, graphical objects, picture files, and wires. To edit any of these items, the item must be selected. To select an item, MC7 must be in the Select mode. To enable the Select mode, press CTRL + E, click the Select button in the Tool bar, or press SPACEBAR.

Once in the Select mode, objects or regions can be selected for editing, moving, or deleting. To illustrate, load the sample circuit DIFFAMP and click on the Select button in the Tool bar. Move the mouse to the 6V battery in the upper right part of the schematic. Click the mouse in the center of the battery. This selects and redraws the battery. The display mode, Select or Block Select, can be changed through the Preferences dialog box. The Select or Block Select color can be changed in the Properties dialog box (F10).

Figure 3-11 Selecting the battery for editing

Double-clicking on a selected component activates the Attribute dialog box which lets you edit its attributes. Double click on the battery. MC7 presents the dialog box showing the value attribute 6V and awaits your edits. Type "6.5". Click OK. That's how you change the parameter of this simple part.

To change the forward beta of a transistor simply double-click on the device and when the Attribute dialog box comes up, edit the BF parameter. Editing always localizes the parameters. If a transistor's model parameters are global, editing will make them local. Mechanically, localization is implemented by placing a model statement with the edited parameters in the text area of the circuit.
To illustrate, double-click on the Q5 transistor. This invokes the Attribute dialog box which should look like this:

![Attribute dialog box]

Figure 3-12 Editing model parameters in the Attribute dialog box

In this case, MC7 searched for Q5's model statement, N1, and displayed it in the edit area of the dialog box. When searching for the model statement, MC7 first looks in the schematic and text area. If it doesn't find it there, it looks in libraries referenced by a .LIB statement, including the default master index, NOM.LIB. If it still doesn't find the model statement, it makes one up from default parameter values and copies it to the text area.

After locating the model statement (or creating a suitable default), MC7 displays the parameter values in the edit fields. You can scroll through the parameter values, editing them as you wish. When you click OK, MC7 updates your local copy of the model statement. The program never modifies any libraries as a result of these edits. It only modifies model statements local to the circuit.

You can click on any model name in the Model list box. Selecting one of these by clicking on it will change the part's model name attribute. The Cancel button cancels any changes made with the dialog box.

Click the Cancel button.
Deleting objects

We can now edit text and component parameters. How about deleting objects? Like editing, deleting requires that the objects be selected. Once selected, they can be deleted with one of two commands; Cut and Clear. Clear, activated by the Del key, deletes without copying to the clipboard. Cut, activated by CTRL + X, deletes and copies to the clipboard. To illustrate, select the pulse source in the DIFFAMP circuit by clicking it. As usual the program colors it to show that it is selected. Press the Del key and the program removes the source.

Undoing and redoing operations

MC7 provides multistage undo and redo functions to reverse the effects of schematic edits and a simple one-stage undo function for most text fields. To illustrate, press CTRL + Z to undo the deletion. The source, which we just deleted, reappears. Press CTRL + Y to redo the change and the source disappears again.

The clipboard

MC7 maintains two clipboards for temporary storage. One is for schematics and the other is for text fields. There are two important clipboard operations.

To copy something to the clipboard, select it, then press CTRL + C.

To paste the contents of the clipboard to a schematic, click the mouse on the schematic at the desired insertion point and press CTRL + V. The clipboard contents are then copied to the schematic and selected. They can be moved by dragging on any selected object in the group. Clicking on any deselected object deselects all objects.

To illustrate, click on the Select button in the Tool bar. Place the mouse at the upper left of the second differential stage of the DIFFAMP circuit. Drag the mouse to the lower right until the display looks like Figure 3-13. Upon release of the mouse button, objects originating inside the outline box are selected. Objects originating outside the box are not selected.
Now press CTRL + C to copy the selected region to the clipboard. Move the mouse to the right of the battery and click the left button. This moves the insertion point. Press CTRL + V to paste the contents of the clipboard to the insertion point. Your circuit should now look like this:

![Figure 3-13 Selecting a region for copying to the clipboard](image1)

![Figure 3-14 After pasting the clipboard contents](image2)

The saved region has been copied, or pasted, from the clipboard to the schematic.

74 Chapter 3: Creating and Editing Simple Circuits
Selection

Single objects or entire regions may be selected for editing, deleting, moving, rotating, mirroring, stepping, or copying. They may be selected or deselected individually or as a group. Clicking on an object or region while the SHIFT key is down toggles the selection state. If the object or region was formerly selected, it becomes deselected. If it was formerly deselected, it becomes selected.

To illustrate, press the SHIFT key and hold it down. Click on the Q7 transistor in the selected group. Be careful not to click on the name Q7 as that will select the PART attribute rather than the part itself. Release the SHIFT key and the circuit looks like this:

![Figure 3-15 Partial selection using SHIFT + mouse click](image)

The left transistor is now deselected. If you press the Del key, the transistor will remain but the rest of the selected region will be deleted. Press the SHIFT key and click the same transistor and it is again selected. If you now press the Del key, the entire selected region will be deleted.

By using partial selection, virtually any subset of a schematic can be selected for editing, copying, deleting, or moving.

To complete this part of the tutorial, click on the **Revert** option from the **File** menu to restore the DIFFAMP circuit.
Drag copying

Ordinarily, when you drag a selected object or group of objects, the entire group moves with the mouse. However, if you hold down the CTRL key while you drag, MC7 leaves the original selected objects in place, makes a copy, and drags the copy along with the mouse. It’s like tearing off a sheet from a pad of printed copies. As with stepping and clipboard pasting, the part names are incremented. Grid text is incremented only if the Options / Preferences / Common Options / Text Increment option is enabled.

To illustrate with the DIFFAMP circuit, click on the Select button, and drag a region box around the V2 battery at the upper right. Release the button. Press CTRL. Click within the selected region and drag it to the right. Notice that a copy of the selected region is created as shown below.

![Figure 3-16 Drag copying](image)

Drag copying is usually more convenient than clipboard cut and paste when you need to make only one copy. Its one step operation is easier and simpler to use than copying and pasting from the clipboard.

If you plan to paste more than one copy, then copying and pasting from the clipboard is usually faster.
Navigating large schematics

How do you navigate a large schematic?

1. Panning: This is by far the easiest method. To mouse pan, drag the right mouse button. It's like sliding a piece of paper across a desktop. Keyboard panning uses CTRL + <any cursor key> to move the view in the direction of the arrow.

2. Scroll bars: Use the schematic scroll bars. This is slow but sure.

3. Relocation: Use the SHIFT + click method to relocate and change views. While holding down the SHIFT button, click the right mouse button where you want the window centered. Clicking toggles the scale between high and low magnification and centers the schematic at the mouse position.

4. Use the Page scroll bar if the desired area is on another page or use CTRL + PAGE UP and CTRL + PAGE DOWN to navigate the pages.

5. Place flags where desired using the flag mode button. Then select a flag from the list by clicking on the Go To Flag button.

6. Use the Zoom-Out or Zoom-In buttons in the Tool bar.

Figure 3-17 The UA709 circuit
To illustrate these methods, load the circuit UA709. It looks like Figure 3-17. At a resolution of 600 X 800, it’s too large to see at the default scale, so shrink its scale by clicking twice on the Zoom-Out button. At this scale the circuit looks like this:

![Figure 3-18 After clicking the Zoom-Out button](image)

Simultaneously press the SHIFT key and click the right mouse button in the lower right, near the two transistors. This centers the schematic at the mouse position and redraws it at normal scale.

![Figure 3-19 The UA709 after repositioning](image)
Another SHIFT + click redraws the circuit at the low magnification scale. A final
SHIFT + click near the upper left corner returns the schematic to 1:1 scale.

Panning is probably the easiest and most powerful method of moving around most
schematics. To pan, drag anywhere on the schematic using the right mouse button. While holding the button down, drag the mouse and move the schematic.
When the mouse is at or near a window edge, release the mouse button. Repeat
the procedure until the schematic is in the desired position. Pan the UA709 circuit
by clicking near the center and dragging left. This moves the schematic to the left,
exposing more of the right-hand portion.

Finally, you can use flags to navigate the schematic. This method is most useful
for very large schematics where panning might take many attempts to span the
entire schematic. In this method you place flags in the schematic where you ex-
pect to want to visit in the future. Then simply picking the flag from the list cen-
ters the schematic view around the selected flag. To illustrate, click on the Go To
Flag button or select Edit / Go To Flag. Select the 'DIFFPAIR' flag from
the list. This redraws the schematic, centered on the flag, as shown below.

![Figure 3-20 Navigating with flags](image)

Close the UA709 file without saving it.
Creating and editing SPICE text files

MC7 can create and analyze SPICE text file circuit descriptions as well as schematics. SPICE text files may be created externally with a word processor or text editor, or internally using the MC7 text editor. To illustrate the procedure for creating a text file, select the New option from the File menu. This presents a dialog box where you specify the type of file to create. Click on the SPICE/Text option, then on the OK button. This opens a new text window and positions the text cursor at the upper left.

Type in the following:

CHOKE.CKT
V1 1 0 SIN (0 100 50)
V2 0 3 SIN (0 100 50)
D1 1 2 DIO
D2 3 2 DIO
L1 4 2 5
R1 0 2 10K
R2 0 4 10K
C1 0 4 2UF
.MODEL DIO D (IS=1E-14 CJO=10PF)
.TRAN .2m 0.05 0 .2m
.TEMP 27
.PLOT TRAN V(1) V(2) V(3) V(4) -150,200
.END

Save the circuit under the name CHOKE1.CKT using the Save As option from the File menu. Note that SPICE circuit file names do not require or assume an extension. There is no default extension. Any extension except "CIR" can be used. The "CIR" extension is reserved for schematic files. By convention, MC7 uses "CKT" for SPICE files, but any extension, except "CIR", will do.

New SPICE/Text files are created in the same way as schematics, by using the New command from the File menu.
Your circuit should look like Figure 3-21. Press ALT + 1 to run a transient analysis. When the Analysis Limits dialog box is displayed, press F2 to run the analysis. The results should look like Figure 3-22.

After the analysis the program automatically determines suitable scales if needed and plots the requested waveforms as specified in the .PLOT statement.

Exit the analysis by pressing F3, then close the file with CTRL + F4.
Summary

The most important ideas and methods covered in this chapter are:

• To open a new schematic use the **New** item on the **File** menu, or use the one automatically opened when the program first starts.

• Change the default component if it is different from the one you want to add. Default components are selected from the Component menu, a Component palette, or one of the part buttons in the Tool menu.

• To add a component, press CTRL + D or click the Component mode button. Select the component you want from the Component menu, User palette, or Tool bar button. Click the mouse on the schematic and drag it into place. If necessary, change its orientation with the right mouse button.

• Press CTRL + W or click the Wire item in the Tool bar to add wires.

• Components are connected with wires. To add a wire, click at one endpoint, drag the mouse to the other endpoint, then release it. Crossing wires do not connect.

• Press CTRL + T or click the Text button in the Tool bar to add text.

• Add text to nodes to name them for easy reference or use the node numbers. Nodes with the same name are connected.

• To edit, move, copy to the clipboard, or delete an object, it must first be selected. To select an object, press CTRL + E to enter the Select mode, then click the object. To select a region, drag the mouse over the region. Use SHIFT + click to deselect an object in a selected group.

• Selected objects are copied to the clipboard with CTRL + C and pasted to the cursor location with CTRL + V.

• CTRL + drag copies and renames selected objects.

• Navigating a schematic is done by scrolling, panning, changing the scale, positioning with SHIFT + click, using flags, and page scrolling.
Chapter 4 Transient Analysis

What's in this chapter

Transient analysis is the topic of this chapter. Using the MIXED4 circuit, the capabilities of the time domain simulator are explored. The goal is to introduce and build a sound understanding of these basic subjects:

• Controlling the analysis through the Analysis Limits dialog box

• Selecting curves to plot or print

• State variables and initialization

• State Variables editor
The Transient Analysis Limits dialog box

Load the MIXED4 circuit file and select Transient from the Analysis menu. MC7 extracts the necessary circuit information directly from the schematic. More information is needed before the analysis can begin, and that information is supplied by the Analysis Limits dialog box.

The Analysis Limits dialog box has five main areas: Command buttons, Numeric limits, Curve options, Expression fields, and Options.

The Command buttons, located just above the Numeric limits field, contain seven commands.

- **Run**: This command starts the analysis run. Clicking the Tool bar Run button or pressing F2 will also start the run.

- **Add**: This command adds another Curve options field and Expression field line after the line containing the cursor. The scroll bar to the right of the Expression field scrolls through the curves when there are more than can be displayed.

- **Delete**: This command deletes the Curve option field and Expression field line where the text cursor is.
Expand: This command expands the text field where the text cursor is into a large dialog box for editing or viewing. To use the feature, click the mouse in the desired text field, and then click the Expand button.

Stepping: This command invokes the Stepping dialog box. Stepping is covered in a separate chapter.

Properties: This command invokes the Properties dialog box which lets you control the analysis plot window and the way curves are displayed.

Help: This command invokes the Help Screen. The Help system provides information by index and topic.

The Numeric limits field provides control over the analysis time range, time step, number of printed points, and the temperature(s) to be used.

- **Time Range:** This field determines the start and stop time for the analysis. The format of the field is:

\[
<\text{tmax}> [,<\text{tmin}>]
\]

The run starts with time set equal to \(tmin\), which defaults to zero, and ends when time equals \(tmax\).

- **Maximum Time Step:** This field defines the maximum time step that the program is allowed to use. The default value, \((tmax)-tmin)/50\), is used when the entry is blank or 0.

- **Number of Points:** The contents of this field determine the number of printed values in the numeric output. The default value is 51. Note that this number is usually set to an odd value to produce an even print interval. The print interval is the time separation between successive printouts. The print interval used is:

\[
\text{print interval} = (tmax - tmin) / (number of points - 1)
\]

- **Temperature:** This field specifies the global temperature of the run. This temperature is used for each device unless individual device temperatures are specified. If the Temperature list box shows Linear the format is:

\[
<\text{high}> [,<\text{low}> [,<\text{step}> ]]
\]
The values are in degrees Celsius. The default value of <low> is <high>, and the default value of <step> is <high> - <low>.

If the Temperature list box shows List the format is:

<\( t_1 \) > [ , <\( t_2 \) > [ , <\( t_3 \) > ] [ ....] ]

where \( t_1, t_2, \ldots \) are individual values of temperature.

One run is produced for each requested temperature, producing multiple branches of each curve.

Curve options

The Curve options field is located below the Numeric limits field and to the left of the Expressions field. Each curve option affects only the curve in its row. The options function as follows:

The first option toggles the X-axis between a linear and a log plot. Log plots require positive scale ranges.

The second option toggles the Y-axis between a linear and a log plot. Log plots require positive scale ranges.

The option activates the color menu. There are 64 color choices for an individual curve. The button color is the curve color.

The option prints a table of the curve's numeric values. The number of values printed is set by the Number of Points value. The table is printed to the Numeric Output window and saved in the file CIRCUITNAME.TNO.

A number from 1 to 9 in the (P) column places the curve into a numbered plot group. All curves with like numbers are placed in the same plot group. If the P column is blank, the curve is not plotted.

Expressions

The X Expression and Y Expression fields specify the horizontal (X) and vertical (Y) expressions. MC7 can evaluate and plot a wide variety of expressions for either scale. Usually these are single variables like \( T \) (time), \( V(10) \) (voltage at node 10), or \( D(OUT) \) (digital state of node OUT), but the expressions can be more elaborate like \( V(2,3)*I(V1)*\sin(2*\pi*1E6*T) \).

Variables list

Clicking the right mouse button in the Y expression field invokes the Variables list which lets you select variables, constants, functions, and operators, or expand
the field to allow editing long expressions. Clicking the right mouse button in the other fields invokes a simpler menu showing suitable choices.

The X Range and Y Range fields specify the numeric scales to be used when plotting the X and Y expressions.

The format is:

\[ <\text{high}> [,<\text{low}>] [,<\text{grid spacing}>] [,<\text{bold grid spacing}>] \]

<low> defaults to zero. [,<grid spacing>] sets the spacing between grids. [,<bold grid spacing>] sets the spacing between bold grids. Placing "AUTO" in the scale range calculates that individual range automatically. The Auto Scale Ranges option calculates scales for all ranges during the simulation run and updates the X and Y Range fields. The Auto Scale (F6) command immediately scales all curves, without changing the range values, letting you restore them with CTRL + HOME if desired. Note that <grid spacing> and <bold grid spacing> are used only on linear scales. Logarithmic scales use a natural grid spacing of 1/10 the major grid values and bold is not used. The Auto Scale command uses the Preferences / Auto Scale Grids value to set the grid spacing if none is specified in the range.

These options include the following:

- **Run Options**
  - **Normal:** This runs the simulation without saving it.
  - **Save:** This runs the simulation and saves it to disk, using the same format as in Probe. The file name is CIRCUITNAME.TSA.
  - **Retrieve:** This loads a previously saved simulation and plots and prints it as if it were a new run. The file name is CIRCUITNAME.TSA.

- **State Variables**
  These options determine the state variables at the start of the next run.
  - **Zero:** This sets the state variable initial values (node voltages, inductor currents, digital states) to zero or X.
• **Read**: This reads a previously saved set of state variables and uses them as the initial values for the run.

• **Leave**: This leaves the current values of state variables alone. They retain their last values. If this is the first run, they are zero. If you have just run an analysis without returning to the Schematic editor, they are the values at the end of the run. If the run was an operating point only run, the values are the DC operating point.

• **Operating Point**: This calculates a DC operating point. It uses the initial state variables as a starting point and calculates a new set that represents the DC steady state response of the circuit to the T=0 values of all sources.

• **Operating Point Only**: This calculates a DC operating point only. No transient run is made. The state variables are left with their final operating point values.

• **Auto Scale Ranges**: This sets the X and Y range to AUTO for each new analysis run. If it is not enabled, the existing scale values from the X and Y Range fields are used.

The Run, State Variables, and Analysis options affect the simulation results. To see the effect of changes of these options you must do a run by clicking on the Run command button or pressing F2.
Selecting curves to plot or print

MC7 automatically creates a set of analysis limits for newly created circuits. It tries to guess what curves you may want to look at and what plot and analysis options you may want. Usually, it is necessary to change these initial guesses. Changes you make to any entry in the Analysis Limits dialog box are saved with the circuit file, so you don't need to enter these each time you run.

Click on the Run button to do the transient analysis of the MIXED4 circuit.

![Figure 4-2 Transient analysis of MIXED4](image)

The top five curves are digital and show the CLR input, clock input, the state outputs of the first two flip-flops, and the decimal value of the three flip-flop outputs. The next two curves are plots of the voltage at the input pulse source and the output of the analog section. In general, V(A) plots the voltage on an analog node A. D(B) plots the state of a digital node B.

You can plot expressions using a variety of variables such as node voltage or device terminal voltage or current. To plot different curves, you can add new curve fields or you can change existing ones. To illustrate, press F9 to display the Analysis Limits dialog box. Click in any column of the last row. Click the Add button in the upper part of the dialog box. This adds a new curve row and moves the text cursor to the P column of the new row. It also duplicates the contents of all fields of the row above. Click the Delete button. This deletes the curve just added. Click the Add button to add the curve row back. Since we want the new
curves to be placed on a separate plot group, change the '1' in the P column to '2'. Press the Tab key twice or click the mouse in the Y Expression field. Type in the following:

"IC(Q4)*VCE(Q4)"

Press the Tab key twice to move the cursor to the Y Range field and type "Auto". This tells the program to determine the Y scale range automatically, after the run. During the run, MC7 uses a default scale to start the plot. Several times during the run it will revise the scales based upon the curves. When the run is complete, MC7 determines the scale necessary to show the complete curves, plots it, and enters the new scales into the X and Y range fields.

If you can't remember the variable or function name you want, use the Variables list as a memory aid. To illustrate, click the Add button again. Click in the new Y Expression field with the left mouse button and drag select the entire Y expression. Click on this selected Y expression with the right mouse button. This invokes the Variables list, a small pop-up menu that lets you select variables, functions, and operators. It also lets you expand the limited text editing area to a full size text edit dialog box. This is handy for complex expressions with many parentheses. Click on Variables and then on Device Currents. This displays a dialog box with a list of the available device currents in the circuit. Click on I(VCC), then on OK. The text "I(VCC)" is entered in the Y Expression field and the cursor is placed to the right of the text. The Y expression will now look like this:

\[ I(VCC) \]

Type "*". Click the right mouse button and select Variables / Device Voltages / V(VCC). Click OK. The Y expression should now look like this:

\[ I(VCC)*V(VCC) \]

Press the Home key to move the cursor to the start of the field. Click the right mouse button and click Functions / Calculus / SUM. SUM is the integration operator. It integrates the expression to the right of the text cursor, with respect to the X expression variable, \( T \). Press the End key to put the cursor at the end of the field and type "/T". This produces an expression for the average power supplied by the VCC battery. The Y expression should now look like this:

\[ \text{SUM}(I(VCC)*V(VCC),T)/T \]

Since the new curve was created with AUTO in the Y Range field we do not
need to edit that field. After the run, MC7 will determine the actual range and calculate a suitable Y scale. Because there are two curves sharing the same plot group, it can do this two ways; 1) by finding a common scale large enough to show all of both graphs, or 2) by finding an individual scale for each curve and printing two Y scales. The choice is determined by the **Same Y Scales** option on the **Scope** menu. If this option is checked, then all curves in each plot group will share a common scale large enough to plot all parts of each curve. This is true regardless of whether auto or user-specified scales are used. If you select this option, MC7 draws a single scale using the largest of the specified or calculated scales. Click the Run button. Here is how the new run looks when the option is disabled.

![Figure 4-3 Transient analysis with two plot groups](image)

Group 1 contains the original curves. Group 2 contains the new curves: the instantaneous collector power of the output transistor Q4, and the average power supplied by the VCC battery. Plot grouping is specified by the P column number. All curves with the same number are plotted in the same group.

Analog and digital curves may be grouped together or separately. When grouped together, digital curves are plotted in the same order they occur in the dialog box, starting at the top of the graph. Analog curves are plotted using the range scales, which only apply to analog curves. This can cause the curves to overlap. Overlap can be minimized by compressing the analog curves with a large Y Range value. Separating analog and digital curves into groups avoids overlap but is less convenient when comparing the two sets of curves at the same time value.
To see what the curves would look like with common Y scales, enable the **Same Y Scales** option on the **Scope** menu. This is what the plots look like:

![Figure 4-4 The plot with the Same Y Scales option enabled](image)

The two scales have been collapsed into a common scale, containing the largest and smallest scale value from each.

While color identifies individual curves, black and white printers create plots where it is hard to tell the curves apart. Tokens can help identify the different curves. To illustrate, click on the **Tokens** button.

![Figure 4-5 The plot with tokens](image)
The Plot Properties dialog box

Curve display and format can be changed with the Plot Properties dialog box. Press F10 to invoke the dialog box for the plot. It looks like this:

![The Properties dialog box](image)

**Figure 4-6 The Properties dialog box**

Click on the V(OUT) curve and the **Colors, Fonts, and Lines** tab. From the Curve Line group select a width of 3. For the V(IN) plot select the third pattern in the list. Click the OK button. Disable tokens by clicking the **Tokens** button in the Tool bar. The screen should look like this:

![Using line width and pattern](image)

**Figure 4-7 Using line width and pattern**
The Plot Properties dialog box lets you control the analysis plot window. It is especially useful for controlling how curves are displayed after or even before the plot. Before a plot exists, you can access this dialog box by clicking on the Properties button (Press Esc to remove the Analysis Limits dialog box if present). The dialog box provides the following choices:

- **Plot**
  - **Curves:** This list box lets you select the curve that the Plot and Graph fields apply to.
  - **Title:** This field lets you specify what the plot title is to be.
  - **Curve:** This group's check box controls whether the curve will be plotted or not. If you want to delete the curve from the plot group, remove the check mark by clicking in the box.
  - **Plot Group:** This list box controls the plot group number.
  - **Plot Type:** This list box controls the plot type. The three available types include rectangular, Smith Chart, and polar. Only rectangular is available for transient analysis.

- **Scales and Formats**
  - **Curves:** This lets you select the curve that the other fields apply to.
  - **X:** This group includes:
    - **Range Low:** This is the low value of the X range used to plot the selected curve.
    - **Range High:** This is the high value of the X range used to plot the selected curve.
    - **Grid Spacing:** This is the distance between X grids.
    - **Bold Grid Spacing:** This is the distance between bold X grids.
    - **Scale Format:** This accesses a dialog box where you select the numeric format used to print the X axis scale.
• **Value Format:** This accesses a dialog box where you select the numeric format used to print the X value in the cursor table and in the tracker boxes.

• **Auto Scale:** This command scales the X Range and places the numbers into the Low, High, and Interval fields. The effect on the plot can be seen by clicking the Apply button.

• **Log:** If checked this makes the scale log.

• **Y:** This group provides corresponding commands for the Y axis group:

  • **Range Low:** This is the low value of the Y range used to plot the selected curve.

  • **Range High:** This is the high value of the Y range used to plot the selected curve.

  • **Grid Spacing:** This is the distance between Y grids.

  • **Bold Grid Spacing:** This is the distance between bold Y grids.

  • **Scale Format:** This is the numeric format used to print the Y axis scale.

  • **Value Format:** This accesses a dialog box where you select the numeric format used to print the Y value in the cursor table and in the tracker boxes.

  • **Auto Scale:** This command scales the Y Range and places the numbers into the Range Low, Range High, and Interval fields. The effect on the plot can be seen by clicking the Apply button.

  • **Log:** If checked this makes the scale log.

• **Same Y Scales:** If enabled, Auto Scale determines a single common scale for all curves within a plot group. If the box is unchecked, the Auto Scale command determines individual scales for each curve.

• **Save Range Edits:** Enabling this check box causes any edits to the range fields to be copied to the appropriate range fields of the Analysis Limits dialog box, making them permanent.
Slope Calculation: This lets you pick Standard, dB/Octave, or dB/Decade method of calculating slopes. The latter two are useful in AC analysis.

Use Common Formats: Clicking this button copies the X and Y formats of the selected curve to the format fields of all curves.

• Colors, Fonts, and Lines

• Objects: This list box lets you select the object that the other group controls apply to. Objects include:

  • General Text: This is text used for axis scales, titles, cursor tables, and curve names.

  • Grid: This is the analysis plot grid.

  • Graph Background: This is the plot background.

  • Window Background: This is the window background.

  • Select: This is the Select mode.

  • Select Box: This is the Select mode box.

  • Initial Object: This governs the initial properties of analysis text, graphical objects, and numeric tags. Object properties can be changed after they are added to a plot by double-clicking on them in Select mode.

  • Tracker: This controls the visual properties such as color and font of the numeric cursor trackers.

  • Select Color Primary: This sets the color of the curve that the left cursor is on when there is more than one branch.

  • Select Color Secondary: This sets the color of the curve that the right cursor is on when there is more than one branch and the two cursors are on different branches.

  • Data Point Labels: This controls the visual properties such as color and font of the data point labels.
• **Curve Names**: This controls the visual properties of the lines and text used to display each curve. "Plot All" lets you set properties for all curves simultaneously.

• **Object Names (Color)**: This group lets you change the foreground and background color and other object characteristics of selected objects.

• **Font**: This group lets you change the font of the selected object.

• **Size**: This group lets you change the text size of the selected object.

• **Style**: This group lets you change the text style of the selected object.

• **Effects**: This group lets you change text effects of the selected object.

• **Sample**: This group shows a sample curve line using currently selected color, width, and pattern properties.

• **Header**: This group controls the header format for text numeric output.

  • **Left**: This group lets you add text to the left side of the text output.

  • **Center**: This group lets you add text to the center of the text output.

  • **Right**: This group lets you add text to the right side of the text output.

In each case the following formats are available:

- $MC$: Prints Micro-Cap
- $User$: Prints user name
- $Company$: Prints company name
- $Analysis$: Print analysis type (Transient, AC, DC)
- $Name$: Prints circuit name

You can use these or any other text in the left, center, or right.

• **Delimiters**: This group lets you select the delimiter that will be placed between items in the text output. The choices are Tab, Semicolon, Comma, Space, or Other.

• **Save Curves**: This group lets you save one or more curves for later display in a plot or use in a User source. It provides these fields:
**Curves:** This lets you select the curve that the other fields apply to.

**Temperature:** If the analysis run stepped temperature and produced multiple curves this field lets you select which to save.

**Stepped Variable:** If the analysis run stepped a variable and produced multiple curves, this field lets you select which to save.

**Save Curve:** This field is a copy of the selected curve name.

**As (New Name):** This field lets you specify the curve's name. It is the name you use later to display or use the curve in a source.

**In File:** This field specifies the file name for the curve.

**Save:** This command saves the selected curve using the specified curve name and file name. Note that when curves are saved to existing files, they are added to the file. If the curve already exists in the file, it is overwritten. All other curves in the file are unaffected.

**Browse:** This command lets you browse directories for the file name you want to save the curve under or to delete.

**Delete:** This command lets you delete the specified curve.

**Tool Bar:** This page lets you select the buttons that will appear in the local tool bar area below the Main tool bar.

The four buttons at the bottom have the following function:

**OK:** This button accepts all changes, exits the dialog box, and redraws the analysis plot. Subsequent runs will use the changed properties and they will be retained in the circuit file, if the file itself is later saved.

**Cancel:** This button rejects all changes, exits the dialog box, and redraws the analysis plot using the original properties.

**Apply:** This button redraws the analysis plot using the current settings in the dialog box to show how the display would be affected by the changes. The changes are still tentative, until the OK button is clicked.

**Help:** This displays the help information for the Plot Properties dialog box.
Let's experiment with some of the other options. Click on the Data Points button. This toggles the display of marker icons for the calculated data points. Since the option was initially disabled, clicking the button enables it, and the data point marker icons are added producing a plot that looks like this:

![Figure 4-8 The plot with the Data Points option enabled](image)

Since the simulator uses a variable time step algorithm to minimize errors and accelerate the run, the actual time points will not be regularly spaced. The data point markers are placed at the actual computed time points. There are at least two situations where you might want to see these:

Inadequate curve sampling: This can happen in transient analysis when the simulator flies past a switch threshold. It may also happen that you want more data points to "fill in" source curves that look choppy. Even though the charge error is strictly controlled by the internal truncation error routines, the data sampling may seem inadequate. Data point icons show where the data points are and whether more will help. In AC analysis, your plot may miss a steep spike on a narrow pass or reject band. Data point icons show whether the simulator actually made a calculation within the band.

Identifying real curve spikes: Sometimes you see spikes on curves. If the curve changes direction from one data point to the next, it's likely the spikes are simply artifacts of the integration routines. The only way to tell is to mark the data points. If they are integration artifacts, you can reduce them by decreasing RELTOL or the minimum time step or both.
To illustrate some other options, click on the horizontal axis grid and vertical axis grid buttons. The plot should now look like this:

![Figure 4-9 Adding grids to the plot](image)

Press F9, then click on the Operating Point and Operating Point Only buttons. This tells the program to do an operating point calculation, and then stop. An operating point calculation sets all sources to their defined initial values, removes all capacitors, and replaces all inductors with short circuits. It then calculates the steady-state DC values of the state variables (node voltages, inductor currents and digital states) at the initial time point. This set of values is referred to as the DC operating point. Press F2 to do the operating point only run. Since we're doing only an operating point, no plot will appear. Exit the analysis by pressing F3. Click on the Node Voltage button and MC7 displays the last calculated states and voltages. In this case, since we just completed an operating point only calculation, these are the operating point values.
State variables and initialization

State variables are the variables that uniquely define the state of the circuit. These include node voltages, inductor currents, and digital node states. MC7 determines the initial state variable values according to the following rules:

When you first select transient analysis, MC7 sets all state variables to zero and all digital levels to X. This is called the setup initialization.

Each time you start a new run, with F2 or clicking the Run button, MC7 does the run initialization. To decide what to do, it looks at the State Variables option from the Analysis Limits dialog box. There are three choices:

**Zero:** Node voltages and inductor currents are set to 0. Digital levels are set to X, or in the case of flip-flop Q and QB outputs, to 0, 1, or X depending upon the value of the global variable DIGINITSTATE. This value is accessed from Options / Global Settings.

**Read:** MC7 reads the variables from the file CIRCUITNAME.TOP. The file is created by the State Variables editor Write command.

**Leave:** MC7 does nothing to the state variables. It simply leaves them alone. There are three possibilities:

- **First run:** If the variables have not been edited with the State Variables editor, they still retain the setup initialization values.
- **Later run:** If the variables have not been changed by the State Variables editor, they retain the ending values from the last run.
- **Edited:** If the variables have been changed by the State Variables editor, they are the values shown in the editor.

The states of all nodes connected to digital stimulus sources are changed to the T=0 value. Using these initial values, an optional operating point calculation may be done. If an operating point is done, the state variables are, of course, changed accordingly. If an operating point is not done, the state variables at the first (T=0) time point are used as initial conditions for starting the run, but interpolated backwards from the second and third time points after the run is over. If the Operating Point Only option is enabled, the analysis ends after the operating point calculation and the final state variable values are the DC operating point values.
The State Variables editor

To illustrate the State Variables editor load the circuit, MIXED1. It looks like this:

![Figure 4-10 The MIXED1 circuit](image)

This circuit contains an analog section driving a digital section. Select **Transient** from the **Analysis** menu. The analysis limits look like this:

![Figure 4-11 The MIXED1 analysis limits](image)
Press F2 to start the run. The results look like this:

Select the **State Variables Editor** from the **Transient** menu. It looks like this:

This editor lets you view and edit state variable values. State variables consist of node voltages, shown in the left column, inductor currents, shown in the middle column, and digital node levels, shown in the right column. Node voltages and digital node levels are identified by the node name, if one exists, or the node number otherwise. Inductors are identified by the part name.

The display shows the current values of the state variables. Since we've just finished a transient analysis these values are from the last data point of the run.

Let's experiment with these values. Double-click the mouse in the L1 inductor field and type ".2". This sets the inductor current to 0.2 amps. Double-click in the OUT voltage field and type "6". This sets the OUT node to 6.0 volts. Double-click
in the OUT2 digital node level field and type "X". This sets the OUT2 node level to X. Click on the Close button. The Run Options from the Analysis Limits dialog box are set to skip the operating point and to leave the state variables when we start the run. These choices tell the program to use the current state variables values, which we have just edited, for the initial values. Since we have requested no operating point, the initial point on the plot should reflect the values in the State Variables editor. Press F2 to start the run. When the run is complete, press F8 to place the display in the Cursor mode. The results look like this:

Notice that the initial value of V(OUT) (shown under the Left cursor column), is the 6.0 volts we specified in the State Variables editor. Similarly, the initial value of the inductor current is 0.2 and the initial value of the digital level of node OUT2 is X.

Exit the analysis with F3 and close the circuit file with CTRL + F4.
Chapter 5  AC analysis

What's in this chapter

AC analysis is the topic for this tutorial. In particular, these subjects are covered:

- AC analysis
- The AC Analysis Limits dialog box
- Experimenting with the options and limits
- Selecting curves to plot or print
- Picking plot options
- Numeric output
- Input and output noise plots
- Nyquist plots
- Smith charts
- Polar plots
AC analysis

What happens during an AC analysis? First, an optional DC operating point is calculated. Digital nodes stabilize at an operating point state and potentially affect analog nodes to which they may be attached. Linearized, small signal AC models are then created for each component and integrated into a set of linear network equations. These are repeatedly solved at many frequency points to obtain the small signal response of the circuit to whatever AC excitation is present in the circuit. The linearized AC model of a digital component is an open circuit. This means that digital parts are ignored during small signal analysis.

The excitation is supplied by one or more independent curve sources in the circuit. Pulse and Sine sources provide a fixed, real, 1.0 volt AC signal. User sources provide a signal comprised of the real and imaginary parts specified in their files. The SPICE independent sources, V and I, provide user-specified real AC signal amplitudes. Function sources can create an AC signal only if they have a FREQ expression. These are the only sources that generate AC excitation.

AC analysis represents the excitation and system variables (node voltages and various branch currents) as complex quantities. Operators, such as RE (real), IM (imaginary), dB \((20\times\log())\), MAG (magnitude), PH (phase), and GD (group delay) are provided to print and plot these complex quantities.

To explore AC analysis, load the file DIFFAMP. It looks like this:

![DIFFAMP circuit](image)

**Figure 5-1 The DIFFAMP circuit**
Choose **AC** from the **Analysis** menu. When the AC Analysis Limits dialog box comes up, the fields should look like this:

![AC Analysis Limits dialog box](image)

**Command buttons**

**Numeric limits**

**Curve options**

**Expressions**

**Figure 5-2 The AC Analysis Limits dialog box**

In this circuit, we have a single source providing a 1.0 volt AC signal. The dialog box instructs MC7 to sweep the frequency from 1K to 10Meg and produce plots of the magnitude of the voltage at the node OUTA and the phase angle of the voltage at node OUTB. Press F2 and the result looks like this:

![AC analysis plot](image)

**Figure 5-3 The AC analysis plot**
The AC Analysis Limits dialog box

The Analysis Limits dialog box is divided into five principal areas: the Command buttons, Numeric limits, Curve options, Expressions, and Options.

The command buttons are located just above the Numeric limits.

**Run:** This command starts the analysis run. Clicking the Tool bar Run button or pressing F2 will also start the run.

**Add:** This command adds another Curve options field and Expression field line after the line containing the cursor. The scroll bar to the right of the Expression field scrolls the curve rows when needed.

**Delete:** This command deletes the Curve option field and Expression field line where the text cursor is.

**Expand:** This command expands the working area for the text field where the text cursor currently is. A dialog box is provided for editing or viewing. To use the feature, click in an expression field, then click the Expand button.

**Stepping:** This command calls up the Stepping dialog box. Stepping is reviewed in a separate chapter.

**Properties:** This command invokes the Properties dialog box which lets you control the analysis plot window and the way curves are displayed. See the Plot Properties dialog box article in Chapter 4, "Transient Analysis".

**Help:** This command calls up the Help Screen. The Help System provides information by index and topic.

The definition of each item in the Numeric limits field is as follows:

**Frequency Range:** This field controls the frequency range for the analysis. The syntax is \(<\text{Highest Frequency}> [, \text{Lowest Frequency}>]. If \text{Lowest Frequency} is unspecified, the program calculates a single data point at \text{Highest Frequency}.

**Number of Points:** This determines the number of data points printed in the Numeric Output window. It also determines the number of data points.
actually calculated if Linear or Log stepping is used. If the Auto Step method is selected, the number of points actually calculated is controlled by the <Maximum change %> value. If Auto is selected, interpolation is used to produce the specified number of points. The default value is 51. This number is usually set to an odd value to produce an even print interval.

For the Linear method, the frequency step and the print interval are:

\[
\frac{<\text{Highest Frequency}> - <\text{Lowest Frequency}>}{(<\text{Number of points}> - 1)}
\]

For the Log method, the frequency step and the print interval are:

\[
\left(\frac{<\text{Highest Frequency}>}{<\text{Lowest Frequency}>}\right)^{1/(<\text{Number of points}> - 1)}
\]

- **Temperature**: This field controls the temperature of the run. If the Temperature list box shows Linear the format is:

  \[
  <\text{high}> [ , <\text{low}> [ , <\text{step}> ] ]
  \]

  The default value of <low> is <high>, and the default value of <step> is <high> - <low>.

  If the Temperature list box shows List the format is:

  \[
  <t1> [ , <t2> [ , <t3> ] [ ...]]
  \]

  where t1, t2,.. are individual values of temperature.

  All values are in degrees Celsius. One analysis is done at each specified temperature, producing one set of curves for each.

- **Maximum Change %**: This value controls the frequency step used when Auto is selected for the Frequency Step method.

- **Noise Input**: This is the name of the input source to be used for noise calculations. If the INOISE and ONOISE variables are not used in the expression fields, this field is ignored.

- **Noise Output**: This field holds the name(s) or number(s) of the output node(s) to be used for noise calculations. If the INOISE and ONOISE variables are not used in the expression fields, this field is ignored.
The Curve options are located below the Numeric limits and to the left of the Expressions. Each curve option affects only the curve in its row. The options function as follows:

The first option toggles the X-axis between a linear and a log plot. Log plots require positive scale ranges.

The second option toggles the Y-axis between a linear and a log plot. Log plots require positive scale ranges.

The option activates the color menu. There are 64 color choices for an individual curve. The button color is the curve color.

The option prints a table showing the numeric value of the curve. The values printed are those actually calculated. The table is printed to the Numeric Output window and saved in the file CIRCUITNAME.ANO.

The option selects the basic plot type. In AC analysis there are three types available, rectangular, polar, and Smith.

A number from 1 to 9 in the P column is used to group the curves into different plot groups. All curves with like numbers are placed in the same plot group. If the P column is blank, the curve is not plotted.

The Expressions field specifies the horizontal (X) and vertical (Y) scale ranges and expressions. The expressions are treated as complex quantities. Some common expressions are F (frequency), db(v(1)) (voltage in decibels at node 1), and re(v(1)) (real voltage at node 1). Note that while the expressions are evaluated as complex quantities, only the magnitude of the Y expression vs. the magnitude of the X expression is plotted. If you plot the expression V(3)/V(2), MC7 evaluates the expression as a complex quantity, then plots the magnitude of the final result. It is not possible to plot a complex quantity directly vs. frequency. You can plot the imaginary part of an expression vs. its real part (a Nyquist plot), or you can plot the magnitude, real, or imaginary parts vs. frequency (a Bode plot).

The scale ranges specify the scales to use when plotting the X and Y expressions. The range format is:

<high> [,<low>] [,<grid spacing>] [,<bold grid spacing>]
<low> defaults to zero. [,<grid spacing>] sets the spacing between grids, [,<bold grid spacing>] sets the spacing between bold grids. Placing "AUTO" in the X or Y scale range calculates its range automatically. The Auto Scale Ranges option calculates scales for all ranges during the simulation run and updates the X and Y Range fields. The Auto Scale (F6) command immediately scales all curves, without changing the range values, letting you restore them with CTRL + HOME if desired. Note that <grid spacing> and <bold grid spacing> are used only on linear scales. Logarithmic scales use a natural grid spacing of 1/10 the major grid values and bold is not used. The Auto Scale command uses the Preferences / Auto Scale Grids value to set the grid spacing if none is specified in the range.

Clicking the right mouse button in the Y expression field invokes the Variables list. It lets you select variables, constants, functions, and operators, or expand the field to allow editing long expressions. Clicking the right mouse button in the other fields invokes a simpler menu showing suitable choices.

---

• **Run Options**

  - **Normal**: This runs the simulation without saving it to disk.
  
  - **Save**: This runs the simulation and saves it to disk in the Probe format.
  
  - **Retrieve**: This loads a previously saved simulation and plots and prints it as if it were a new run.

• **State Variables**: These options determine what happens to the time domain state variables (DC voltages, currents, and digital states) prior to the optional operating point.

  - **Zero**: This sets the state variable initial values (node voltages, inductor currents, digital states) to zero or X. This option forces an operating point.

  - **Read**: This reads a previously saved set of state variables and uses them as the initial values for the run. Normally the values read in are from a prior operating point run in AC or transient analysis, and are the desired bias conditions about which to linearize and do the AC analysis. If so, you would want to disable the Operating Point option when you use this Read feature. This option forces an operating point.

  - **Leave**: This leaves the current values of state variables alone. They retain their last values. If this is the first run, they are zero. If you have

---

111
just run an analysis without returning to the Schematic editor, they are the values from that run. This option does not force an operating point.

**Frequency step**

- **Auto:** This method uses the first plot of the first group as a pilot plot. If, from one frequency point to another, the plot has a vertical change of greater than [maximum change %] of full scale, the frequency step is reduced, otherwise it is increased. [maximum change %] is the value from the fourth numeric field of the AC Analysis Limits dialog box. Auto is the standard method because it uses the fewest number of data points to produce the smoothest plot.

- **Linear:** This method uses a frequency step that produces horizontally equidistant data points on a linear scale. The number of data points is controlled by the Number of Points field.

- **Log:** This method uses a frequency step that produces horizontally equidistant data points on a log scale. The number of data points is controlled by the Number of Points field.

- **List:** This method uses a comma-delimited list of frequency points from the Frequency Range, as in 1E8, 1E7, 5E6.

**Operating Point:** This calculates a DC operating point, changing the state variables as a result. If an operating point is not done, the time domain variables are those resulting from the initialization step (zero, leave, or read). The linearization for AC analysis is done using the state variables after this optional operating point. In a nonlinear circuit where no operating point is done, the validity of the small-signal analysis depends upon the accuracy of the state variables read from disk, edited manually, or enforced by device initial values or .IC statements. Calculating an operating point may (and usually does) change the initial state variables.

**Auto Scale Ranges:** This sets all ranges to Auto every time a simulation is run. If disabled, the values from the range fields are used.

All options affect simulation results. To see their effect, you must do a run by clicking on the Run command button.
Experimenting with options and limits

The small squares on the plots in Figure 5-3 mark the actual points calculated by MC7. We can produce a smoother plot at the expense of more data points by reducing the *Maximum change %* value from 5% to 1%. Display the AC Analysis Limits dialog box with F9. Double-click the mouse in the Maximum Change % field and type "1". Press F2 to run the analysis. It looks like this:

![Figure 5-4 The plot with Maximum change % set to 1%](image)

The lower value of 1% produces a smoother plot by calculating more data points. The current Frequency Step method is Auto. In this mode, the frequency step is automatically adjusted to restrain the point-to-point change of both the vertical value and the angle of the plot itself to less than the specified maximum change. The Auto method produces the smoothest plot at the lowest computation price for most curves.

This analysis uses 1% and generates about three times the number of data points as the 5% analysis. Since the analysis time increases in direct proportion to the number of data points, it is wise to keep the *Maximum change %* as large as possible. A value of 1 to 5 is usually suitable. If the first curve is very flat, you may want to try a fixed frequency step method.

Let's try one of these methods. Press F9 to display the Analysis Limits dialog box. Click in the Frequency Step list box. When the list drops down, click on the Log option. Press F2 to start the run. The result looks like Figure 5-5.
The constant horizontal distance between data points is achieved by making each new frequency a product of the prior frequency and a fixed multiplier. Since the lowest frequency forms the base that is multiplied, it must not be zero.

The Linear option is only used when the X axis is linear. To illustrate, press F9 and edit the Frequency Range field to 1E7, 0. Change the Frequency Step method to Linear and change the X Log/Linear button states of the first two curves to linear. Press F2 to run. The result looks like Figure 5-6.
Numeric output

To obtain a tabulation of the numerical values simply click the Numeric Output button for each curve for which numeric output is desired. Do that now for the first two curves. Press F9, then click the buttons. Press F2 to run the analysis. All text or numeric output is directed to the Numeric Output window and to a disk file with the name DIFPAMP.ANO. Press F5 to see the window. The first part shows the results of the DC operating point. Scroll down to see the numeric values for the curves. The display should look like this:

A printout of the data in the Numeric Output window may be obtained from the Print option of the File menu.

To display the Analysis Plot window, press F4, or click on the Analysis Plot button.

To display the Output window, press F5, or click on the Numeric Output button

Disable the numeric output button for each curve.
Noise plots

MC7 models three types of noise: thermal, shot, and flicker noise.

Thermal noise is produced by the random thermal motion of electrons and is always associated with resistance. Discrete resistors and the parasitic resistance of active devices contribute thermal noise.

Shot noise is caused by a random variation in the production of current from a variety of sources including recombination and injection. It is usually associated with dependent current sources. All semiconductor devices generate shot noise.

Flicker noise comes from a variety of sources. In BJTs, the source is contamination traps and other crystal defects that randomly release their captured carriers.

Noise analysis computes the contribution from all these sources as seen at the input and output. Output noise is calculated at the output node specified in the Noise Output field. To plot it, specify ONOISE as the Y expression. Input noise is calculated at the same output node(s) specified in the Noise Output field, but is divided by the gain from the node(s) specified in the Noise Input field to the output node. To plot or print input noise, specify INOISE as the Y expression.

Press F9 and edit the analysis limits to match Figure 5-8. Be sure to disable numeric output for the first two curves and to select the Log option.
Press F2 to run the analysis. The results look like this:

![Figure 5-9 Plots of input and output noise](image.png)

In this circuit, thermal noise is generated by the resistors. Shot and flicker noise are generated by the transistors.

Because the equations are structured differently for noise, it is not possible to simultaneously plot noise variables and other types of variables such as voltage and current. That is why we disabled the other curves by placing a blank in their P fields. If you attempt to plot both noise and other variables, the program will issue an error message.

Noise is an essentially random process and as a result carries no phase information. For this reason, noise is defined as an RMS quantity. Thus the phase (PH) and group delay (GD) operators will not produce meaningful results when plotting noise. With noise, only magnitudes are meaningful.

The units of noise are V / sqrt(Hz).
Nyquist plots

A Nyquist plot is easy to generate. Edit the analysis limits to look like these. Here we have enabled the last curve and disabled the other curves and selected log stepping.

![Figure 5-10 Analysis limits for the Nyquist plot](image)

Press F2 to run the analysis. The result looks like this:

![Figure 5-11 The Nyquist plot](image)

Note that the X expression in this case was \(\text{RE}(V(\text{OUTA}))\), not \(F\) as it usually is. In general, it can be any expression involving any AC variable.
Smith charts

To generate a Smith chart plot, select the option adjacent to the P column. Here is what the Analysis Limits dialog box looks when set up to create a Smith chart plot.

![Figure 5-12 Analysis limits for the Smith chart](image)

Here is what a typical Smith chart plot looks like:

![Figure 5-13 Typical Smith chart plot](image)
Polar plots

To generate a polar plot, select the option adjacent to the P column. Here is what a typical polar plot Analysis Limits dialog box looks like:

![Figure 5-14 Analysis limits for a polar plot](image)

Here is what a typical polar plot looks like:

![Figure 5-15 Typical polar plot](image)
Chapter 6 DC analysis

What's in this chapter

DC analysis is the topic for this chapter. It is a short tutorial covering these subjects:

- What DC analysis does
- What the DC analysis limits do
- A simple circuit for generating IV-curves
DC analysis

In DC analysis, the program treats capacitors as open circuits and inductors as short circuits. It sweeps the specified Variable 1 and solves for the steady-state DC node voltages and branch currents. Two stepping loops are provided for easy creation of parametric plots such as device IV curves. The variable for either loop can be a voltage or current source value, temperature, a model parameter, or a symbolic variable. As in the other analysis routines, the complete set of variables are available for printing and plotting, with the obvious exceptions of charge, flux, capacitance, inductance, B field, and H field. These variables are not provided since flux and charge are ignored in DC analysis. To explore DC analysis, load the file IVBJT. It looks like this:

![Figure 6-1 The IVBJT circuit](image)

This circuit is used to plot the I-V characteristics of a bipolar transistor. It can be easily adapted to other device types, such as GaAsFets, MOSFETs, and JFETs. There is a voltage source for the collector voltage sweep and a current source for the base current sweep.

After loading the circuit, select DC from the Analysis menu. When the DC Analysis Limits dialog box comes up, it looks like Figure 6-2.
The dialog box instructs MC7 to step the value of the current source $I_B$ from 0 to 5 mA, using a maximum step size of 0.5 mA. For each value of the current source, $I_B$, the voltage source, $V_{CC}$, is to be swept from 0 to 5 volts, using a maximum step size of 10. The step size may be varied during the run to optimize convergence and to conform to the $\text{<Maximum change %>}$ constraint, but it is never to be larger than 10. Click on the Run command button and the results look like this:

![Figure 6-3 DC analysis plot of IV characteristics](image-url)
The DC Analysis Limits dialog box

The Analysis Limits dialog box is divided into five major areas: the Command buttons, Sweep group, Curve options, Expression fields, and Options.

Command buttons provide these commands.

- **Run:** This command starts the analysis run. Clicking the Tool bar Run button or pressing F2 will also start the run.

- **Add:** This command adds another Curve options field and Expressions field line after the line containing the cursor. The scroll bar to the right of the Expressions field scrolls through the curves when needed.

- **Delete:** This command deletes the Curve option field and Expressions field line where the text cursor is.

- **Expand:** This command expands the working area for the text field where the text cursor currently is. A dialog box is provided for editing or viewing. To use the feature, click in an expression field, then click the Expand button.

- **Stepping:** This command calls up the Stepping dialog box. Stepping is reviewed in a separate chapter.

- **Properties:** This command invokes the Properties dialog box which lets you control the analysis plot window and the way curves are displayed. See the Plot Properties dialog box article in Chapter 4, "Transient Analysis".

- **Help:** This command calls up Help information for DC analysis.

The definition of each field in this group is as follows:

- **Variable 1:** This row specifies the Method, Name, and Range fields for Variable 1. Its value is usually plotted along the X axis. The column fields for this variable are:

  - **Method:** This field specifies one of four methods for sweeping or stepping the variable: Auto, Linear, Log, or List.

    - **Auto:** In this mode the rate of step size is adjusted to keep the point-to-point change less than Maximum Change % value.
• **Linear**: This mode uses the following syntax from the Range column for this row:

```
<end> [,<start> [,<step>] ]
```

Start defaults to 0.0. Step defaults to \((start - end)/50\).
Variable 1 starts at \(start\). Subsequent values are computed by adding \(step\) until \(end\) is reached.

• **Log**: This mode uses the following syntax from the Range column for this row:

```
<end> [,<start> [,<step>] ]
```

Start defaults to \(end/10\). Step defaults to \(exp(ln(end/start)/10)\).
Variable 1 starts at \(start\). Subsequent values are computed by multiplying by \(step\) until \(end\) is reached.

• **List**: This mode uses the following syntax from the Range column for this row:

```
<v1> [,<v2> [,<v3>] ...[,<vn>]]
```

The variable is simply set to each of the values \(v1, v2, .. vn\).

• **Name**: This field specifies the name of Variable 1. The variable itself may be a source voltage, temperature, a model parameter, or a symbolic parameter (one created with a .DEFINE statement). Model parameter stepping requires both a model name and model parameter name.

• **Range**: This field specifies the numeric range for the variable. The range syntax depends upon the Method field described above.

• **Variable 2**: This row specifies the Method, Name, and Range fields for Variable 2. The syntax is the same as for Variable 1, except that the stepping method options include None and exclude Auto. Each discrete value of Variable 2 from the range field produces one complete branch.

• **Temperature**: This controls the temperature of the run. The fields are:

  • **Method**: This field specifies one of two methods for stepping the temperature: Linear or List.
• **Linear:** This mode uses the following syntax from the Range column for this row:

\[ \langle end \rangle \[, \langle start \rangle \[, \langle step \rangle \]\]

Start defaults to 0.0. Step defaults to \((\text{start} - \text{end})/10\). Variable 1 starts at \(\text{start}\). Subsequent values are computed by adding \(\text{step}\) until \(\text{end}\) is reached.

• **List:** This mode uses the following syntax from the Range column for this row:

\[ \langle v1 \rangle \[, \langle v2 \rangle \[, \langle v3 \rangle \] \ldots \[, \langle vn \rangle \]\]

Temperature is simply set to each of the values \(v1, v2, \ldots vn\). One run is produced for each temperature. *Note that when temperature is selected as one of the stepped variables (Variable 1 or Variable 2) this field is not available.*

• **Range:** This field specifies the range for the temperature variable. The range syntax depends upon the Method field described above.

• **Number of Points:** This is the number of data points to be interpolated and printed if numeric output is requested. This number defaults to 51 and is usually set to an odd value to produce an even print interval. Its value is:

\[ \frac{(\langle \text{final1} \rangle - \langle \text{initial1} \rangle)}{(\langle \text{Number of points} \rangle - 1)} \]

\(\langle \text{Number of points} \rangle\) values are printed for each value of variable 2.

---

**Curve options**

The Curve options are located below the Numeric limits and to the left of the Expressions. Curve options affect the curve in the same row. The definition of each option is as follows:

The first option toggles the X-axis between a linear \(\square\) and a log \(\square\) plot. Log plots require positive scale ranges.

The second option toggles the Y-axis between a linear \(\square\) and a log \(\square\) plot. Log plots require positive scale ranges.
The option activates the color menu. There are 64 color choices for an individual curve. The button color is the curve color.

The option prints a table showing the numeric value of the curve. The number of values printed is controlled by the Number of Points value. The table is printed to the Numeric Output window and saved in the file CIRCUITNAME.DNO.

A number from 1 to 9 is used in the Plot (P) column to group the curves into different plots. All curves with like numbers are placed in the same plot. If the P column is blank, the curve is not plotted.

The Expressions field is used to specify the horizontal (X) and vertical (Y) scale ranges and expressions. Some common expressions used are VCE(Q1) (collector to emitter voltage of transistor Q1) or IB(Q1) (base current of transistor Q1).

The X Range and Y Range fields specify the scales to be used when plotting the X and Y expressions. The range format is:

\[ \text{<high>} [,\text{<low}>] [,\text{<grid spacing}>] [,\text{<bold grid spacing}>] \]

\text{<low>} defaults to zero. [,\text{<grid spacing}>] sets the spacing between grids. [,\text{<bold grid spacing}>] sets the spacing between bold grids. Placing "AUTO" in the scale range calculates that individual range automatically. The Auto Scale Ranges option calculates scales for all ranges during the simulation run and updates the X and Y Range fields. The Auto Scale (F6) command immediately scales all curves, without changing the range values, letting you restore them with CTRL + HOME if desired. Note that \text{<grid spacing>} and \text{<bold grid spacing>} are used only on linear scales. Logarithmic scales use a natural grid spacing of 1/10 the major grid values and bold is not used. The Auto Scale command uses the Preferences / Auto Scale Grids value to set the grid spacing if none is specified in the range.

Clicking the right mouse button in the Y expression field invokes the Variables list which lets you select variables, constants, functions, and operators, or expand the field to allow editing long expressions. Clicking the right mouse button in the other fields invokes a simpler menu showing suitable choices.

The Options are to the right of the Numeric limits. The Auto Scale Ranges option has a check box. Clicking the mouse in the box will toggle the options on or off with an X in the box showing that the option is enabled.
The options available from here are:

- **Run Options**

  - **Normal**: This runs the simulation without saving it to disk.
  
  - **Save**: This runs the simulation and saves it to disk.
  
  - **Retrieve**: This loads a previously saved simulation and plots and prints it as if it were a new run.

- **Auto Scale Ranges**: This sets the X and Y range to auto every time a simulation is run. If it is disabled, the values from the range fields will be used.

Press F3 and unload the IVBJT circuit without saving it.
Chapter 7  Using the Scope

What's in this chapter

Every analysis routine generates curves as a part of the run, based upon the instructions in the Analysis Limits dialog box. After the run is complete, you can inspect, manipulate, magnify, and annotate the plot, as well as search for and display specific numeric positions or values for each of the curves. The collection of tools that helps you do this is called Scope.

This chapter shows how to use these features to get the maximum information from an analysis run. The topics include:

• Experimenting with Scope
• Magnifying
• Panning
• Cursor mode
• Cursor mode panning and scaling
• Cursor positioning
• Adding text to plots
• Adding tags to plots
• Performance functions
• Animating an analysis
Experimenting with Scope

Load the file CHOKE. It looks like this:

![Figure 7-1 The CHOKE circuit](image1)

After loading the circuit, select transient analysis by pressing ALT + 1. Press F2 to start the run. When finished, the plot looks like Figure 7-2.

![Figure 7-2 Transient analysis of the CHOKE circuit](image2)
When the analysis is over, click on the **Scope** menu. It provides these options:

- **Delete All Objects**: This command removes all objects (shapes, tags, or text) from the analysis plot. To delete an object, select it by clicking on it, then press CTRL + X or the DELETE key. To delete all objects use CTRL + A to select all objects, then press CTRL + X or the DELETE key.

- **Auto Scale**: This command scales the plot group containing the selected curve. F6 may also be used. The selected curve is the one whose Y expression is underlined.

- **Restore Limit Scales**: (CTRL + HOME) This command restores the range scales to the values in the Analysis Limits dialog box.

- **View**: The view options only affect the display of simulation results, so you may change these after a run and the screen is redrawn accordingly. These options may also be accessed through Tool bar icons shown below.

  - **Data Points**: This marks the actual points calculated by the program on the curve. All other values are linearly interpolated.

  - **Tokens**: This adds tokens to each curve. Tokens are small graphic symbols that help identify the curves.

  - **Ruler**: This substitutes ruler tick marks for the normal full screen X and Y axis grid lines.

  - **Plus Mark**: This replaces continuous grids with "+" marks at the intersection of the X and Y grids.

  - **Horizontal Axis Grids**: This adds grids to the horizontal axis.

  - **Vertical Axis Grids**: This adds grids to the vertical axis.

  - **Minor Log Grids**: This adds minor log grid lines between the major grids to any axis which uses the log option.

  - **Baseline**: This adds a plot of the value 0.0 for use as a reference.

  - **Horizontal Cursor**: This adds a horizontal cursor intersecting each of the two vertical numeric cursors at their respective data point locations.
• **Trackers:** These options control the display of the cursor, intercept, and mouse trackers, which are little boxes containing the numeric values at the current data point, its X and Y intercepts, or at the current mouse position.

• **Cursor Functions:** These control the cursor positioning in Cursor mode. Cursor positioning is described later in this chapter.

• **Label Branches:** This accesses a dialog box which lets you select from the automatic and user-specified X location method for labeling multiple branches of a curve. This option only appears when Monte Carlo, Stepping, or temperature stepping have produced multiple branches of the curves(s).

• **Label (Time, Frequency, Input Sweep) Points:** This lets you specify a set of time, frequency, or input sweep data points, in transient, AC, or DC analysis, respectively, which are to be labelled. This command is mostly used to label frequency data points on polar and Smith charts.

• **Animate Options:** This option displays the node voltages/states, and optionally, device currents, power, and operating conditions (ON, OFF, etc.), on the schematic as they change from one data point to the next. To use this option, click on the button, select one of the wait modes, then click on the Tile Horizontal button, or Tile Vertical button, then start the run. If the schematic is visible, MC7 prints the node voltages on analog nodes and the node states on digital nodes. To print device currents click on . To print device power click on . To print the device conditions click on . It lets you see the evolution of states as the analysis proceeds. To restore a full screen plot, click on the button.

• **Normalize at Cursor:** (CTRL + N) This option normalizes the selected (underlined) curve at the current active cursor position. The active cursor is the last cursor moved. Normalization divides each branch's Y values by the Y value of the branch at the current cursor position, producing a normalized value of 1.0 there. If the Y expression contains the dB operator and the X expression is F (Frequency), then the normalization subtracts the value of the Y expression at the current data point from each of the curve's data points, producing a value of 0.0 at the current cursor position.

• **Go to X:** (SHIFT + CTRL + X) This command lets you move the left or right cursor to the next instance of a specific value of the X expression of the selected curve. It then reports the Y expression value at that data point.
• **Go to Y:** (SHIFT + CTRL + Y) This command lets you move the left or right cursor to the next instance of a specific value of the Y expression of the selected curve. It then reports the X expression value at that data point.

• **Go to Performance:** This command calculates performance function values on the Y expression of the selected curve. It also moves the cursors to the measurement points. For example, you can measure pulse widths and band widths, rise and fall times, delays, periods, and maxima and minima.

• **Go to Branch:** This lets you select and color a left and right branch for each curve. If you're in Cursor mode, it will also place the left and right cursors on them. The left cursor branch is colored in the primary select color and the right cursor branch is colored in the secondary select color.

• **Tag Left Cursor:** (CTRL + L) This command attaches a tag to the left cursor data point on the selected curve.

• **Tag Right Cursor:** (CTRL + R) This command attaches a tag to the right cursor data point on the selected curve.

• **Tag Horizontal:** (SHIFT + CTRL + H) This command drags a horizontal tag from the left to the right cursor, showing the difference between the two X expression values.

• **Tag Vertical:** (SHIFT + CTRL + V) This command drags a vertical tag from the data point at the intersection of the curve and the left cursor to the intersection of the curve and the right cursor, showing the difference between the two Y expression values.

• **Align Cursors:** This option, available only in Cursor mode, forces the left and right cursors of different plot groups to stay on the same data point.

• **Keep Cursors on Same Branch:** When stepping produces multiple runs, one line is produced for each run for each plotted expression. These lines are called branches of the curve or expression. This option forces the left and right cursors to stay on the same branch of the selected curve when the UP ARROW and DOWN ARROW cursor keys are used to move the numeric cursors among the several branches. If this option is disabled the cursor keys will move only the left or right numeric cursors, not both, allowing them to occupy positions on different branches of the curve.

• **Same Y Scales:** This option forces all curves in a plot group to use the
same Y scale. Otherwise, if the curves have differing Y Range values, one or more Y scales will be drawn.

- **Thumb Nail Plot**: This option draws a small guide plot which gives a global view of where the current plot(s) are on the whole curve. You can also select different views by dragging a box over the curve.

Next, choose **Mode** from the **Options** menu. The five modes beginning with **Scale** deal with analysis plots and are usually accessed by clicking on their Tool bar buttons shown below, but they may also be activated from this menu.

- **Scale**: In this mode, the left mouse button drags an outline box to magnify a portion of the plot. F7 also accesses this mode.

- **Cursor**: This mode shows the numeric value of each curve at each of two plot cursors. The left mouse button controls the left plot cursor and the right button controls the right plot cursor. The left cursor is initially placed on the first data point. The right cursor is initially placed on the last data point. The LEFT ARROW or RIGHT ARROW keys move the left or right cursor to a point on the selected curve. Depending on the positioning mode, the point may be the next local peak or valley, global high or low, inflection point, or simply the next data point. The direction is left or right depending on whether a LEFT ARROW or RIGHT ARROW key is pressed. If the SHIFT key is used with the cursor key, the right cursor is moved, otherwise, the left cursor is moved. F8 may also be used to access this mode.

- **Point Tag**: In this mode, the left mouse button is used to tag a data point with its numeric (X,Y) value. The tag snaps to the nearest data point.

- **Horizontal Tag**: In this mode, the left mouse button can be used to drag between two data points to measure the horizontal difference.

- **Vertical Tag**: In this mode, the left mouse button can be used to drag between two data points to measure the vertical difference.

*Note: In all modes except Cursor, a drag of the right mouse button pans the plot. In Cursor mode, CTRL + right mouse drag pans the plot.*
Magnifying

Press ESC twice to remove the menus. Click the left mouse button just above and to the left of the large peak of the V(B) curve. While holding the left button down, drag the mouse down and to the right to create a magnification box like the one shown in Figure 7-3.

Figure 7-3 Magnifying a region

Release the button and MC7 scales the plot to match the outline of the box.

Figure 7-4 The magnified region
Panning

Panning is like scrolling in a text field, except that it is multidirectional. To illustrate, click the right mouse button in the middle of the plot. The mouse arrow cursor changes to a hand cursor. While holding the right button down, drag the mouse slowly up and to the left until it nearly touches the upper left corner of the plot window. The effect is like sliding a paper across a desk. Dragging the mouse dynamically updates the display to reflect the change in view. Release the button and the plot looks like this:

![Figure 7-5 Panning the plot](image)

As with panning in the Schematic editor, the keyboard may also be used. The CTRL key plus the arrow keys move the view in the direction of the arrow.

The combination of panning and magnifying allows close inspection of any portion of the curves.

Note that you can also scale (magnify) and pan while in Cursor mode:

- **Scaling:** CTRL + left mouse drag
- **Panning:** CTRL + right mouse drag

Press CTRL + HOME or choose **Restore Limit Scales** from the **Scope** menu to return the analysis to its original offset and scale.
Cursor mode

Click on the Cursor mode button or Press F8 to place Scope in the Cursor mode. In this mode the display looks like this:

The Cursor value fields, located below the plots, show the numeric value of each curve or expression at both cursor positions. The X expression value is shown below the Y expression values. The purpose of each field is as follows:

- **Left**: This shows the value of the row's Y expression at the left cursor.

- **Right**: This shows the value of the row's Y expression at the right cursor.

- **Delta**: This shows the value of the row's Y expression at the right cursor minus the value of the Y expression at the left cursor.

- **Slope**: This shows the row's Y expression delta value divided by the delta value of the X expression. If the X expression is T (time), then this field approximates the time derivative of the curve between the two cursors. The slope calculation can be changed to dB/Octave or dB/Decade from Properties / Scales and Formats, if dB is used in the Y expression and F (frequency) is the X expression.
Cursor mode panning and scaling

**Mouse**
Normal mouse-controlled scaling and panning are not available in Cursor mode, since the mouse movements in this mode are used to control the left and right curve cursors. However, by using the CTRL key together with the mouse, you can pan and scale within Cursor mode as follows:

- **Scaling:** CTRL + left mouse drag
- **Panning:** CTRL + right mouse drag.

To scale (magnify) the curves, press the CTRL key down and drag with the left mouse button.

To pan the curves, press the CTRL key down and drag with the right mouse button.

**Keyboard**
To pan the curves with the keyboard, press the CTRL key down and press the LEFT ARROW or RIGHT ARROW keys.

There is no keyboard-based scaling procedure.
Cursor mode positioning

Drag with the left mouse button to control the left cursor, and the right button to control the right cursor. The LEFT ARROW and RIGHT ARROW cursor keys move the left cursor and SHIFT + cursor keys move the right cursor. The mouse places the cursor anywhere, even between simulation data points. The keyboard moves the cursor to one of the simulation data points, depending on the positioning mode. The positioning mode, chosen with a Tool bar button, affects where the cursor is placed the next time a cursor key is pressed. Cursor positioning picks locations on the selected, or underlined, curve. Curves are selected with the Tab key, or by clicking the Y expression with the mouse.

• **Next Simulation Data Point:** In this mode, pressing the cursor keys finds the next actual data point in the direction of the cursor arrow from the run.

• **Next Interpolated Data Point:** In this mode, pressing the cursor keys finds the next rounded interpolated data point in the direction of the cursor arrow.

• **Peak:** In this mode, pressing the cursor keys finds the next local peak on the selected curve.

• **Valley:** In this mode, pressing the cursor keys finds the next local valley on the selected curve.

• **High:** Clicking this button finds the data point with the largest algebraic value on the current branch of the selected curve.

• **Low:** Clicking this button finds the data point with the smallest algebraic value on the current branch of the selected curve.

• **Inflection:** In this mode, pressing the cursor keys finds the next data point with the largest magnitude of slope, or first derivative, on the selected curve.

• **Top:** Clicking this button finds the data point with the greatest Y value of all branches of the selected curve *at the current X cursor position*.

• **Bottom:** Clicking this button finds the data point with the smallest Y value of all branches of the selected curve *at the current X cursor position*. 
• **Global High:** Clicking this button finds the data point with the largest algebraic Y value of all data points on all branches of the selected curve.

• **Global Low:** Clicking this button finds the data point with the smallest algebraic Y value of all data points on all branches of the selected curve.

When Cursor mode is selected, a few initialization events occur. The selected curve is set to the first, or top curve. The Next mode is enabled. Clicking on a mode button not only changes the mode, it also moves the last cursor in the last direction. The last cursor is set to the left cursor and the last direction is set to the right. The left cursor is placed at the left on the first data point. The right cursor is placed at the right on the last data point.
Click on the Peak \( \text{A} \) button. The left cursor moves to the first peak to the right of its current position on the selected curve, \( V(A) \). Press SHIFT + LEFT ARROW key. The right cursor moves to the first peak on its left.

![Figure 7-7 Using the Peak mode](image)

Click on the \( \text{V} \) button to select the Valley mode. Press the RIGHT ARROW key. The cursors are placed on the next valley in the right and left directions.

![Figure 7-8 Using the Valley mode](image)
Click on the High button. The left cursor moves to the global high on the selected curve.

![Figure 7-9 Using the High mode](image)

Click on the button to select the Low mode. The left cursor is positioned at the right hand edge of the plot, the global low for the curve.

![Figure 7-10 Using the Low mode](image)
Click on the Inflection button. The left cursor moves to the next inflection point on the selected curve. Press SHIFT + RIGHT ARROW key. The right cursor moves to the next inflection point on the selected curve moving right to left.

**Figure 7-11 Using the Inflection mode**

Click on the Go to Y button. Type "50" in the dialog box that comes up and click on the 'Left' button in the dialog box. The left cursor is positioned at the first incidence of 50.0 for the selected curve's Y expression value.

**Figure 7-12 Using the Go to Y mode**
Adding text to plots

Adding text to an analysis plot is easy. Click on the Close button to exit the Go To Y mode. Click on the \( T \) button to select the Text mode. Click the mouse near the large peak of the \( V(B) \) curve and type "\( V(B) \) peaks at 138 volts.". Click OK. The screen looks like this:

![Figure 7-13 Adding text to a plot](image)

Would the text look better if it were centered over the peak? To see if it would, first enter Select mode by pressing the SPACEBAR or by clicking on the Select button \( \text{Select} \). Next, click on the text with the left button and drag it to the left until it is centered. Release the button and the text is redrawn at the mouse position.

Perhaps the text would look better if it were bold. Double click on the text and when the text dialog box is presented, click on the Font tab in the dialog box. This part of the dialog box lets you change the font and several font attributes. In this case, we need to change the Style attribute. From the Font Style group, select the Bold option. Click on the OK button. The text should now appear as in Figure 7-14. All font attributes for each instance of text are independently changeable.
Adding tags to plots

Click on the \( \text{Vertical Tag} \) button to activate the Vertical Tag mode. Click the left mouse button near the highest peak of \( V(A) \). Drag the mouse to the highest peak of \( V(B) \) and release the button. The tag shows the vertical delta between the two data points.
In a similar manner, the horizontal tag, enabled by the button, measures the horizontal delta between the two data points of the tag. It is most useful for measuring the time difference between two digital events, such as the width of a pulse or the time delay between two events. Choose **Delete All Objects** from the **Scope** menu to delete the text and tag.

Click on the button to activate the Point Tag mode. Click the left mouse button at the second peak of \( V(B) \) and drag the mouse. The point tag labels the actual analysis data point nearest the initial mouse click. A shadow of the tag will track the mouse movements. Release the mouse button when the shadow is at the desired spot. The screen should look like Figure 7-16.

![Figure 7-16 Using the Point tag](image)

When in Select mode, double clicking on a tag element invokes the Tag dialog box. This dialog box lets you edit the arrow style, weight, color, and the font attributes of the number. All of the tag options are available for each instance of a tag element.

Both the text body and arrow tip of a tag may be repositioned after placement. Press **SPACEBAR** to toggle into Select mode. Double click on the tag and then deselect the Lock item in the dialog box. Click **OK**. Drag either the body handle or the arrow tip handle. The body handle is the small black rectangle near the text. The arrow tip handle is the small black rectangle at the tip of the tag arrow.

Press F3 to exit the analysis, then CTRL + F4 to close the file.
Performance functions

MC7 provides a group of functions for measuring performance-related curve characteristics. These functions include:

**Rise_Time**  
This function marks the N'th time the Y expression rises through the specified Low and High values. It places the cursors at the two data points and returns the difference between the X expression values at these two points. This function is useful for measuring the rise time of time-domain curves.

**Fall_Time**  
This function marks the N'th time the Y expression falls through the specified Low and High values. It places the cursors at the two data points and returns the difference between the X expression values at these two points. This function is useful for measuring the fall time of time-domain curves.

**Peak_X**  
This function marks the N'th local peak of the selected Y expression. A peak is any data point algebraically larger than the neighboring data points on either side. It places the left or right cursor at the data point and returns its X expression value.

**Peak_Y**  
This function is identical to the Peak_X function but returns the Y expression value. This function is useful for measuring overshoot in time-domain curves and the peak gain ripple of filters in AC analysis.

**Valley_X**  
This function marks the N'th local valley of the selected Y expression. A valley is any data point algebraically smaller than the neighboring data points on either side. It places the left or right cursor at the data point and returns its X expression value.

**Valley_Y**  
This function is identical to the Valley_X function but returns the Y expression value. It is useful for measuring undershoot in time-domain curves and the peak attenuation of filters in AC analysis.
Peak_Valley This function marks the N'th peak and N'th valley of the selected Y expression. It places the cursors at the two data points and returns the difference between the Y expression values at these two points. This function is useful for measuring ripple, overshoot, and amplitude.

Period The period function accurately measures the time period of curves by measuring the X differences between successive instances of the average Y value. It does this by first finding the average of the Y expression over the simulation interval where the Boolean expression is true. Then it searches for the N'th and N+1'th rising instance of the average value. The difference in the X expression values produces the period value. Typically a Boolean expression like "T>500ns" is used to exclude the errors introduced by the non-periodic initial transients. This function is useful for measuring the period of oscillators and voltage to frequency converters, where a curve's period usually needs to be measured to high precision.

Frequency This is the numerical complement of the Period function. It behaves like the Period function, but returns 1/Period. The function places cursors at the two data points.

Width This function measures the width of the Y expression curve by finding the N'th and N+1'th instances of the specified Level value. It then places cursors at the two data points, and returns the difference between the X expression values at these two points.

High_X This function finds the global maximum of the selected branch of the selected Y expression, places either the left or the right cursor at the data point, and returns its X expression value.

High_Y This function acts like High_X, but returns the Y value.

Low_X This function finds the global minimum of the selected branch of the selected Y expression, places either the left or the right cursor at the data point, and returns its X expression value.
Low_Y
This function acts like Low_X, but returns the Y value.

X_Level
This function finds the N'th instance of the specified Y Level value, places a left or right cursor there, and returns the X expression value.

Y_Level
This function finds the N'th instance of the specified X Level value, places a left or right cursor there, and returns the Y expression value.

X_Delta
This function finds the N'th instance of the specified Y expression range, places cursors at the two data points, and returns the difference between the X expression values at these two points.

Y_Delta
This function finds the N'th instance of the specified X expression range, places cursors at the two data points, and returns the difference between the Y expression values at these two points.

X_Range
This function finds the X range (max - min) for the N'th instance of the specified Y range. First it searches for the specified Y Low and Y High expression values. It then searches all data points between these two for the highest and lowest X values, places cursors at these two data points, and returns the difference between the X expression values at these two points. It differs from the X_Delta function in that it returns the difference in the maximum and minimum X values in the specified Y range, rather than the difference in the X values at the specified Y endpoints.

Y_Range
This function is identical to the X_Range function but it returns the difference in the maximum and minimum Y values in the specified X range. This function is useful for measuring filter ripple.

Slope
This function finds the numeric slope at the N'th instance of the specified value of the X expression.

Phase_Margin
This function finds the phase margin of a curve if both dB(expr) and PHASE(expr) curves are plotted.
These functions may be used in performance plots, Monte Carlo analysis and 3D plotting. They may also be applied directly to single curves, which is what we will illustrate now. Load the file PERF2 and run transient analysis. When the run is complete, click on the Go To Performance button, and drag the dialog box to the middle of the screen. The dialog box should look like this:

![Figure 7-17 Go To Performance dialog box](image)

The dialog box employs the following fields:

**Function**  
This selects one of the performance functions.

**Expression**  
This selects which of the expressions you want the performance function to perform its measurements on. Only expressions that were printed or plotted during the run are available.

**Boolean**  
This expression must be true for the performance functions to consider a data point for inclusion in the search. Typically this function is used to exclude some unwanted part of the curve from the function search. "T>100ns" would instruct the program to exclude any data points for which T<=100ns.

**N**  
This integer specifies which of the instances you want to find and measure. For example, there might be many pulse widths to measure. Number one is the first one on the left starting at the first time point. The value of N is incremented each time you click on the Go To button, measuring each succeeding instance.

**Low**  
This field specifies the value to be used by the search routines. For example, in the Rise_Time function, this specifies the low value at which the rising edge is measured.

**High**  
This field specifies a value to be used by the search routines. For example, in the Rise_Time function, this specifies the high value at which the rising edge is measured.
Level

This field specifies the value to be used by the search routines. In the Width function, for example, this specifies the expression value at which the width is measured.

A performance function at its core is a search. The set of data points of the target expression is searched for the criteria specified by the performance function and its parameters. All performance functions share the following general properties:

Performance functions interpolate:
Performance functions search for the closest qualifying data point and, if necessary, interpolate between it and an adjacent data point.

Performance functions find the N'th instance:
Every performance function has a parameter N which specifies which instance of the function to return. The only exceptions are the High and Low functions for which, by definition, there is a maximum of one instance.

Each performance function call increments the N parameter:
Every time a performance function is called, N is incremented after the function is called. The next call automatically finds the next instance, and moves the cursor(s) to subsequent instances. For example, each call to the Peak function locates a new peak to the right of the old peak. When the end of the curve is reached, the function rolls over to the beginning of the curve.

Only curves plotted during the run can be used:
Performance functions operate on curve data sets after the run, so only curves plotted during the run are available for analysis by a performance function.

Boolean expression must be TRUE:
Candidate data points are included only if the Boolean expression is true for the data point. The Boolean expression is provided to let the user include only the desired parts of the curve in the performance function search.

At least PERFORM_M neighboring points must qualify:
If a data point is selected, the neighboring data points must be consistent with the search criteria or the point is rejected. For example, in the peak function, a data point is considered a peak if at least PERFORM_M data points on each side have a lower Y expression value. PERFORM_M is a Global Settings value and defaults to 1. Use 2 or even 3 if the curve is particularly choppy or has any trapezoidal ringing in it.
Select Rise_Time from the list box. Enter "3" in the High field and ".5" in the Low field. Enter "1" in the N field. Click on the dialog Go To button. The screen looks like Figure 7-18. N is incremented for each click of the Go To button, so successive clicks measure the rise time of successive pulses.

Select Fall_Time. Enter "1" in the N field, "3" in the High field, and ".5" in the Low field. Click the Go To button twice. The screen should look like Figure 7-19.
Select the Period function. Click on the Go To button. The screen looks like this:

![Figure 7-20 Measuring the pulse period](image)

Select the Width function and click on the Go To button. Width is computed by finding the N'th rising instance of the value Level, then the N'th falling instance of the value Level. The function returns the difference between the X expression values, and places cursors at the two locations. The screen should look like this:

![Figure 7-21 Measuring the pulse width](image)
Select the X_Range function. Click on Go To. The screen looks like this:

![X_Range function](image1)

**Figure 7-22 The X_Range function**

X_Range locates the N'th instance of the YLow and YHigh values, places cursors at the data points and returns the difference between the X expression values. The Y_Range function works similarly. Select it and set XLow = 100n and XHigh = 200n, and click the Go To button. The result looks like this:

![Y_Range function](image2)

**Figure 7-23 The Y_Range function**
Performance functions also work on digital curves. Select D(11) from the Expression list and Rise_Time from the Function list. Set N=2 and click the Go To button. The result looks like Figure 7-24.

![Figure 7-24 Measuring digital rise times](image)

Select the Fall_time function. The result for N=2 looks like Figure 7-25.

![Figure 7-25 Measuring digital fall times](image)
Animating an analysis

It is often useful to step through an analysis one time point at a time. Animation mode lets you do this and displays the node voltages and digital states on the schematic at each time point. To see how the mode works, load the file MIXED4. Select **Transient** from the **Analysis** menu. Press ALT + F4 to remove the Analysis Limits dialog box. Click on the Tile Vertical button. Click on the Animate button, select the Wait for Key Press option, and hit OK. Click on the Node Voltages button. Click on the Run button. Press and hold the CTRL and SPACEBARS keys down to observe each new data point being computed and printed on the schematic.

![Figure 7-26 Animating an analysis](image)

The figure above shows what the screen should look like midway through the run. In this mode, MC7 computes a single data point, optionally prints the voltages/states, currents, power, and conditions on the schematic, and then awaits the CTRL + SPACEBAR key or time delay. It then repeats the cycle of compute, print, and pause until the run is complete. When Animate mode is canceled by clicking on the Don’t Wait button in the Animate dialog box, the run continues in normal mode. To see both the schematic and analysis plot simultaneously, you must select either Tile Horizontal or Tile Vertical. This option is available for AC, DC, and transient analysis, although it is most useful in the transient analysis of digital and mixed-mode circuits. Press ESC to stop the run, F3 to exit the analysis, and CTRL + F4 to close the file.
What's in this chapter

Probe is an alternative tool for viewing the results of an analysis. It performs the selected analysis, saves the entire analysis in a disk file, then lets the user probe the schematic. Unlike a normal analysis, where only the curves specified in the Analysis Limits dialog box are saved, Probe saves everything, so you can decide what to plot after the analysis run. It is very much like probing a real circuit with an oscilloscope, spectrum analyzer, or curve tracer. In this chapter we demonstrate Probe's capabilities with several examples. The topics include:

- How Probe works
- Transient analysis variables
- Experimenting with Probe
- Navigating the schematic
- An AC example
- A DC example
- Probing SPICE files
How Probe works

Probe is another way to view simulation results. It lets you point to a location in a schematic and see the curves. It functions exactly like a normal simulation, saving all of the variables at each solution point in a disk file. When you click the mouse in the schematic, Probe determines where the mouse pointer is, extracts from the file the appropriate values for both the vertical and horizontal axes, and plots the resulting curve. You can also plot expressions using circuit variables as you can in a standard analysis.

To illustrate Probe, load the file ECLGATE. Select **Probe Transient** from the **Analysis** menu. If a current analysis results file is not already available, the program runs a transient analysis on the circuit and saves the results in a file called ECLGATE.TSA. It then presents the Probe display. Click on the **Probe** menu. It provides these options:

- **New Run:** (F2) This option forces a new run. Probe automatically does a new run when the time of the last saved run is earlier than the time of the last edit to the schematic. However, if you have changed RELTOL or some other Global Settings value or option that can affect a simulation run, you may want to force a new run using the new value.

- **Add Curve:** This option lets you add a plot defined by a literal expression using any circuit variable. For example you might enter VCE(Q1)*IC(Q1) to plot a transistor's collector power.

- **Delete Curve:** This option lets you selectively remove curves.

- **Delete All Curves:** (CTRL + F9) This removes all curves.

- **Separate Analog and Digital:** This mode places the analog and digital curves in separate plot groups.

- **One Curve:** In this mode, only one curve is plotted. Each time the schematic is probed, the old curve is replaced with the new one.

  *You can add more than one trace with this mode by holding the CTRL key down while clicking on an object. This adds the curve if not already plotted or deletes it if it is already plotted.*

Chapter 8: Using Probe
• **Many Curves**: In this mode, new curves do not replace old ones, so many curves are plotted together, with common or individual vertical scales. The choice of common or individual scales is made by enabling or disabling the **Same Y Scales** option from the **Scope** menu.

• **Save All**: This option forces Probe to save all variables. Use it only if you need to display power, charge, flux, resistance, capacitance, inductance, B field, or H field.

• **Save V and I Only**: During a run, MC7 generates many variables. Saving them all to disk for display by Probe can create huge files. This option saves file space and lowers access time by saving only time, digital states, and voltage and current variables. It discards the remainder, including power, charge, flux, capacitance, inductance, resistance, and magnetic field values.

• **Plot Group**: This option lets you pick the plot group to place the next curve in. The next time you add an expression or click in the schematic to plot a curve it will be placed in the specified plot group.

• **Exit Probe** (F3) : This exits Probe.
Transient analysis variables

The Vertical menu selects the vertical variable and the Horizontal menu selects the horizontal variable. Where the arrow tip of the mouse cursor touches the schematic, Probe determines whether the object is a node or a component and whether it is analog or digital.

If the object is a digital node, Probe plots the state curve of the node.

If the object is analog, Probe extracts the vertical and horizontal variables specified by these menus and uses them to plot the analog curve. The analog variables available in transient analysis include:

- **Voltage:** If the mouse probes on a node, a node voltage is selected. If the mouse probes on the shape of a two-lead component, the voltage across the component is selected. If the mouse probes between two leads of a three or four lead active device, the lead-to-lead difference voltage is selected.

  *Press the SHIFT key and click on two nodes and you'll get the differential voltage across the two nodes.*

- **Current:** If the mouse probes on the shape of a two-lead component, the current through the component is selected. If the mouse probes on a lead of a three or four lead active device, the current into the lead is selected.

- **Energy:** If the mouse probes on a component, it plots the energy dissipated (ED), generated (EG), or stored (ES) in that component. If the component has more than one of these, a list appears allowing selection.

- **Power:** If the mouse probes on a component, it plots the power dissipated (PD), generated (PG), or stored (PS) in that component. If the component has more than one of these, a list appears allowing selection.

- **Resistance:** If the mouse clicks on a resistor, this selects its resistance.

- **Charge:** If the mouse clicks on a capacitor, the capacitor's charge is selected. If the probe occurs between the leads of a semiconductor device, the charge of the internal capacitor between the two leads is selected. For example, a click between an NPN base and emitter selects the CBE charge.

- **Capacitance:** This is the capacitance associated with the charge.
• **Flux:** If the mouse clicks on the body of an inductor, this selects its flux.

• **Inductance:** This is the inductance associated with the flux.

• **B Field:** If the mouse clicks on a core, this selects the B field of the core.

• **H Field:** If the mouse clicks on a core, this selects the H field of the core.

• **Time:** This selects the transient analysis simulation time variable.

• **Linear:** This selects a linear plot.

• **Log:** This selects a log plot.
Probing node voltages

Click the **Vertical** menu and select **Voltage**. Select **Time** on the **Horizontal** menu. Click the left mouse button on the dot above the Q1 collector lead. Probe scans the schematic, determines that the mouse is pointing to node 1, and plots V(1) vs. time. Probe on Q1’s base lead dot, then probe on its emitter lead dot. The display should now look like this:

![Probing node voltages](image)

**Figure 8-1 Probing node voltages**

Probe first checks if the location is within the shape outline of a component. If so and if the component is a digital part, a subckt, or a macro, Probe presents a list of pin names and lets you select one. If the part is anything else (e.g. a standard analog part), Probe tries to match the selected vertical and horizontal variables, like voltage or current, with the variables available from the component. If there is a match, the variables are assigned and retrieved from the file. If there is no match, Probe checks to see if one of the selected variables is voltage and the location is on a non-ground node. If it is, it assigns the node's digital state or analog voltage to the variable and retrieves the values from the file.

To illustrate plotting lead-to-lead voltages, press CTRL + F9 to remove all curves. Click the mouse midway between the Q1 base lead dot and the Q1 emitter lead. This plots one of the curves, VBE(Q1) or VEB(Q1), depending upon which lead the probe was closest to. It may take some practice to get the feel for where to probe. Add the VBC(Q1) curve by clicking midway between the base and collector leads.
Probing lead-to-lead voltages

The lead-to-lead voltage curves look like this:

Figure 8-2 Probing lead-to-lead voltages

Lead currents can be plotted just as easily. Select Current from the Vertical menu. Press CTRL + F9 to remove all curves. Click on the base and emitter leads of Q1. The resulting curves show the current into each of these leads:

Figure 8-3 Probing lead currents
Navigating the schematic

Suppose you want to probe in an area of the schematic that is not visible? You can use any of the usual methods: scroll bars, mouse or keyboard panning, changing the scale, SHIFT + click relocation, or flag relocation.

To move around quickly use the SHIFT + click method. Press the SHIFT key and click the right mouse button anywhere in the circuit. The circuit shrinks. Move the mouse to another part of the circuit and press SHIFT + click. The scale reverts to normal and the view is centered at the mouse position.

Keyboard panning uses CTRL + any arrow key to move the view in the direction of the arrow. CTRL + PGUP and CTRL + PGDN move the view up or down one page. The circuit window must be selected to pan the circuit view.

Mouse panning is the best way of navigating a localized area of the schematic. To illustrate, click in the Probe display and press CTRL + F9. Select Voltage from the Vertical menu. Click the left mouse button on Q1’s collector dot to plot V(1) vs. time. Point the mouse near the middle of the circuit window, click the right mouse button, and hold it down. Drag the mouse to the left until the mouse is near the window border. Release the button and repeat the procedure until the Q8 transistor is in view. Click on the dot by the node labeled Out. The screen should look like this:

![Figure 8-4 Curves from widely separated areas](image)

Figure 8-4 Curves from widely separated areas
An AC example

How about AC? The basic operation is the same, but there are differences. To illustrate the differences, press F3 to exit Probe and unload the ECLGATE circuit. Load the file DIFFAMP. Select **Probes AC** from the **Analysis** menu. Click on the **Vertical** menu. It looks like this:

![Figure 8-5 AC Probe variables and operators](image)

The list of variables includes the usual voltage and current variables, but excludes charge, capacitance, flux, inductance, B, H, and time. There are several new variables; INOISE, ONOISE, and frequency. Additionally, the complex math operators, Magnitude, Magnitude (dB), Phase (PH), Group Delay (GD), Real Part (RE), and Imag Part (IM) are available. The short form is shown in parentheses. One of these operators is always selected. When you choose a circuit variable by clicking in the schematic, the selected operator is applied to the circuit variable and the result plotted. Magnitude is the default operator. For example, V(10) is the magnitude of V(10). PH(V(10)) is the phase of V(10). As in normal AC analysis, the noise variables cannot be mixed with other variables, such as voltage or current.

Click on the dot near the node labeled A. Using the right mouse button, pan the schematic to the left by dragging in the schematic. Pan until the right portion of the diffamp is visible. Click on the dot near the node labeled OutA. Click on the Cursor mode button to enable the Cursor mode. The results should look like Figure 8-6.
The left plot cursor is initially placed at the first data point, 1Khz. The low frequency gain at the two nodes A and OutA can be read out directly under the Left column. Use the left mouse button to move the left cursor to obtain additional readings. The right plot cursor is controlled by the right mouse button.

Press CTRL + F9. Select Magnitude, Log, and ONOISE from the **Vertical** menu and click anywhere in the schematic. Select INOISE from the **Vertical** menu and click anywhere in the schematic. This plots input and output noise:

Figure 8-6 Reading AC gains using the Cursor mode

Figure 8-7 AC noise plots
A DC example

We'll use the file DIFFAMP to illustrate the use of Probe in DC. Exit the AC Probe routine by pressing F3. Select Probe DC from the Analysis menu. Click on the Vertical menu. It looks like this:

![DC Probe variables](image)

**Figure 8-8 DC Probe variables**

The list of available vertical variables includes voltage, current, and power. The horizontal variable is initially the voltage across the Input1 source when you start or press CTRL + F9 to clear the curves. The horizontal variable can be changed after the first curve has been placed by first selecting the plot window, and then pressing F10 to invoke the Characteristics dialog box. Simply type in a new expression into the Plot X field.

Press ESC to remove the Vertical menu.

Click on the dot near the node labeled OutA. Using the right mouse button, pan the schematic to the left by dragging in the schematic. Pan until the right portion of the diffamp is visible. Click on the dot near the node labeled 'OutB'. Click on the Cursor button to enable Cursor mode. The results should look like Figure 8-9.
Click on the Inflection button. This moves the left plot cursor to the next inflection point to the right of its current position (first data point). Press SHIFT + LEFT ARROW key. This moves the right plot cursor to the next inflection point to the left of its current position (last data point). The peak gain 603, which occurs near the inflection point, can be read out directly in the Slope column. The inflection mode is useful for determining the peak DC gain of an amplifier.
Probing a SPICE file

MC7 can also probe SPICE files. Exit DC Probe with F3 and load CHOKE.CKT. Select Analysis / Probe Transient. MC7 presents the Analysis Limits dialog box to let you change the run conditions if you want. Press ESC to remove the dialog box and click on the text V1 and again on C1. MC7 plots the voltage across the V1 source and the C1 capacitor.

![Figure 8-11 Probing SPICE circuits](image)

Clicking on two-terminal devices like sources, resistors, diodes, and the like plots the voltage across or current through the device, depending upon whether the Vertical option is set to Voltage or Current.

Clicking on three-terminal devices, presents a dialog box where you can select the desired voltage or current variable.

Clicking on a node number plots the node voltage.
Chapter 9  Stepping Component Parameters

What's in this chapter

Stepping is the process of systematically changing one or more numeric parameters to see what effect the parameter(s) may have on circuit behavior. You can step simple parameters, like a resistor's value, or a model statement parameter like the forward beta of a transistor, or a symbolic parameter.

In this chapter, we demonstrate how to use stepping with several tutorials. The topics include:

• How parameter stepping works

• Stepping in transient analysis

• AC and DC examples

• Stepping summary
How parameter stepping works

Stepping systematically alters the value of one or more parameters of one or more components and then runs the analysis, drawing multiple branches for each curve. Most parameter types can be stepped, including component parameters like the resistance of a resistor, model parameters like a transistor beta, and symbolic parameters created with a .define or .param command. If the parameter changes the equation matrix, MC7 simply recreates the equations. For each parameter set, a run is made and the specified curves plotted.

To illustrate stepping, load the circuit DIFFAMP. Select Transient from the Analysis menu. Press F11, click on the Stepping button in the Analysis Limits dialog box, or click on the Stepping button to display the Stepping dialog box. It looks like this:

![Figure 9-1 The Stepping dialog box](image)

The dialog box provides tabs for up to twenty parameters, although two or three is a practical maximum. Each tab accesses a panel which controls a single parameter. Stepping for each parameter is enabled when its Step It option is set to Yes.

The left Step What list box specifies the name of the model whose parameter is to be stepped. Since dissimilar parts may share the same model name, the electrical definition is shown along with the name. This can be seen in Figure 9-1 where the first item is NPN N1. This specifies that we want to step one of the parameters of all bipolar NPN transistors using the model name N1. Clicking on the list box arrow displays a list of the models available for stepping. To select a model, click on it.

The right Step What list box specifies the name of the model parameter to be...
stepped. Clicking on the list box arrow displays a list of the parameters available for stepping. To select a particular parameter, click on it. In this case we want to step the BF (forward beta) parameter, so leave it as it is.

The From field in each panel specifies the starting value of the parameter for the first run. The To field specifies the ending value of the parameter for the last run. The Step Value field specifies how much the parameter changes between steps.

The Method option in each panel controls how the Step Value affects the parameter value. Linear stepping adds the Step Value to the parameter value. Log stepping multiplies the parameter by the Step Value. List stepping lets you enter a comma-delimited set of specific values in the From field.

The Parameter Type option in each panel specifies whether the Step What field refers to a model name, component name, or symbolic name. You can step an individual instance of a model parameter or all instances of the model parameter. If the Type option is set to Model, all instances are simultaneously stepped. If this option is set to Component and the PRIVATEANALOG / PRIVATEDIGITAL (Options / Global Settings) flags are enabled, then only the instance whose component name matches the Step What field will have its parameter stepped.

The Change option only comes into play when stepping multiple parameters. It controls whether the parameter changes are to be nested or simultaneous. For example, suppose you step R1 through the values 10 and 20. Suppose also that you step C2 through the values 1n and 5n. Simultaneous stepping will generate two runs and nested stepping will produce four runs as shown below.

<table>
<thead>
<tr>
<th>Nested</th>
<th>Simultaneous</th>
</tr>
</thead>
<tbody>
<tr>
<td>R1=10 C2=1n</td>
<td>R1=10 C2=1n</td>
</tr>
<tr>
<td>R1=10 C2=5n</td>
<td>R1=20 C2=5n</td>
</tr>
<tr>
<td>R1=20 C2=1n</td>
<td></td>
</tr>
<tr>
<td>R1=20 C2=5n</td>
<td></td>
</tr>
</tbody>
</table>

Simultaneous stepping requires an equal number of steps for each parameter. Use nested stepping when you want all combinations of parameter variation. Use simultaneous stepping when you want only specific combinations.
Stepping in transient analysis

To see how stepping works in transient analysis, click the Yes button in Parameter panel 1, click OK, and press F2 to start the run. It looks like this:

![Figure 9-2 Stepping BF in four transistors simultaneously](image)

In this run, each device which uses the N1 model, which includes the transistors Q1, Q3, Q4, and Q5, has its BF (forward beta) stepped through the values 100, 150, ... 350. To see which devices use N1, double-click on each device in the schematic to see its Attribute dialog box. From the results, it seems the offset voltage of $V(\text{OUTA,OUTB})$ is insensitive to large changes in BF, if all four devices have the same value.

Now we'll step the BF of just Q1 to see how the circuit tolerates small relative differences in beta. Press F11 to access the Stepping dialog box. Click on the Component item in the Parameter Type group. From the Step What list, click on Q1 and from the parameter list select BF. Type "250" in the From field, "255" in the To field, and "1" in the Step Value field. Click on the OK button and press F2 to start the run. The plot, shown in Figure 9-3, demonstrates the circuit sensitivity to differential beta. When Q1's BF changes from 250 to 255, while all other transistors have constant BF, large shifts occur in the output offset of both curves $V(A,B)$ and $V(\text{OUTA,OUTB})$. 
Now we'll use CJE to illustrate log stepping. Press F11 to access the Stepping dialog box. Click on the Model button and the Log button. From the left list box select NPN N1, and from the right list box, select CJE. Type "2P" into the From field, "16P" into the To field, and "2" into the Step Value field. Click OK. Press F2 to start the run and it looks like this:
AC and DC examples

Press F3. Select Revert from the File menu. Press ALT + 2 to select AC. Press F11, click the Yes button in the Step It group. Press ENTER, then F2.

To illustrate list stepping, press F11. Click the List option in the Method group. Type "100,110,150,160,200,210" in the From field. Press ENTER, then F2. The run looks like this:
To illustrate stepping in DC, press F3 to exit the analysis. Press ALT + 3 for DC analysis. Press F11, click on the Linear option, click on the Yes button, click OK, then press F2 to start the DC run. It looks like this:

![Figure 9-7 DC analysis linear stepping](image)

To illustrate multiple parameter stepping, press F11, click in the Yes option in the Step It field of parameter 2. Press ENTER, then F2. The run looks like this:

![Figure 9-8 DC analysis stepping](image)

Here we've simultaneously stepped BF and NF of all transistors using the N1 NPN model. Nested stepping was selected, and each parameter has six values, so $6 \times 6 = 36$ runs were done.
Text stepping

Text can also be stepped. Consider the circuit below:

Here Q1’s model is set to N1, which is defined as N1A via the statement,

```
.DEFINEN1N1A
```

If we step N1 through a list that includes N1A and N1B, we get two simulations. One is for the case when N1 is N1A and uses the N1A model parameter set. The second is for the case when N1 is N1B and uses the N1B model parameter set. The Stepping dialog box for this case is shown below.

![Figure 9-10 Stepping the N1 variable](image1)

![Figure 9-11 The Stepping dialog box for text stepping the N1 variable](image2)
Notice two things about text stepping:

1) Text stepping is done with a symbolic variable that is created and defined with a .DEFINE statement.

2) Text stepping is done with the List method.

Here is what the simulation looks like for the specified stepping.

![Figure 9-12 The simulation run](image)

The two runs use two different model parameter sets and produce two different output curves.
Stepping summary

The most important things to remember when using stepping include:

1. The parameters of these components may not be stepped:
   - Transformer
   - User sources
   - Laplace sources
   - Function sources
   - SPICE dependent sources (E,F,G,H sources)
   - MC4 Switches; the S and W switches can be stepped.

The behavior of User, Laplace, Function, and SPICE sources is embodied in algebraic formulas and numeric tables, and thus can't be stepped. You can, however, step symbolic parameters which in turn are used in Laplace, Function, and SPICE source functions. For example, you could use,

```plaintext
.DEFINe TAU 5
```

A Laplace function source like,

```plaintext
1/(1+TAU*S)
```

could then be changed by stepping TAU.

Similarly in a Laplace table source like,

```plaintext
.DEFINe RVAL 2.0
.DEFINe TAB (1k,0,RVAL)
```

you could change the behavior of the source by stepping RVAL.

The User source gets its data from an external data file and has no parameter that can be stepped.

2. In Component mode, stepping affects one parameter of one device only if the PRIVATEANALOG and PRIVATEDIGITAL options (Global Settings) are enabled. In Model mode, stepping affects one parameter of all devices that use that model name. Thus you are potentially affecting many devices.
This is true regardless of the state of the PRIVATEANALOG or PRIVATEDIGITAL flags.

3. Certain model parameters may not be stepped. These include:

- The MOSFET Level model parameter may be stepped, but an error will occur if the model statement has been created with parameters for level 1, 2, or 3 and the level changes to a BSIM model (Level 4, 5, or 8). Each BSIM model uses model parameter names that are different from the other BSIM models as well as the level 1, 2, and 3 models, so the parameter names would be meaningless.

4. Linear stepping starts with the From value and adds the Step Value until it reaches the To value. Log stepping starts with the From value and then multiplies by the Step Value until it reaches the To value. A Step Value of 2 is often convenient and is called octave stepping. A Step Value of 10 is sometimes referred to as decade stepping. List stepping simply uses the values specified in the From field.

5. If multiple parameters are to be simultaneously stepped, they must each specify the same number of steps. If there is a mismatch, an error message is generated.

6. At least two parameters must be varied to create 3D performance plots.

7. Stepping a resistor, capacitor, or inductor that uses an expression for its value, replaces the value calculated from the expression with the step value. In other words, the step value takes precedence over the calculated value.

8. Text stepping requires a variable created with a .DEFINE statement and the List method must be used.
Chapter 10

Using Monte Carlo

What's in this chapter

Monte Carlo analysis statistically tests circuit performance. It creates a batch of circuits populated with toleranced components. After the analysis of each circuit, it employs user-selected functions to extract performance data from curves plotted or printed during the run. The results are statistically analyzed and plotted in the form of histograms. Careful review of the data can yield valuable insights into the reliability, cost, and the ability to manufacture the circuit.

Monte Carlo statistical analysis is available in transient, AC, and DC analysis.

Stepping and Monte Carlo are mutually exclusive. Either one, but not both, may be run simultaneously.

The chapter is organized as follows:

- How Monte Carlo works
- Distributions
- Performance functions
- Options
- An example
- Statistical summary
How Monte Carlo works

Monte Carlo works by analyzing many circuits. Each circuit is constructed of components randomly selected from populations matching the user-specified tolerances and distribution type.

Tolerances are applied to a component's numeric model parameters. *Only model parameters and symbolic parameters can be tolerated.* Tolerances are specified as an actual value or as a percentage of the nominal parameter value.

Both absolute (LOT) and relative (DEV) tolerances can be specified. A LOT tolerance is applied absolutely to each device. A DEV tolerance is then applied to the first through last device relative to the LOT tolerated value originally chosen for the first device. In other words, the first device in the schematic list receives a LOT tolerance, if any. All devices, including the first, then receive the first device's value plus or minus the DEV tolerance. DEV tolerances provide a means for having some devices track in their critical parameter values.

Both tolerances are specified by including the key words LOT or DEV after the model parameter:

```
[LOT\[t&d\]=<value>[\%]]  [DEV\[t&d\]=<value>[\%]]
```

For example, this model statement specifies a 10% absolute tolerance to the forward beta of the transistor N1:

```
.MOST N1 NPN (BF=300 LOT=10%)
```

In this example, for a worst case distribution, each transistor using the N1 model statement has a forward beta of either 270 or 330. If a Gaussian distribution were used, a random value would be selected from a Gaussian distribution having a standard deviation of 30. If a uniform distribution were used, a random value would be selected from a uniform distribution having a half-width of 30.

This example specifies a 1% relative tolerance to the BF of the N1 model:

```
N1 NPN (BF=300 DEV=1%)
```

The DEV value specifies the relative percentage variation of a parameter. A relative tolerance of 0% implies perfect tracking. A 1.0% DEV tolerance implies that the BF of each N1 device is the same to within 1.0%. Model statements that use
DEV tolerances force the use of private libraries, regardless of the state of the PRIVATEANALOG or PRIVATEDIGITAL flags.

This sample specifies a 10% absolute and 1% relative BF tolerance:

```
.MODEL N1 NPN (BF=300 LOT=10% DEV=1%)
```

In this example, assuming a worst case distribution, the first N1 model is randomly assigned one of the two values 270 or 330. These two values are calculated from the mean value of 300 and 10% LOT tolerance as follows:

\[
BF = 270 = 300 - 0.1 \times 300 \\
BF = 330 = 300 + 0.1 \times 300
\]

Suppose that the LOT toleranced BF value was randomly chosen to be 330. Then all N1 transistors, including the first, are randomly given one of these values, based upon the 1% DEV tolerance:

\[
327 = 330 - 0.01 \times 300 \\
333 = 330 + 0.01 \times 300
\]

If the LOT toleranced BF value had been randomly chosen to be 270, then all N1 transistors, including the first, would be randomly given one of these values, based upon the 1% DEV tolerance:

\[
267 = 270 - 0.01 \times 300 \\
273 = 270 + 0.01 \times 300
\]

Assuming a worst case distribution, all BF values in any particular run would be chosen from the set \{267, 273\} or the set \{327, 333\}.

Resistors, capacitors, and inductors can only be toleranced through their multiplier model parameter. The example below provides a 5% LOT tolerance and a .2% DEV tolerance for a capacitor:

```
.MODEL CMOD CAP(C=1 LOT=5% DEV=.2%)
```

Any capacitor that uses the CMOD model will be toleranced, since the tolerated C multiplier will multiply its capacitance value.

See the "Monte Carlo Analysis" chapter in the Reference manual for further information on using tolerances.
Distributions

The actual values assigned to a toleranced parameter depend not only on the tolerance, but on the distribution as well.

A worst case distribution places all values at the extremes of the tolerance band. There are only two values:

\[
\text{Min} = \text{Mean} - \text{Tolerance} \\
\text{Max} = \text{Mean} + \text{Tolerance}
\]

The mean value is the model parameter value.

A uniform distribution places values equally over the tolerance band. Values are generated with equal probability over the range:

From \textit{Mean - Tolerance} to \textit{Mean + Tolerance}

A Gaussian distribution produces a smooth variation of parameters around the mean value. Values closer to the mean are more likely than values further away. The standard deviation is obtained from the tolerance by this formula:

\[
\text{Standard Deviation} = \Sigma = (\text{Tolerance}/100)\cdot\text{Mean}/\text{SD}
\]

SD (from the Global Settings dialog box) is the number of standard deviations in the tolerance band. Thus, the standard deviation is calculated directly from the tolerance value. The value chosen depends upon how much of a normal population is to be included in the tolerance band. Here are some typical values:

<table>
<thead>
<tr>
<th>Standard deviations</th>
<th>Percent of population</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>68.0</td>
</tr>
<tr>
<td>1.96</td>
<td>95.0</td>
</tr>
<tr>
<td>2.00</td>
<td>95.5</td>
</tr>
<tr>
<td>2.58</td>
<td>99.0</td>
</tr>
<tr>
<td>3.00</td>
<td>99.7</td>
</tr>
<tr>
<td>3.29</td>
<td>99.9</td>
</tr>
</tbody>
</table>

If you're certain that 99.9% of all 10% resistors are within the 10% tolerance, you would use the value 3.29. Using a Gaussian distribution, a 1K 10% resistor may have a value below 900 ohms or above 1100 ohms. The probability would be less than 0.1% for an SD of 3.29, but it could happen.
Performance functions

MC7 saves all X and Y expression values of each plotted or printed expression at each data point for each run, so you can create histograms after the runs are done by picking a performance function and an expression. The performance function calculates a single number from the selected expression for each analysis run. All the numbers are combined to form a population which is statistically analyzed and its histogram is displayed. The performance functions supplied with MC7 include:

- Rise_Time
- Fall_Time
- Peak_X
- Peak_Y
- Valley_X
- Valley_Y
- Peak_Valley
- Period
- Frequency
- Width
- High_X
- High_Y
- Low_X
- Low_Y
- X_Level
- Y_Level
- X_Delta
- Y_Delta
- X_Range
- Y_Range
- Slope
- Phase_Margin

For a more detailed description of how the performance functions work see Chapter 7 of this book.
The Monte Carlo options dialog box provides these choices:

- **Status**: Monte Carlo analysis is enabled by selecting the On button. To disable it, click the Off button.

- **Number of Runs**: The number of runs determines the confidence in the statistics produced. More runs produce a higher confidence that the mean and standard deviation accurately reflect the true distribution. Generally, from 30 to 300 runs are needed for a high confidence. The maximum is 30000 runs.

- **Report When**: This field specifies when to report a failure. The routine generates a failure report in the numeric output file when the Boolean expression in this field is true. The field typically contains a performance function specification. For example, this expression

  \[
  \text{Rise\_Time}(V(1),1,1,0.8,1.4) > 10\text{ns}
  \]

  would generate a report when the specified rise time of \( V(1) \) exceeded 10ns. The report lists the model statement values that produced the failure. These reports, included in the numeric output file (CIRCUITNAME.TNO for transient, CIRCUITNAME.ANO for AC, and CIRCUITNAME.DNO for DC), can be viewed directly and are also used by the **Load MC File** item in the **File** menu to recreate the circuits that created the performance failure.

- **Distribution to Use**: This choice controls the type of distribution used to generate the individual populations of component parameters.

  - **Gaussian distributions** are governed by the standard equation

    \[
    f(x) = e^{-\frac{(x-\mu)}{\sigma^2}} / (2\pi)^{\frac{1}{2}}
    \]

    Where \( s = x-\mu/\sigma \) and \( \mu \) is the nominal parameter value, \( \sigma \) is the standard deviation, and \( x \) is the independent variable.

  - **Uniform distributions** have equal probability within the tolerance limits. Each value from minimum to maximum is equally likely.

  - **Worst case distributions** have a 50% probability of producing the minimum and a 50% probability of producing the maximum.
An example

To illustrate the Monte Carlo features, load the file CARLO4.CIR. This file contains a simple pulse source driving an RLC network. The circuit looks like this:

![Carlo4 Circuit](image)

**Figure 10-1 The CARLO4 circuit**

Select transient analysis and then using the mouse, click the **Options** item from the **Monte Carlo** menu. It should look like this:

![Monte Carlo Options](image)

**Figure 10-2 Monte Carlo options**
The Monte Carlo options are set to run 100 runs using a Gaussian distribution. Click on the OK button and press F2 to start the runs. The curves accumulate on the screen and the result looks like this:

![Figure 10-3 The analysis run](image)

Select **Monte Carlo - Histograms - Rise_Time(V(3),1,1,1,2)**. This selects the existing Rise_Time histogram which looks like this:

![Figure 10-4 The Rise_Time histogram](image)
This figure shows the frequency distribution for the Rise_Time performance function. The function is specified for the curve V(3), with a Boolean of 1, which selects all data points, an N value of 1 which searches for the first rise time in the V(3) curve, a Low value of 1.0, which defines the first level from which the rise time is to be measured, and a High value of 2.0, which specifies the second level from which the rise time is to be measured. The Rise_Time function measured one value from each of the 100 curves and the results are shown here in histogram form. The statistical summary at the lower left shows the lowest value, highest value, standard deviation, and mean, or average value, of the 100 numbers. The list to the right lets you scroll through individual rise time values. The Intervals value determines the number of vertical bars in the histogram. You can change the lower and upper limits in the histogram to show the percentage of the total distribution included within the limits, predicting how these limits would affect production yields.

Now we'll add a new histogram to measure the width of the pulse. Select Monte Carlo - Histograms - Add Histogram. This presents the Properties dialog box, which you use to select a performance function. Click on the Get button and select the Width performance function. Click OK. Click OK again in the Properties dialog box a new histogram is presented.

Figure 10-5 The Width histogram

The Width function is specified for the curve V(3), with a Boolean of 1, which selects all data points, an N value of 1 which searches for the first pulse in the V(3) curve, a Level of 2.0, which defines the level at which the width of the pulse is to be measured.
Press F3 to exit. Select AC from the **Analysis** menu. Press F2 and the screen should look like this:

![Figure 10-6 100 plots of DB(V(3))](image)

Select **Add Histogram** from the **Histograms** item on the **Monte Carlo** menu. Use the Get button to select the X_Level function for the What To Plot field. Click in the Y Level field and type -3. Click OK. Click OK again in the Properties dialog box a new histogram is presented.

![Figure 10-7 AC bandwidth histogram using the X_Level function](image)
The function is specified for the curve DB(V(3)), with a Boolean of 1, which selects all data points, an N value of 1 which finds the first X value instance in the curve, a Y Level of -3.0, which defines the level at which the X value of the curve is to be measured. Since the curve is a plot of the gain of the circuit, which is a simple low pass filter, and since we chose -3 for the level, the performance function measures the 3dB bandwidth of the filter.

Press F10 to show the Properties dialog box. It includes items similar to the Plot Properties dialog boxes for the analysis plots.

Press Cancel to close the dialog box.
Press F3. Select DC from the **Analysis** menu. The Analysis Limits look like this:

![Figure 10-8 The DC analysis limits](image)

These limits specify that we plot $R(R2)$ while stepping $V1$. $V1$ has no effect on $R(R2)$. As a result, the plots are a series of straight lines. Press F2 to start the run. Select the **Peak_Y** item from **Monte Carlo - Histograms**. The **Peak_Y** function measures the largest value of $R(R2)$, which is simply the toleranced resistor value. The distribution approximates a Gaussian distribution.

![Figure 10-9 A Gaussian distribution](image)
The Uniform distribution option produces a histogram like this:

![Uniform Distribution Graph]

**Figure 10-10 A uniform distribution**

The Worst Case distribution option produces a histogram like this:

![Worst Case Distribution Graph]

**Figure 10-11 A worst case distribution**

In each of the three cases, we plotted the resistance value directly, so each output histogram directly mirrored the distribution function used to determine its value.
The Gaussian distribution for the resistor tolerance resulted in a similar, Gaussian output distribution. For a large number of cases, the histogram closely approaches the bell shape of the standard Gaussian equation.

The uniform distribution for the resistor produced a similar uniform output distribution, although with a few bumps. If we had run a very large number of cases, we would expect a perfectly flat histogram, reflecting an equal probability of all outputs in the range.

The worst case distribution generated an output distribution that contained the two extremes. The proportion that fall into the low or high category is due to chance. The larger the number of runs, the greater the chance the proportions will be equal.

In more complex designs having many components with tolerances, the output distributions approach a standard Gaussian shape, even if the input distribution is chosen to be uniform or worst case, due to the Central Limit Theorem of statistics. It simply takes more cases to produce a normal-looking output distribution.

Press F3 to exit the analysis, and close the file with CTRL + F4.

---

**Statistical summary**

The statistical results are printed to a disk file. The file names used are:

- Transient analysis: CIRCUITNAME.TMC
- AC analysis: CIRCUITNAME.AMC
- DC analysis: CIRCUITNAME.DMC

The content of the file may be viewed by selecting Statistics from the Monte Carlo menu when a histogram is the active window.
What's in this chapter

This chapter describes the use of macros. The term macro is defined and the four steps of macro creation and usage are described. They are:

- Creating the macro circuit file
- Selecting or creating a suitable shape for the macro
- Entering the macro into the Component library
- Using the macro in a circuit

What is a macro?

Macros are complete circuits, created and saved on disk to be used as building blocks by other circuits. The principal advantage of macros is that the behavior of a complex circuit block can be incorporated into and represented by a single component. The complexity and detail of the macro is hidden from view in the calling circuit.

When an analysis is run, the macro circuit file is loaded from disk and substituted for the macro. Macro circuits are constructed in the usual way, with two exceptions.

First, macros use command text of the form,

```
.PARAMETERS(par1,par2,...),
```

to define parameters to be passed to the macro by the calling circuit.

Second, macros use grid text on circuit nodes to define the nodes (pin names) that are to be connected to the using circuit.
Creating the macro circuit file

The first step in using macros is to create the macro circuit itself. We won't do that here. Instead we'll use a macro circuit which is supplied with MC7. Load the macro circuit INT. It is an integrator circuit and looks like this:

![Figure 11-1 The INT macro](image)

The first stage of the macro circuit is a voltage-controlled current source (IOFV). Its transconductance value, SCALE, is passed as a numeric parameter by the calling circuit. The circuit which uses the macro is referred to as the calling circuit. The first stage multiplies the input signal by the value SCALE and converts it to a current. The current flows directly into a capacitor, creating a voltage that is the integral of the scaled input signal. A final unity-gain stage buffers the capacitor voltage from the load in the calling circuit. The high-valued resistor avoids infinite voltages on the capacitor when DC input voltages occur. It also limits the useful range of the macro to frequencies above 1E-6, which would be acceptable for virtually all applications.

This circuit illustrates the two features which distinguish macros from ordinary circuits. First, the external pin connections are defined by placing the pin name in the form of grid text on the node where connection is desired. In the INT circuit, the text PINA, connects the positive input of the voltage-controlled current source to PINA of the macro shape. The text PINB, connects the output of the buffer stage to PINB of the macro shape.

The second important feature in this macro is that it receives parameters from the calling circuit. A macro need not have passed parameters, but most do. It can greatly enhance a macro's usefulness. The first step in passing parameters to a macro is to include the .PARAMETERS control statement in the macro circuit.
This is done by including a piece of text in the macro circuit using this format:

\[
\text{.PARAMETERS } (<\text{parameter[=<value>]> [, } <\text{parameter[=<value>]>})*}
\]

The INT macro uses this particular parameters statement:

\[
\text{.PARAMETERS(SCALE=1,VINIT=0)}
\]

The statement defines two parameters, SCALE and VINIT. SCALE is used to multiply the input signal, and hence the integral. VINIT is used to provide an initial value to the capacitor and hence to the value of the integral.

The usual procedure is to create the INT macro circuit, then save it under the macro name. In this case it would be saved to disk under the name INT.MAC.

---

Selecting a suitable shape for the macro

The second step in the construction of a macro is the selection or creation of a suitable shape. For our example, the Block shape will suffice. It looks like this:

![Figure 11-2 The Block shape](image)

The figure shows the Shape Editor display for the Block shape. If there are no suitable shapes in the library, you can create a new one to visually suggest the function of the macro.
Entering the macro into the Component library

The third step is to enter the macro in the Component library. To do this, select the **Component Editor** from the **Windows** menu. From the Component Selector, double-click on the Macros name in the Analog Primitives group. In this hierarchical selector, double-clicking opens a closed group or closes an open group. Click on the INT name. This selects and displays the INT component. If you were adding INT as a new macro you would have clicked first on the Macro group to select it, then clicked on the Add Part button to add INT to the macro group. The INT component display looks like this:

![Component library entry for the INT macro](image)

**Figure 11-3 Component library entry for the INT macro**

The **Name** data field is for the component name. This is the same as the macro file name. In this case we used the name INT.

The **Shape** data field is for the name of the shape to be used to represent the macro. The shape names are from the Shape library, which is created and maintained by the Shape editor. To select a shape, click in the Shape field and press the first letter of the shape name until the one you want appears, or use the arrow adjacent to the list to browse. Here we have chosen the Block shape.

The **Definition** field specifies the electrical definition. To select a definition, click in the field and press the first letter of the definition name until the one you want appears, or use the arrow to browse. In this case, we must specify Macro to indicate that the electrical definition comes from a circuit file.
The Memo field is for descriptions or comments. It has no effect on the electrical behavior of the part.

The Attribute placement display shows the location of the attribute text (XX and YY in Figure 11-3) relative to the shape. Attribute text for a macro component is comprised of the part name, macro name, and optional parameters. These are entered via the Attribute dialog box when the component is added to a schematic. You can drag the text with the left mouse button to indicate where the first (XX) and second (YY) attribute text will be initially placed. After the component is initially placed in a circuit, the attribute text can be relocated by dragging the text attribute with the mouse.

An important aspect of entering a macro into the library is defining where the pins are. For a component like a diode, the pin names are predefined as Anode and Cathode.

*For a macro, pin names are defined by the user. They must match the actual node names as defined by grid text in the macro circuit.*

The names are defined by clicking in the Shape / pin display field. This activates a Pin dialog box, allowing you to enter a new pin name and to specify if it is digital or analog. Double-clicking on an existing pin lets you edit it. Both the pin marker dot and the pin name can be independently dragged with the mouse to the desired locations.
Using the macro in a circuit

The final step is using the macro. This is the easiest part. Once the macro has been entered into the Component library, it is available for use in circuits. It is accessed from one of the groups on the Component menu.

To illustrate using a macro, we’ll create a simple circuit that contains a voltage source with a sawtooth waveform driving an INT macro. The output of the INT macro should be the integral of the input waveform.

Close the Component Editor without saving any changes. Close the INT circuit. Select the New option from the File menu, then Schematic from the New dialog box. From Component Menu / Analog Primitives / Waveform Sources select the Pulse Source. Place it in the schematic with the plus sign pointing up. Type "SAW" for the model attribute. Enter these parameters:

\[ VZERO=-1 \ \text{V} \quad \text{VONE}=1 \ \text{V} \quad P1=0 \ \text{P} \quad P2=0.2 \ \text{u} \quad P3=0.2 \ \text{u} \quad P4=0.4 \ \text{u} \quad P5=0.4 \ \text{u} \]

Click on the OK button. Click the Wire mode button. Draw a wire from the top of the pulse source to the right.

From the Macros group of the Analog Primitives section of the Component menu, select INT. Place the INT macro input at the end of the line just drawn. Type "1E7" for the SCALE parameter, and "1" for the VINIT parameter. This passes a scale value of 1E7 and an initial value of 1. Click OK. Finally, click on the Ground button in the upper tool bar, rotate it as needed with the right mouse button and place it at the minus lead of the Pulse source.

The key points about placing a macro in a circuit are:

1. Remember where you put it in the Component hierarchy. Macros are usually placed in and selected from the Analog Primitives / Macros section of the Component menu, but their location is up to you.

2. The VALUE field holds the name of the macro circuit file, such as INT. The name must match the file name the macro circuit was saved under.

3. Each parameter is entered as a separate attribute.
The final circuit and its transient analysis are shown in the figures below. To produce this analysis you must disable the operating point and change the plot scales in the analysis limits dialog box.

Figure 11-4 The INT macro used in a circuit

Figure 11-5 Transient analysis of the circuit

Press F3, and close the circuit.
An easy way to create macros

Another way to make macros from existing circuits is to use the macro creation command. To illustrate, load the file ECLGATE. Enter Select mode, and drag a box region across the circuit like this:

![Figure 11-6 The ECLGATE macro box region](image)

Be sure to draw the box region exactly as shown above. Now press CTRL + M. Click OK in the dialog box. The screen should look like this:

![Figure 11-7 The ECLGATE circuit using a macro](image)
The program has converted the circuitry in the box region into a macro circuit. To do this it did the following:

1. Placed the circuitry within the box region in a file called ECLGATE.MAC.

2. Placed an ECLGATE macro into the current component library.

3. Modified the ECLGATE circuit on the screen by replacing the contents of the region box with a macro call ECLGATE.

As a result of this action the ECLGATE circuit appears simpler. Its complexity is hidden and encapsulated in the macro block called ECLGATE. In addition the macro has been entered into the component library and is available for use by other circuits.

You can see the macro circuit by clicking on the Info button and then clicking on the ECLGATE macro block. It looks like this:

![Figure 11-8 The ECLGATE macro circuit](image)

The program has determined that five pins are needed and has located the pin text as required. This form of macro creation always uses an adjustable macro box. Its sides and pins can be moved about as desired. It always retains its rectangular shape, however.
To change the location of the pins, select the macro by clicking on it. Drag the dot at the end of the pin to the new location and release it.

To change the shape of the macro box, select the macro by clicking on it. Drag a corner dot to change both length and width. Drag a side dot to change length or width. For example, the figure below shows an example of how the shape can be modified. Compare this with Figure 11-7.

![Figure 11-9 The altered macro box shape](image)
What's in this chapter

This chapter describes the use of SPICE subcircuits. The four steps of subckt creation and usage are described. They are:

- Creating the subckt circuit file
- Selecting or creating a suitable shape for the subckt
- Entering the subckt into the Component library
- Using the subckt in a circuit
- Using the Add Part wizard to add subckt parts

What is a subcircuit?

Subcircuits are complete SPICE text file circuits, created and saved on disk to be used by other circuits. The great virtue of subcircuits is the same as for macros; the behavior of a complex circuit block can be incorporated into and represented by a single component. The complexity and detail is hidden from view in the circuit that uses the macro.

Another major advantage is that most parts vendors use the SPICE subcircuit as the principal means for modeling their parts. Access to these models is the key reason for using subcircuits.
Creating the subcircuit text file

The first step is to create the subcircuit circuit itself. We won't do that here. Instead we'll use an existing subcircuit, supplied with MC7. To load the SPICE file, select the Open item from the File menu. Type ".\library\UA741.MOD". The circuit file looks like this:

```
* UA741 operational amplifier "macromodel" subcircuit
* connections: non-inverting input
  | inverting input
  | positive power supply
  | negative power supply
  | | | output
  | | | | |
subckt UA741 1 2 3 4 5
+3.3V//: resistance=31.39
* cc 51 0 [resistance]
ct 11 12 4.664E-12
ci 6 7 2.102E-12
dc 5 5 dx
de 54 5 dx
dlp 50 51 dx
dlj 92 90 dx
dp 4 3 dx
epnd 99 0 poly(3) (3,0) (4,0) 0 .5 .5
eb 7 99 poly(5) vb ve vlp vin 6 10.61E6 -10E6 10E6 10E6 -10E6
ga 6 0 11 12 137.7B -6
```

**Figure 12-1 The UA741.MOD subcircuit**

This subcircuit is a standard Boyle-type model for the classic UA741. The circuit file can be created with the MC7 SPICE text editor or by using an external word processor. Frequently, it can be obtained as a text file from a manufacturer of the part. It must be placed in the library directory and the file name entered into the "NOM.LIB" file to be accessible to MC7. The file name is entered by adding a line such as,

```
.LIB "UA741.MOD"
```

to the NOM.LIB file. The NOM.LIB file is located in the library folder.
Selecting a suitable shape for the subcircuit

The second step is the selection or creation of a suitable shape. Select the Shape Editor from the Windows menu. For our example, the Opamp5 shape will do nicely. It looks like this:

![Shape Editor](image)

**Figure 12-2 The opamp5 shape**

If there are no suitable shapes in the library, you can create a new one to visually suggest the function of the subcircuit. All shapes created are added to and appear in the Shape list field of the Component editor.
Putting subcircuits into the Component library

The third step is to enter the subcircuit in the Component library. To do this, select **Component Editor** from the **Windows** menu. Double-click on the Subckts group of the Analog Primitives group. This presents a list of the existing subcircuits. Click on the Opamp_subckt_5. This shows the existing Opamp_subckt_5 component. If you were adding this component as a new subcircuit you would have clicked first on the Subckt group to select it, then clicked on the Add Part button to add the Opamp_subckt_5 component to the macro group and edited the data fields to look like these:

![Component library entry](image)

**Figure 12-3 The subckt Component library entry**

The first data field is the Component name. This can be any alphanumeric name. It does not need to be the name of the subckt. In this case we used the general name, Opamp_subckt_5, but we could also have chosen the name UA741.

The Shape entry is the name of the shape to be used to represent the macro. Here we have selected the Opamp5 shape. Click on the down arrow to see a list of the available shapes from the Shape library.

The Definition field is where you specify the electrical definition. In this case, we specify Subckt. Click on the down arrow to see a list of the available definitions.
The Attribute placement fields define the location of the attribute text (XX and YY in Figure 12-3) relative to the shape. Subckt attribute text is comprised of the PART attribute which provides the part name, the NAME attribute which specifies the name of the subcircuit, the optional FILE attribute which specifies the name of the file containing the .SUBCKT statement, the PARAMS attribute which provides any passed numeric parameters, and the TEXT attribute which provides any passed text parameters. These attributes are specified when the component is placed in a schematic. The Attribute placement fields let you drag the text with the left mouse button to define where the first (XX) and second (YY) attribute text will be initially placed. After the component is placed, attribute text can be relocated by dragging with the mouse.

An important aspect of entering a subckt into the library is defining where the pins are. For a component like a BJT, the pin names are predefined as Emitter, Base, and Collector. For a subckt, the pin names and locations must be defined by the user. This is done by clicking in the Shape / pin display field. This activates a Pin dialog box, allowing you to enter a new pin name and to specify if it is digital or analog. Double-clicking on an existing pin lets you edit it. Both the pin marker dot and the pin name can be independently dragged with the mouse to the desired locations.

The pin names used in the Component library must match those in the .SUBCKT statement in the file that contains the subckt itself. For example, the UA741 uses "1" as the name of the positive input pin, so we need a pin named "1" at the position on the shape we want to identify as the positive input pin. Similarly, "5" is used as the name of the output pin so we want to have a pin named "5" placed on the shape where we expect to find the opamp output.

<table>
<thead>
<tr>
<th>UA741 Subckt Pin Names</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Positive input pin</td>
</tr>
<tr>
<td>2</td>
<td>Negative input pin</td>
</tr>
<tr>
<td>3</td>
<td>Positive power pin</td>
</tr>
<tr>
<td>4</td>
<td>Negative power pin</td>
</tr>
<tr>
<td>5</td>
<td>Output</td>
</tr>
</tbody>
</table>

Notice that you could put the pins anywhere. There is no magic in placing the positive input pin near the + symbol. It is simply easier to remember where the pins are when you wire them into a circuit.

Close the Component editor.
Using the subcircuit as a component

The final step is using the subckt. Once it has been entered into the Component library, it is available for use in any circuit and can be accessed from the Component menu group where it was added. Unload the UA741.MOD SPICE file and load the SUBCKT1 circuit. It looks like this:

![Schematic diagram of SUBCKT1 circuit]

The key points about using a subckt are:

1. When the part is placed in a circuit, its NAME attribute must be the same as its .SUBCKT name.

2. MC7 searches for the subckt in the following places:

   - The text area of the schematic. You can paste the subckt to the text area and avoid the need to copy the subckt file to the library directory.
   - The file name listed in the File attribute.
   - The files in any .LIB statements, including the default .LIB NOM.LIB.
     *This is the preferred and most common access method.*

3. Many different subcircuits can be covered with a single, generic subckt entry in the Component library, if they have the same pins and node order.

---

**Figure 12-4 Using the subckt component**

The text area of the schematic. You can paste the subckt to the text area and avoid the need to copy the subckt file to the library directory.

- The file name listed in the File attribute.
- The files in any .LIB statements, including the default .LIB NOM.LIB.
  *This is the preferred and most common access method.*
Using the Add Part wizard to add subckt parts

The procedure described in the previous pages describes how to add a subckt part from scratch. Frequently, you may wish to add a part model supplied by a semiconductor parts vendor. The easiest way is to use the Add Part wizard. It combines the three basic steps into one operation.

1) Copy the file containing the subckt or model statement to the library folder.

2) Add the model file name to the nom.lib text file located in the library folder.

3) Make an entry in the Component library.

Suppose you have downloaded a file called AD.LIB from a vendor to the location CA. In the file is a subckt statement for the power NMOS device IRF5101A. You want to add it to the library. Here is what you do.

1) Select Component Editor from the Windows menu.

2) Select the group where you want the part name to appear in the Component menu. For this illustration simply select Analog Library

3) Click on the Add Part wizard button.

4) The first prompt is for the part name. Type in "IRF5101A". Click Next.

5) The next prompt is for the electrical definition. Select Subckt. Click Next.

6) The next prompt asks for the name of the file containing the subckt. Type C:\AD.LIB (or wherever the file currently resides). Click Next.

7) The next prompt is the tricky one. The wizard has scanned the Component library and compiled a list of all subckt based parts that have pin names matching those it found for the IRF5101A subckt. Actually it tries to present only a representative list, as there may be thousands of possible parts. Select one from the list. In this case we will select the DNMOS as we know this to be a discrete NMOS device. Click Next.

8) The next prompt asks for an optional memo field. Click Next.

9) The next prompt asks for an optional palette assignment. Click Next.
10) The next panel lets you set the visibility of the various part attributes. Click Next.

11) The next panel lets you make the assignment of the component name to the NAME attribute. This assignment avoids the need to invoke the Attribute dialog box when one of these parts are added to a schematic. Click to enable the option. Click Next.

12) The final panel advises you to examine the entry to be sure all elements have been selected properly, particularly the choice of shape and where the pin names have been placed on the shape.

For our example, the new part should look like this.

![Figure 12-5 The subckt Component library entry](image)

It is also possible to import many parts simultaneously from one file. That is done with the Import wizard. Its operation is described in the Reference manual.
Chapter 13  Printing

What's in this chapter

This chapter describes how to get copies of your work on printers. MC7 provides output in two basic ways.

- Graphics
  - Schematics
  - Analysis plots
  - Performance plots
  - 3D plots
  - Monte Carlo histograms

- Text
  - Schematic text area
  - SPICE circuit descriptions
  - Document files
  - AC, DC, and transient analysis numeric output
  - Transient analysis state variables
  - Monte Carlo statistics

All text output is available in disk file or hard copy form. Graphics output is available on any printer that your system supports.
Printing schematics

Schematics may contain one or more pages which may be printed. Depending upon the scale chosen, each page is partitioned into one or more sheets for printing or plotting. The Auto option scales the largest page to fit on just one sheet. The User option lets the user pick a scale and thus adjust the physical size of the schematic. Larger image sizes produce more sheets of paper per page.

To setup or preview the printed output, use these File menu options:

• **Print Setup**
  The contents of this dialog box depend upon the type of printer chosen, but it usually lets you choose the printer, orientation, paper size, and other options. The choice of orientation affects the Print Preview partitioning.

• **Print Preview**
  This option lets you preview how the schematic will be partitioned for printing into one or more sheets. Its display looks like Figure 13-1.

  • **OK**
    This accepts any changes and exits the dialog box.

  • **Cancel**
    This ignores any changes and exits the dialog box.

  • **Next Page**
    This displays the partitioning for the next page of the schematic. Note that the scale, whether Auto or User is chosen, applies to all pages.

  • **Prior Page**
    This selects and displays the partitioning for the prior page.

  • **Page**
    This shows the name of the page being displayed. You can display any page by selecting its name from the list.

  • **Print**
    This invokes the Print dialog box.

  • **Setup**
    This accesses the Print Setup dialog box.
• Properties
This accesses the standard schematic Properties dialog box, which lets you make last minute changes to colors, fonts, and the title block.

• Help
This accesses the Help System.

• Auto _Auto_scale_
This option adjusts the scale so that the largest page in the schematic will just fit on the chosen paper size. All other pages use this scale. If Auto is clicked, _Auto_scale_ shows the scale value used. The same result is achieved by clicking on the User button and typing the same number in the _User_scale_ data field.

• User _User_scale_
This button enables the _User_scale_ value. A scale of 100 is normal size. The User Scale data field holds the scale. A change in scale takes effect only when the Apply button is pressed.

• Apply
This updates the display to reflect changes in the User scale field.

The Title Block item on the Preferences dialog box menu lets you define the content of the five fields of the title block. Field 1 is printed in large text, and the remainder are printed in smaller text. There are several options to facilitate printing the file name, date, and page numbers. These options are enabled by placing the following key words in the desired text field.

• $NAME This prints the circuit name.
• $DATE This prints the current date.
• $TIME This prints the current time.
• $USER This prints the user name.
• $COMPANY This prints the company name.
• $PAGE This prints the page number.
• $PAGENAME This prints the schematic page name.
• $MAXPAGE This prints the largest page number.
• $SHEET This prints the sheet number.
• $MAXSHEET This prints the largest sheet number.

The One Title option box produces one title block per schematic if checked. If unchecked one title block per sheet is printed.
An example of schematic printing

Load the file 'PRINT'. Select **Print Preview** from the **File** menu.

![Figure 13-1 Print Preview of page one of the PRINT circuit](image1)

The Scale mode is set to Auto so MC7 prints one sheet for each of the two pages contained in this schematic. Figure 13-1 shows how page one will fit in landscape mode. Click on the Next Page button to display page two. It looks like this:

![Figure 13-2 Print Preview of page two of the PRINT circuit](image2)
Now click on the User button. This applies the current user scale of 125 and partitions the schematic for printing. The result, shown in Figure 13-3, shows how page two will be partitioned. At this scale, two sheets of paper are required to print page two of the schematic.

![Figure 13-3 The Print Preview of page two with a scale of 125](image)

Note that clicking on the Auto or User buttons automatically update the screen. Simply editing the User scale field will not, by itself, update the screen. Clicking the mouse on the Auto, User, or Apply buttons will cause a screen update.

Once a suitable scale is chosen and the desired page ranges are selected, click on the Print button to invoke the Print dialog box to initiate printing. Of course, you need not use the Print Preview each time you want to print. If you've previously checked the Print Preview and are happy with it, simply press CTRL + P to invoke the Print dialog box.

Click on the OK button and close the file.
Printing an analysis plot

To produce a plot, first run the analysis. When the analysis is complete select the **Print Setup** option from the **File** menu. From this dialog box, select the orientation and other options.

To illustrate, load the file ECLGATE and run transient analysis. Select **Print Preview** from the **File** menu. It should look like this:

![Figure 13-4 The Print Preview of an analysis plot](image)

The Print Preview dialog box lets you include, and set the size and location on the paper of the analysis plots, 3D plots, and Monte Carlo plots. You can even include the circuit schematic. The dialog box provides these buttons:

- **Print:** This sends the image to the printer.
- **Setup:** This invokes the Print Setup dialog box.
- **Tile:** This arranges the selected plots in contiguous non-overlapping areas of the paper.
- **All:** This selects all available plots for printing.
- **Close:** This closes the Print Preview dialog box.
Help: This accesses the Help system.

There is a list of available plots. Click on a plot to toggle its selection state. There are also three button options:

Auto Tile: This automatically tiles selected plots in the layout. If Auto Tile is off, each plot acquires a set of handles and may be moved and re-sized.

Print Background: This prints the selected background color. It's generally a bad idea on ink jet printers because the large quantity of ink needed for the background saturates and warps the paper surface.

Black Border: This adds a black border around each plot.

To illustrate, click on the All button. This adds the schematic to the analysis plot producing a display like this.

![Figure 13-5 Adding the schematic to the analysis plot](image)

Because Auto Tile is enabled the plots are tiled to fill the paper. Click on the Auto Tile button to disable it. The plots are redrawn showing handles. The handles are the little black rectangles. You can now move individual plots by dragging on the interior part of the plot and you can re-size individual plots by dragging on one of the handles.
To illustrate modifying the layout, grab the lower-right handle of the schematic and drag it up and to the left. Release the handle. Drag the upper-right handle of the analysis plot down and to the left. Release the handle. Drag the analysis plot from the interior so that it moves. Drag it up and drop it on the schematic so as to overlap the two. The display should now look like this:

![Figure 13-6 Modifying the preview layout](image)

In addition to printing in the usual way, you can create Windows metafiles of the various schematics and plots created by MC7. These metafiles can be imported into other programs such as Word, PageMaker, and Excel. They can also be placed in MC7 schematics.

To illustrate, exit the print routines by clicking on the Close button. From the Edit menu select **Copy Entire Window to Picture File**. When the dialog box comes up, click on OK. This save the analysis plot as a Windows MetaFile or WMF file using the name ECLGATE.WMF.

Quit transient analysis with F3. Select **Options / Mode / Picture**. This enters metafile placement mode. Click in the lower right of the schematic. In the dialog box, click on the Browse button and select the ECLGATE.WMF file.

The screen should now look like Figure 13-7.
This same WMF picture can be imported into Excel. From Excel, select **Insert / Picture / From File**. Enter the path and file name, or browse until you find it. The path and name will be something like:

C:\MC7\DATA\ECLGATE.WMF.

The picture should appear in Excel with handles for changing its size and shape.
What's in this chapter

Animation mode is an alternative way of visualizing analysis results. It performs the selected analysis and plots any specified waveform. While it is plotting, it is also updating any animation devices on the schematic along with any on-schematic display values. In this chapter, we demonstrate Animation mode's capability with an example. The topics include:

- How Animation mode works
- Animation components
- Animate Options dialog box
- A Transient example
How Animation mode works

Animation mode is another way to view simulation results. In this mode, a single analysis data point is taken and the on-schematic display values and animation components are updated on the schematic. Micro-Cap then waits for either a key press or a specified time delay before calculating the next data point. The purpose is to slow the simulation down to be able to monitor the updated changes on the schematic. The on-schematic display values let the node voltages, branch currents, power dissipation, and device conditions of the latest data point be viewed on the schematic. The animation components that update are the digital switch, LED, and seven segment display. While primarily designed to operate in transient analysis with digital components, this mode is available in transient, AC, and DC with any type of circuit.

In transient analysis, a single time step is calculated, and any on-schematic display values or animation components are updated on the schematic. When a key is pressed or after the specified delay time has elapsed, the solution at a new time point is calculated and the schematic updated accordingly. The schematic always displays the values from the last time step calculated.

In AC analysis, the schematic displays the on-schematic display values and states of the animation components from the operating point calculation. These values are fixed during the entire simulation. Even though the schematic displays are fixed at the operating point, the animation mode will calculate a single frequency data point when a key has been pressed or the specified time delay has elapsed.

In DC analysis, a single DC sweep data point is calculated, and any on-schematic display values or animation components are updated on the schematic. When a key is pressed or after the specified delay time has elapsed, the next DC sweep data point is calculated and the schematic updated accordingly. The schematic always displays the values from the last DC sweep data point calculated.
Animation components

There are three animation components: a digital switch, an LED, and a seven segment display. The description of these are as follows:

**Digital Switch:** The switch is designed to produce either a digital zero or one state. It has a single output pin at which the selected digital state will appear. During a simulation, the switch may be clicked on to toggle it between its zero and one output. The appearance of the switch's arm will change to indicate which state the switch is currently connected to.

**LED:** The LED component is designed to represent the display of a light emitting diode. It has a single input pin. Depending on the digital state or the analog voltage at the input pin, the LED will be lit with a different color on the schematic. The colors the LED uses are defined in the Color/Font page of the circuit's Properties dialog box. In this page, there is a list of digital states that have a corresponding color.

**Seven Segment Display:** The seven segment component is designed to represent the display of a seven segment display. It has an input pin for each segment of the display. All of the pins are active high. It is intended to work with basic seven segment decoders/drivers although any input will control the display of the corresponding segment.

The LED and seven segment display components do not model the electrical characteristics of the parts they represent. They are only available for display purposes. The digital switch is the only one of the three that can affect a simulation. Each of these components must have an I/O model specified for them in order to work with analog components.
Animate Options dialog box

This dialog box sets the interval between data point calculations in an animation analysis. The dialog box is invoked by selecting **Animate Options** under the **Scope** menu and appears in Figure 14-1. It provides these options:

**Wait**

- **Don't Wait**: This option turns off the animation which lets the analysis run at optimum speed.

- **Wait for Key Press**: This option will produce one data point with each key press.

- **Wait for Time Delay**: This option will produce one data point per specified time delay.

**Time Delay**: This text field sets the specified time delay in seconds that will be between each data point calculation. This text field is only active if the Wait for Time Delay option is selected.

**OK**: This closes the dialog box and saves any changes that were made.

**Cancel**: This closes the dialog box and ignores any changes that were made.

**Help**: This accesses the help topic for this dialog box.

![Animate Options dialog box](image)

**Figure 14-1 Animate Options dialog box**
A transient analysis example

To see how the animation mode works in transient analysis, click on **Open** under the **File** menu and load the circuit ANIM3. The ANIM3 circuit uses the seven segment components to display the outputs of three 7448 seven segment decoders. The circuit should appear like this:

![Figure 14-2 The ANIM3 circuit](image)

Select **Transient** from the **Analysis** menu. Close the Analysis Limits dialog box. Click on the **Scope** menu and select **Animate Options**. The Wait setting for the ANIM3 circuit is currently set to **Wait for Time Delay** and the Time Delay has been defined as 0.5. This means that a single data point will be calculated every half second. Click **OK**. Hit the F2 key to run the simulation. The resulting values will be displayed in the plot and on the schematic. Notice that both the digital states on the schematic and the seven segment displays are updated with each data point. Figures 14-3 and 14-4 display the simulation results at two separate times in the circuit.

For animate mode, a split screen should be used to be able to view both the waveform plot and the schematic at the same time. This can be done by selecting **Tile Vertical** or **Tile Horizontal** under the **Windows** menu. The schematic can be moved within the window by dragging with the right mouse button.
The waveforms in the plot also show the output values of the Ina stimulus (nodes 21-18), the Inb stimulus (nodes 28-25), and the resulting output (nodes 35-32) of the adder. As can be easily seen in the figures, it is much easier to view the basic output through the animation components than through the actual waveforms.
Index

Symbols
SMAXPAGE 217
SMAXSHEET 217
.SUBCKT 211
3D plots 43

A
AC analysis 105
   Accessing 46, 107
   Excitation 106
   System variables 106
Accel PCB interface 26
Active filters 48
Add page command 29
Add Part wizard 53
Add Parts wizard 213
Adding components 62, 82
Adding tags to plots 145
Adding text to plots 144
Align cursors command 133
Analog library 32
Analog primitives 32, 66
Analog waveforms 8, 16
Analysis Limits dialog box 8, 84, 108, 123, 124
Command buttons
   Add 84, 108, 124
   Delete 84, 108, 124
   Expand 85, 108, 124
   Help 85, 108, 124
   Properties 85
   Run 84, 108, 124
   Stepping 85, 108, 124
Numeric limits field
   Frequency range 108
   Maximum change % 109
   Maximum time step 85
   Noise input 109
   Noise output 109
   Number of points 85, 108, 126
   Temperature 85, 109, 125
   Time range 85
Options
   Auto scale ranges 88, 112, 128

B
B field plots 159
Baseline 131
Batch mode 17
Behavioral modeling 1
Bessel filters 48
Border display command 38
Bottom cursor position mode 139
Box 19, 29
Bring to front command 30
BSIM models 1

C
Calculator 35
Capacitance plots 159
Cascade command 34
Characteristic plot command 64
Charge plots 159
Chebyshev filters 48
Clear command 28, 73
Clear cut wire command 28

Frequency step 112
Normal run 87, 111, 128
Operating point 88, 112
Operating point only 88
Retrieve run 87, 111, 128
Save run 87, 111, 128
State variables options
   Leave 88, 111
   Read 88, 111
   Zero 87, 111
Animation 50, 156, 225
   Components 227
   Example 229
   Mode 33, 225
   Options 228
Arrange icons command 34
Attributes 19, 30, 62
   Dialog box 62, 71, 72
   Text 20
   Text display command 38
Auto scale command 131
Auto scale option 87, 111, 127

231
Click the mouse 19
Clipboard 19
Close command 27
Color command 30
Color menu 86, 110, 127
Command line 17
Command line operation 17
Component
  Definition 19
  Menu 32
Component Editor
  Access command 35
  Add group command 53
  Add part command 53
  Add Part wizard 53
  Adding a new component 51
  Assign command 52
  Clear Palette command 54
  Creating pins 21
  Display 51
  Display Value / Model Name 52
  Export to MC6 command 53
  Find command 54
  Import wizard 53
  Info command 54
  Merge command 53
  Move command 54
  New file command 53
  Open file command 53
  Parts list command 53
  Paste command 54
  Pin assignments 52
  Pin text option 52
  Redo command 54
  Replace command 54
  Sort command 54
  Undo command 54
  User palette assignment 52
  User palette membership 65
Component library 1
Component mode command 36
Condition display command 38
Copy command 19, 28, 74, 82
Copy to clipboard command 28
Copy to picture file command 29
Cross-hair display command 38
Current 7, 160
Current display command 38
Cursor 19
Cursor mode 13, 134, 137, 138
Cursor mode command 37
Cursor value fields 137
Cut command 28, 73, 82

D

Data directory 4
Data entry 25
DC analysis 46
Default component 82
Default setting for new circuits 42
Define command 6
Delete all objects command 131
Delete page command 29
Deleting objects 73
Demos 49
Deselecting objects 75
Design menu 48
DEV tolerances 184
Dialog boxes 25
Digital
  Hex operator 7
  State 7
Digital library 32
Digital primitives 32, 66
Digital waveforms 8, 16
Drag 19
Drag copying 76, 82
DSP 50
Dynamic DC analysis 12, 46, 50

E

Edit menu 28
Editing parameters and text 71
Elliptic filters 48
Equipment required 3
Esc key 20
Exit command 27
Expressions 8, 13, 89
F
File
  Binary model 56
  Text model 56
File menu 26
  New command 26
  Open command 26
  Save as command 26
  Save command 26
Filter designer 50
Filters 33, 48
Find command 31
Find component command 33
Flag mode command 37
Flip X command 29
Flip Y command 29
Font command 30
Fourier analysis 50
Function keys 58
  CTRL + F11 Optimizer 58
  CTRL + F4 Close window 58
  CTRL + F6 Change window 58
  CTRL + F9 Delete all plots 58
  F1 Help 58
  F10 Properties dialog box 58
  F11 Stepping dialog box 58
  F12 State Variables editor 58
  F2 Run analysis 58
  F3 Exit analysis 58
  F4 Display analysis plot 58
  F5 Display numeric output 58
  F6 Auto scale 58
  F7 Scale mode 58
  F8 Cursor mode 58
  F9 Analysis Limits dialog box 58
G
Gaussian distribution 186
Global settings 45, 173
Gmin stepping 40
Graphics mode command 36
Grid 20
  Grid text 20
  Grid text display command 38
H
H field plots 159
Hardware requirements 3
Help mode command 37
Help System 49
Horizontal tag mode 134
Horizontal tag mode command 37
I
I-V characteristics 123
Import wizard 53
Inductance plots 159
Inertial cancellation 40
Info mode command 37
Initialization 101
INOISE 116
Installation 4
Inverse-Chebyshev filters 48
K
Key ID 49
L
Linear DC stepping 125
Linear plot option 86
List DC stepping 125
Load MC file 27
Log DC stepping 125
Log plot option 86
LOT 184
LOT tolerances 184
M
Macro
  Definition 20, 197
  Parameters command 198
Maximize command 34
Maximum time step 85
MC6 5
Menus 22
  Selection 24
Mirror box command 29
Mode commands 36
Model Editor
Add command 57
Copy command 57
Delete command 57
Go to command 57
Memo field 57
Merge command 57
Pack command 57
Part field 57
Part selector 57
Type Selector 57
Model editor 56
Model library 56
Binary form 56
Text form 56
MODEL program 5, 35, 56
Monte Carlo
Distributions
Gaussian 186
Uniform 186
Worst case 186
Example 189
How it works 184
Options
Distribution to Use 188
Number of Runs 188
Report When 188
Status 188
Standard deviation 186
Monte Carlo analysis 50

Node voltages display command 38
Noise
Analysis 116
Flicker 116
Shot 116
Thermal 116
NOM.LIB 208, 212
Normalize command 132
Number of points 85, 108, 126
Numeric output
AC 115
DC 126
Transient 85
Nyquist plots 118

O
Object 21
ONOISE 116
Open model file 56
Optimizer 14
Optimizer demo 50
OrCad PCB interface 26

P
P column 8
Package editor 35
PADS PCB interface 26
Page 29
Scroll bar controls 23
Selector tabs 23
Panning 21, 79, 136, 164
Passive filters 48
Paste command 21, 28, 73, 74, 82
PCB interface 1, 26, 35
Performance functions 1, 147, 187
Performance plots 50
Picture 29
Picture files 71
Pin assignments 52
Pin connections 67
Pin connections display command 38
Pin definition 21
Plot group number 86
Plotting waveforms 7, 89
Point tags 37, 134
Point to end mode command 37
Point to point mode command 37
Polar plot 110
Polar plots 120
Power 7
Power display command 38
Preferences command 39
Common options
   Add DC path to ground 40
   Analysis progress bar 40
   Auto show mode 41
   Component cursor 41
   Date stamp 39
   DC path to ground check 39, 40
   File list size 39
   File warning 42
   Floating nodes check 39
   Gmin stepping 40
   Inertial cancellation 40
   Lock tool bar 39
   Node snap 40
   Nodes recalculation threshold 41
   Plot on top 40
   Print background 39
   Quit warning 42
   Rubberbanding 41
   Select mode 39
   Show slider 41
   Sound 39
   Text increment 40
   Time stamp 39
   Warning time 39
   Component palettes 42
   Main tool bar 42
   Palettes, color 42
Print
   An example 218
   Print preview
      Apply command 217
      Auto command 217
      Help command 217
      User command 217
      Title block 217
   Print command 27
   Print preview command 27
   Print setup command 27
   Printing 215
      Print preview 216
      Schematics 216
      Setup 216
   PRIVATEANALOG 173, 180, 185
   PRIVATEDIGITAL 173, 180, 185
   Probe 16, 157
      AC analysis 47, 165
      DC analysis 47, 167
      Linear plot 161
      Log plot 161
      Many traces command 159
      Navigating the schematic 164
      New run command 158
      One trace command 158
      Probing lead-to-lead voltages 163
      Probing node voltages 162
      Remove all command 158
      Save all command 159
      Save V & I only command 159
      Separate analog and digital command 158
      Transient analysis 47
      Transient analysis variables 160
         B field 161
         Capacitance 160
         Charge 160
         Flux 161
         H field 161
         Inductance 161
         Resistance 160
         Time 161
      Probe feature 50
      Probing 1
      Properties dialog box 8
      Protel PCB interface 26
      PSpice 1

Q

Quick tour 6
R
Redo command 28, 73
Reference manual 2
Refresh command 29, 63
Registering 3
Rename Components command 30
Rename Defines command 30
Repeat last find command 31
Replace command 31
Restore limit scales command 131
Revert command 27, 59, 75
Rotate command 29
Rotating components 62
Rubberbanding 41
Ruler command 131

S
Same branch command 133
Same Y scales command 133, 134
Scale mode 37, 134
Scales 90
Schematic editor 22
Scope 129
Commands
Animate 132
Auto scale 131
Cursor 132
Delete all objects 131
Go To Performance 133
Horizontal cursor 131
Keep cursors on same branch 133
Normalize 132
Restore limit scales 131
Same Y scales 133, 134
Tag horizontal 133
Tag left cursor 133
Tag right cursor 133
Tag vertical 133
Trackers 132
View Baseline 131
View data points 131
View horizontal grids 131
View minor log grids 131
View ruler 131
View tokens 131
View vertical grids 131
Cursor mode 137, 138
Cursor positioning modes 139
Bottom 139
Go To X 132
Go To Y 133
High 139, 140
Next 139
Peak 139
Top 139
Valley 139
Magnifying waveforms 135
Modes
Cursor 134
Point tag 134
Scale 134
Vertical tag 134
Panning waveforms 136
Scroll bars 23
Security key 2, 5, 49
Select
Select all command 28
Select mode 65, 71
Command 36
Definition 21
Selection 75
Send to back 30
Sensitivity analysis 46, 50
SETUP program 4
Shape
Definition 21
Editor 35, 55
Short 21
Show all paths command 38
Shrink command 79
Slider 41
Smith charts 110, 119
SPICE 6
SPICE files 80
Split text/drawing areas horizontal 34
Split text/drawing areas vertical 35
Standard deviation 186
State variables
Add Parts 213
Import 214
Working with macros 197
Working with subckts 207
Worst case 186

X
X expressions 110

Y
Y expressions 110

Z
Zoom-In command 34, 78
Zoom-Out command 34, 78